H“. PIXELHUE

All-New Event Presentation
Switching Solutions

Event Presentation Switchers P20/P10/Q8
Event Management Software PixelFlow
Event Controllers U5/U5 Pro

00000



Copyright © 2024 Pixelhue Technology Ltd. All Rights Reserved.

No part of this document may be copied, reproduced, extracted or transmitted in any form or by any
means without the prior written consent of Pixelhue Technology Ltd (hereinafter referred to as
PIXELHUE).

Trademarks

&>

i’. PIXELHUE is a trademark of Pixelhue Technology Ltd.

Brand and product names mentioned in this manual may be trademarks, registered trademarks or
copyrights of their respective holders.

Statement

Thank you for choosing PIXELHUE products. This document is intended to help you understand and use
the products. PIXELHUE may make improvements and/or changes to this document at any time and
without prior notice. If you experience any problems in use or have any suggestions, please contact us
via the contact information given in this document. We will do our best to solve any issues, as well as
evaluate and implement any suggestions.

This document could contain technical inaccuracies or typographical errors. Changes are periodically
made to the information in this document; these changes are incorporated in new editions of this
document.

The latest edition of user manuals can be downloaded from the PIXELHUE website www.pixelhue.com.

www.pixelhue.com i


http://www.pixelhue.com/

All-New Event Presentation Switching Solutions

User Manual Contents

Contents

(070 ] (=] | £ USRS ii
T GBNEIAL ... ettt ettt et e ete e te et e e teeteeteeeteeeteeeteeeteeteeateeereeeaaeenns 1
T.T ADOUL THIS MANUAL......c..oiiiiiiiceeeeec ettt st st e s ab e e beeabeesbaestbessbeesbeenbeesseesseas 2
T2 VEISION HISTOMY ...ttt ettt sttt et e b e bt e sat e st e et e e ebeas 2
1.3 SYMDBOIS @NA PICTUMES ...ttt ettt ettt ettt et et st e se e st eneesseeneeneas 2

2 SATBEY .ot ettt et et ettt ete et e eteete et e teete e teete et e eteerteeteeanenteeteenreans 4
2.1 GeNEral CoNSIAEIAtIONS ....c..eocviiiiiiiie ettt ettt ettt stb e e b e b e ebe e beesebesebeesbeesseesteessseesseenveans 5
2.71.71 GENETAI SATELY ...ttt 5

2.1.2 Environmental REQUIFEMENTS . ......cciiiiiiieieiieeeeeeee ettt ettt aesre e besseensens 5

2.1.3 DEVICE SAFELY ..ttt bttt ne e 5

2.1 4 PersONal SAfELY......coiiuiiiiieicieeeeee ettt et et ettt e ete et teereenaeas 6

2.2 DEVICE CAITYING ..ottt ettt et h e a et sttt e bt e s bt e sh e e sate e bt e bt e bt e astesmeeeateenbe e beesbeesseesaneans 6
2.3 DEVICE MOUNTING ...ttt ettt b e sat e st e e bt e bt e bt e s bt e sae e e bt e be e beesbeesaeesaneans 7
2.3.1 MOUNTING ON @ DESKIOP ....vviiieiieiieiieie ettt sttt ettt b e se b e sseessesbeeseensens 7
2.3.2MoUNtiNG INTO @ RACK. ........eiieieeeee ettt 7

WG TG 1 C1 (01U ] o [o 10T NS 8

A 0 o] [ o = Ta [N 11 =10 4= o USSR 8
2.4 71T POWET COTAS....cuiiitiiiieitiectte ettt ettt et e et e etteeteete e beestseetbeesbeesbeeaseestaesbeeereeesseenseesbeenssenssenssenns 8

A Y [0 E= W 0= o] 1= OSSR 9

2.4.3 MISCEIIANEOUS .......oceviiieiieiiteeeee ettt ettt ettt et e b e e teesbasbeese e beessessesseessessesseensans 9

2.5 EIECIICAl SATELY ....eeieiiiieieeeee ettt ettt b ettt sa e beere s reeneenne 9
2.5, T BAEIY it ettt e e b e e be e e aa e e abeeetaeeerbeeeraeeasreeeraeenns 9

2.5.2 Electromagnetic INtEIrfErE&NCE ..........ocvi i 10

2.5.3 ANTI-STATIC ... ittt ettt a et st e ettt neeneeaeens 10

2.6 Unpacking and INSPECTION ........ccveeouiieeie ettt ettt e e aee et eteeeaeeereas 10
2.6. T UNPACKING ..ottt ettt ettt et ettt et st e e st e beese e b e aeessesbesseessesaeessessesreenseseessenns 10

2.6. 2 INSPECHION......oeiitiiee et ettt e e et e e e e e e e tabeeeeaaaeeeeeatseee e stseeeseasseeeesnsseeesansres 10

2.7 DEVICE LADEIS ...ttt et et et e te e ta e et e e abeereeteereas 10
2.8 NOtES AN CAULIONS ....ooviiiiiciie ettt ettt et e et e et e eaaeeateebeeebeesabeenseenveenveeseeseas 11
2.8.1 INSTAllAtioN NOTES.......oooeiiiiiiteectee ettt ettt ettt e eae e ete e te e teeeateeeveeabeeteenreas 11

2.8. 2 FCC CAULION ...cceeviieiiee ettt ettt ettt et e et e st e et eesteessaeesnseeenseeenseesnnaeensseesnseeenseennseean 11

2.8.3 OTNEIS .ttt et b ettt b et et e eaeers e beeteenb e teeneenns 12
3Terms and DEfiNITIONS ... ..ot ettt ettt ettt e et e te et ete e nas 13
A OVEIVIEW. ...ttt ettt ettt et e et e e et e e et ee e abeeeabee e tsaesaseeessseesabaeaasseesseeeassaesssaeensseesseeensseeasseesnseeenssesanseens 15

www.pixelhue.com i



All-New Event Presentation Switching Solutions

User Manual Contents
A7 SOIUTION OVEIVIEW ..ovviiiiiiieeiieete ettt eve et ettt et s b e s ebeesbeesbeessaasabeesbeesbeesbeassaesssessessseesseesseesses 16
4.2 CONTIOI OVEIVIEW ...ttt ettt ettt ettt ettt et s b e e tb e esbeesbeessaassbeesbeesbeesbeesbaesssessessseesseesseensens 20
A 3 INIAL INSPECTION .....oiviiiieiecie ettt ettt et et et esae s s e eseessesseenseseeseensaeseensenseensansas 21

S HArdware INTrOAUCTION ........ooviiiecie ettt te e s teestbeesbeesbeesbeeteesssasssessseesseessens 22
5.1 P20 Hardware INTrOAUCTION ........ocuoiiiicee ettt ettt ettt eaeeaeens 23
ST T FIONTPANEL ...ttt ettt et e ete e ete e et e eaeeeaaeeaeens 23

5. T2 REAINPANEL ...ttt ettt et eaeeaeen 25
5.2 P10 Hardware INTrOAUCTION ........coiiiiecii ettt ettt ta e s e b e e b e e teesaaessbeenveens 28
5.2 T FIONT PANEL ..ottt ettt ettt ab et e et e e s taestbeesbeesbeesbeesbeesseessenens 28
5,22 REAINPANEL ...ttt ettt e eaeeaaen 31

5.3 Q8 Hardware INtrOAUCTION .........oooviie et ettt et ettt e eaee e eaeens 34
5.3 T FrONTPANEL ...ttt ettt eee e en 34
5.3. 2 REAINPANEL ... ettt e tb e e tbeeabeebe e be e be e aaenens 35

Y LT U0 0 =] = 1 o] L= USRS 43
0.1 P20/PT0 MeNU OPEIATIONS ..ottt ettt ettt et e sb e sb e s it e st et e bt ebeesbeesaeesaneeneeens 44
6.7.7 Startup and SHULAOWN ........ouiiiicc ettt b e b e re e srneeareeaveens 44

6. 7.2 HOMIE SCIEEN......ooiiii ettt ettt et e et e e st e e sbee e tbeeesbeeesbeessbaeesaeesssaeesseessseeensseessseeessaenns 44

LT S T [ T o 10 | TP SSPRT 47
B.T.4 OULPUL ...ttt ettt et et e e s teeseaesateesseeaseese e seesssesnseenseanseensaasseessnesnsennseans 56

B. 1.0 SCIBBIN ...ttt ettt e e et e e et e e et e e e bt e e etae e eteeeeaaeeebeeeateeeerteeeeaeaen 62
B.T.0 LAYET ..ottt ettt e ettt e et e e b e e e bae e et b e e et aeesbeeebae e taeeanbaeetbeenabaeetaeeansaeeraeens 71
B.1.7 TFANSITION . ettt ettt e e et e e e taeessbeeesaeessseeessseesasaeansaeensseeenseeenns 86
B.T.8 PrESEY .. oottt e e e bt e et b e e e bt e e taeeasbeeeabeesabeeeraeearaeeeraaenn 87
6.7.9 MUIIVIEWET (MVR) ...ttt ettt ettt ettt seneesens 88
B.T.TO NETEWOTK ...ttt ettt ettt ettt e e te et e be e st e b e e seessesbeessesbeeseessasbeeseenseeseessasseeseensas 89
B.1.TT AQVANCEM ..ottt ettt ettt et b e e et e saesbeessesbeeseessesbeeseensesseessesseessensas 90

B. 1. T2 MOGE...... ettt ettt ettt ettt et et e e teeae e teetseeteeteesseeteereeteereenseereensennas 99

6. 1. T3 ADOUL US ..ottt ettt et e et e et e teeteeateeteeteeteeteenseeteersenseernennens 100

B.T. T4 LANQUAGE. .....ceeieiiee et ectee ettt e e tte e e teeeteeestbeeestae e sbeessseeessseessseaassaeeassesansseessseessseeessessssenan 100
0.2 Q8 MENU OPEIAtIONS ...ttt ettt e ettt e e sttt e e et eeeestaeeeesaaeeeeaasseeeesssseeessssesesansseeens 101
6.2.7 Startup and SHULAOWN ........oeoieeie et et 101
0.2.2 HOMIE SCIEEN......oiiiiieiieectee ettt et et e et e e et e e bt e e sabeeetbeessbeeessaeessseeessseesssaaensseessseeenseens 101
6.2.3 NETWOTK SETLINGS ...ttt ettt ettt ettt e ete e eateeteeeteeeaeeeese e 103
6.2.4 DEVICE INFOIMEALION ..ottt ettt ettt et et eae e e 104
6.2.5 AAVANCEA SETLINGS ......eoiiiieiiiicieie ettt ettt et ettt b e beese e b e teessesreessesseeseensans 105
LT S Y = T [ - T 1< TSRS 110
0.2.7 ADOUL US ...ttt ettt et sttt e ete s e beere e b e beesbesbeessebeeaeennans 110

7 Event Management Software PiXEIFIOW ...........c.ooiiiiiiiiiiii ettt 111
7.1 Software Installation and CONNECTION ..........c.oouiiiiiiiiiiciciieeeceee ettt 112
7.1.71 Software INStallation ..............ooiiiii et 112
7.1.2 SOftWAre CONNECLION ........c.ooueiiicie ettt ettt ettt e et e teeteeve e nas 112

www.pixelhue.com iii



All-New Event Presentation Switching Solutions

User Manual Contents
7.2 ProjeCt Man@gemIENT .......c.ui ittt ettt b e sttt et e b e b e st 113
7.2.T Create NEW PrOJECTS ... ..ottt ettt ettt e et e e et e et e e st e e esbeesssaeesaeesnseeesseennnes 113
A | 4] o Lo g B od £ =Tt £ PP RRR 116
7.2. 3 EXPOIT PrOJECTS. ...ttt et ettt sttt st et be et sb et 117
7.3 DeVICE MANAGEMENT ..ottt et ettt et ettt e et e e e bt e s et e saeeenteebeeteeeneeeneeeneeeaes 118
7.3.1 Enter Device Configuration Page..........ccccviiuieiiiiieieieceeeee ettt 118
7.3.2 Configure DeVICE PrOPEIIES ......cueeeitieeeeeecteeeecteeeee ettt ettt ettt e 121
7.3.3 CoNfigure INPUL PrOPEITIES .....c.vocvieeeie ettt ettt ettt et e sv e 128
7.3.4 Configure OUTPUL PrOPEITIES ........eoiiiieeieiieieeeteeee ettt sttt et sse e ennas 136
7.4 SCreen CONTIGUIATION .....ccoiiviiiiiii ettt ettt ste et esbeeseenseesaensesseensansesseensans 144
7.4.1 CONFIQUIE SCIEENS ..ottt ettt ettt ettt ettt ettt eae b e ste e b e sbeereesseeteeasesreensennas 144
7.4.2 Configure SCreen Properti@S........ccuiiuicieciiiiciiceeeeee ettt e 145
R =)= T G0 o 1= = L o] o F TP P PSSR 154
7.5.T A LAYETS ..ottt ettt ettt et et be st e b e sse e b e sseessebeeseenseeseenseseeneensas 154
7.5.2MANAQGE GAIIETY ...ttt nne 156
7.5.3 CoONTigure Layer PrOPEITIES ........c.cocviiuieieiieieie ettt ettt ettt ettt be e ss e reessesseeneennes 156
R B\ oo T To [l o (Y= £ TSRS 166
7.6 MURIVIEWET (IMVR).......uiiiiie ettt b ettt 167
7.6.1 CoNfigure MVR LAYOUL .......ccooiiiiiiiiiii ettt ettt ettt et et an e 167
7.6.2 CoNfigure MVR PrOPEITIES .....cviivieiiiiieieieeiete sttt ettt ettt st be e aeessesseessennes 168
7.7 SCreeN MaINTENANCE .......ooeiiiece ettt ettt ettt ettt et et e seesseesaaesaseenseenseanseesseesnsesnns 170
7.7.1 DeVice MaINTENANCE .......ccuiieiiie ettt ettt e et e et e e st e e snteesnteeesaeeenseeeenseesnnes 170
7.7.2 DEVICE DIagNOSTICS ..eeiiiiieiieeeiee ettt ettt e e et e et e e s b e e tb e e esbaeetaeeenreeenbeeennes 171
7.8 SOFtWAIE SETHINGS . ....ueiviiiieieieeeet ettt ettt et e et e e se et eseeae s b e s s e s e s eseeneeneeseenees 172
7.8.1T SWITCh Ul LANQUAGE .......oiieiieieeieeeeete ettt ettt ettt et te e s te e etbeeabeesbeesteesaneseneeens 172
7.8.2 CoNfiguIre INPUL VIBW ...ttt et eae et e e 172
= RS I = (o To] 4 Mo To [ S RSO U R PP 172
7.8. 4 View SOFtWAIE INFO ..ocueiiiiieieie ettt ettt st b e et ae s e sseesaennas 172
8 US/US5 Pro EVENT CONTIOIEES........iceieiiiieiieie ettt ettt ettt et st nb e steessesbeessesesseensans 173
S TR I 1 oY o 4] o USSR 174
8.2 Hardware INtrOAUCTION .........ooiieeee ettt ettt st et ae st eeae e 174
8.2.T FIONT PANEL ...ttt ettt ettt et et e et e e e se e st e s e aeensenseeneeneas 174
8.2.2 REAIPANEL ...ttt et b b ettt ae et sbeeneennas 176
B.3 DEVICE OPEIAtIONS .....eiiiieiiieeeeee et ettt e e ettt e e e st e e e e s tbaeeestaeeeeansseeeessseeeeanssseeeanseeaean 178
8.3.71 BASIC OPEIatiONS....cco ittt e e e ettt e e e et e e e e etbe e e e eareeeeeareeaeennrens 178
8.3.2 Startup and ShUTAOWN .........coiiie et ettt e 178
8.3.3 MaiN TOUCRHSCIEEN ...ttt ettt sttt be et e st e s e sneeneeneas 179
8.3.4 DEVICE BUTTONS ...ttt ettt e et et e ae e bt e eaeeenes 179
8.3.5 SCIrEEN BUTTONS...... ittt e et e et e et eesteeenseesnsaeenseeenseeennseennnes 180
8.3.6 INPUL SOUMCE BUTTONS ..ot ettt e e e e et e e e e areeaeensaeas 181
8.3.7 LaYEr BUTTONS ..ottt ettt et e et e e st e e ete e st ee e st e e snsaeenseesnseeenseesnnes 182
8.3.8 PreSet BUTTONS .......oiii ettt sttt e e st e st 183
www.pixelhue.com iv



All-New Event Presentation Switching Solutions

User Manual Contents
8.3.9 FUNCTLION CONTIOI AFCA ...ttt sta e e tbe s rbeesbeesbe e ssenenenens 184
8.3.10 Camera and Timecode CONTrol AF€a..........c.ooiiiiiieriiiciecieeteereeee sttt 185
8.3.17 SMArt TOUCNSCIEEN ...ttt ettt et b e s nseebeessesseensensas 186
8.3. T2 NUMDEI BUTTONS ...ttt ettt ettt e e e ete e eae e et e eaeeenns 189
8.3.13 Switching and CONTIOl ATEa ........ccueiuieiieiicieeeeee ettt sse e 190
8.3.TA MIDI MOAUIE ATCQ ... ittt ettt ettt st e e b e e b e e sbe e s teestaeetbeesbeesbeebeesssenssenens 191
8.3. TS POWEI BUTTON ...ttt ettt ettt e et e et e e st e e esbeeessaeesaeeenseeesseennnes 192
ST L I = - | SRRSO 192
8.3. 17 KEYDO@IM ...ttt ettt ettt ettt b et nb e ae b e seeneennas 193
8.3 T8 DIAWEIS ..ottt ettt ettt e et e e e e e et e e e tbeeebee e abeeeasee e sseeenteeetaeeanteeetreeeanes 193

9 StreamM DECK CONIIOL ...ttt et et ete e e e e e et e eeaeeeteeeteeeaeeeaneenneens 194
9.1 Software Obtaining and Preparations ..........cccooieiiiiiiieie ettt 195
9.2 SOftware CONFIQUIATION .......cc.iiiiieieieeeee ettt ettt ettt b e st eneeseenes 195

A SPECITICALIONS ..ottt ettt et sttt et e e te e b e beesee b e eseesbeeseess e beessenseeseesseeneeneensas 201
AT P10/P20 SPECIFICALIONS ....cvieiiiieieieeee ettt sttt ettt neene s 201
A 2 Q8 SPECITICALIONS. ....ccvitiiiiiii ettt ettt ettt ettt e teete et e eteeaeeereerneanas 202
A.3 US5/US5 Pro SPeCIfiCAtiONS........cciiiieieieieeteee ettt 203

B SUPPOMEA RESOIUTIONS ...ttt ettt et sttt e e ab e eabeeabeebe e beesebestbeesseesseesseenseas 204
BT P20/P 0.ttt ettt ettt et e h ettt nt st n et e teese s et ene et eneeneeneas 204
B2 Q8. ettt b et e e ab e he st e bt e tt e b e bt es b e beeasenseeteenteeseentebeeseenseereenaenns 205
B.B US/US PrO...o ittt ettt et ettt b e et e b e st e ess e b e e ss e s s e e ae e st e s e entenbeereenseeteennenns 205

www.pixelhue.com v



All-New Event Presentation Switching Solutions
User Manual

1 General

General

Overview

e About This Manual
* Version History

e Symbols and Pictures

www.pixelhue.com



All-New Event Presentation Switching Solutions

User Manual 1 General

1.1 About This Manual

This user manual describes how to operate the P20/P10/Q8 seamless switchers and
U5/U5 Pro event controllers, as well as how to use the matched all-new event
management software PixelFlow. This manual is designed to be a reference for your
daily use of our products. It contains a complete description of the hardware and
control software.

a Note

Always check for the latest version of all documents at www.pixelhue.com.

1.2 Version History

Version Date Changes

V1.3.1 2024-03-15 | Addedthe Q_ST2110_4xSFP25G Input Card_I for the Q8.

V1.3.0 2024-02-02 | * Updated the descriptions of P20/P10 front panel
buttons, home screen and LCD menu operations.

e Added the stream Deck control instruction.

¢ Updated the descriptions of the event management
software PixelFlow.

V1.2.0 2024-01-05 ® Updated the sections related to P20/P10.

¢ Updated the descriptions of the event management
software PixelFlow.

* Updated the Q8 physical specifications.
® Updated the U5/U5 Pro physical specifications.

V1.1.1 2023-11-10 | Updated the front panel related content of the Q8.

V1.1.0 2023-09-28 Added Stream Deck as a control option of the P20 and P10.
V1.0.1 2023-08-25 Added Q8 function limitation information
V1.0.0 2023-06-30 First release

1.3 Symbols and Pictures

Symbol Overview

@ Danger Indicates a hazard with a high level of risk, which if not
avoided, will result in death or serious injury.

& Warning Indicates a hazard with a medium or low level of risk, which if
not avoided, could result in minor or moderate injury.

0 Caution Indicates a potentially hazardous situation, which if not
avoided, could result in equipment damage, data loss,
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performance degradation, or unexpected results.

Note

Provides additional information to emphasize or supplement
important points of the main text.

Picture Overview

Images and pictures given in this manual are used for illustration purposes only. The
actual product may vary due to product enhancement. The content of the images can
be slightly different from reality, such as device types, installed modules, form and
position of software windows on the screen.
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2.1 General Considerations

To ensure that you can use this product correctly and safely, please be sure to
observe the following precautions:

Before performing any operation, make sure that you have read all the operating
instructions provided by the device, especially the instructions that may endanger
the personal safety and device safety, such as dangers, warnings and cautions, to
minimize the probability of accidents.

All the operations must conform to local safety codes. When the safety and
precautionary measures described in this manual conflict with local safety codes,
please follow the local codes.

The personnel responsible for installing and maintaining the device must be
professionals who have been trained and have mastered the correct operation
methods and all safety precautions. Only trained and qualified personnel can
perform device installation and maintenance.

This device must be used in an environment that meets the design specifications;
otherwise, it may cause device failure. The resulting device function abnormalities
or component damage, personal safety accidents, property losses and other
situations are not included within the scope of the device warranty.

2.1.1 General Safety

When operating the device, you must strictly abide by the local laws and
regulations. The safety precautions described in this manual are only a
supplement to the local safety laws and regulations.

The "Danger”, "Warning" and "Caution” items described in this manual are only
supplementary instructions for all safety precautions.

To ensure personal and device safety, please strictly follow all the safety
precautions on the device labels and described in this manual when installing the
device.

2.1.2 Environmental Requirements

Ensure adequate air flow in the equipment room.

Take necessary measures to prevent dust, water and static electricity.
Avoid long-term direct sunlight.

Keep the device away from heat and ignition sources.

Do not place the device in an explosive atmosphere.

Do not place the device in a corrosive environment.

Do not place the device in a strong electromagnetic environment.

2.1.3 Device Safety

Before operating, fix the device on the floor or other stable objects, such as a wall
or mounting bracket.

During transportation and use of the device and its packaging, the device must be
fixed stably to avoid falling.
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Do not step on, hit and violently operate the device and its packaging to prevent
damage to the device or packaging box.

Do not block the ventilation openings during operation.
Tighten the board or card screws with a tool.
After the installation, remove the empty packing materials from the device area.

Save the packing box and materials for possible storage and transportation in the
future.

Always wear anti-static wrist bands and insulating gloves when touching the
static-sensitive components.

Avoid dropping any object into the chassis.

Keep the device away from conductors that are easy to induce lightning to avoid
lightning strikes to the device.

Do not make the circuit faces of the boards or cards contact each other.

Do not touch the circuit, components, connectors or wiring slots of the boards or
cards with bare hands.

Do not repair the device without authorization. Only trained professionals can
maintain the device. You can contact PIXELHUE at any time if needed.

Always use the spare parts recommended by PIXELHUE.

Regularly clean the dust on the heat dissipation holes to prevent the dust from
blocking the holes and thus affect the heat dissipation of the device.

2.1.4 Personal Safety

Place the device in a stable location to prevent personal injury caused by falling.
Avoid bare wires and maintain or replace them in time when they are damaged.
Do not operate the device and connect cables outdoors under thunderstorms.

Do not wear watches, rings, or other metal jewelry when installing spare parts or
maintaining the device.

2.2 Device Carrying

Do not relocate a powered device, and do not take any objects that may cause
danger to the relocation.

Always pay attention to the wheels at the bottom of the flight case during
transportation to avoid them being jammed by stones or deformed due to external
forces.

Always hold the handles of the flight case firmly when pushing a flight case with
wheels. Do not stack other devices on the flight case.

The relocated device should be repacked in the original factory packaging.
Do not disassemble the components during the transportation of the flight case.

When handling or placing the boards or cards, bare board components or
modules, always package them individually.
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When carrying the device with your bare hands, always wear protective gloves to
avoid injury.

When carrying the device, handle it gently and always hold the handles of the
device or drag the bottom edge of the device. Do not hold the handles of a device
component.

When the device weight exceeds the carrying limit of a single person, carry it with
multiple people or use a carrying tool.

When using a forklift or handcart for transportation, place the device stably to
ensure the device will not tip over.

The following table lists the maximum weights that adults can carry at a time
specified by some organizations for your reference.

Organization Weight
CEN (European Committee for Standardization) 25kg/55.13 1b
ISO (International Organization for Standardization) 25kg/55.13 1b

NIOSH (National Institute for Occupational Safety and Health) | 23 kg/50.72 Ib

HSE (Health and Safety Executive) 25kg/55.13 Ib

General Administration of Quality Supervision, Inspection and | Male: 15 kg/33.08 Ib
Quarantine of the People’s Republic of China Female: 10 kg/22.05 Ib

2.3 Device Mounting

When the device is installed on a desktop or into a rack, the desktop or rack must
bear at least 4 times the device weight.

2.3.1 Mounti

2.3.2 Mounti

ng on a Desktop

Ensure the stability and grounding of the desktop or working table.

Ensure that the device is placed horizontally and do not turn it over or hang it on
the wall.

Do not place other objects on the device.

Do not put water cups, beverages and other containers with liquid close to or on
the device to avoid liquid leakage and thus cause safety hazards.

If any object or liquid accidentally enters the device, stop using the device and
disconnect the power cord and all cables connected to the device immediately,
and then contact the after-sales personnel.

When handling a flight case with wheels, please lock and fix the wheels to prevent
the device from sliding.

When stacking, ensure all the devices are stacked stably to avoid device damage
and personal injury caused by falling.

ng into a Rack

The rack must be fixed properly to avoid tilting and falling, and thus cause
personal injury and device damage.
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When a device is mounted into a rack, all mounting holes must be fixed with
screws.

Ensure the rack is well ventilated. It is recommended to reserve at least 1U space
between the stacking devices, and the heat dissipation vents must not be
obstructed and keep at least 10 cm distance from other objects.

2.3.3 Grounding

Connect the grounding wire first when installing a device, and disconnect the
grounding wire at last when removing the device.

The connecting surface of the grounding wire and the device must have good
conductivity. Spray painting is strictly prohibited, and there must be sufficient
fastening force between the connecting parts.

Do not operate the device when the grounding conductor is not installed.

There must be no joints in the middle of the grounding wire, and it is strictly
prohibited to install a switch or fuse on the grounding wire.

For devices using a three-pin socket, ensure that the ground terminal in the three-
pin socket is well grounded.

2.4 Cable Requirements
2.4.1 Power Cords

& Warning

Do not install or remove the power cord when the device is powered on. When the
power cord core contacts the conductor, an electric arc or spark will be generated
which may result in fire or eye injury.

Protect the power cord properly to prevent it from being punctured to avoid
personal injury or fire caused by a short circuit.

To ensure the safety of the device and personnel, be sure to use the matched
power cord.

User-supplied cables must comply with local cable regulations and device cable
requirements.

Before installing or removing the power cord, turn off the device power first.

Check the electrical plug regularly and wipe off the dirt or dust accumulated on
the plug.

Before connecting the power cord, read the labels or markings on the power cord
to make sure it is a matched one.

The device is intended to operate from an AC power source with a voltage range of
AC 100-240V~, 50/60Hz. Various standard plugs are shown in the figure below.

US NEMAS5/15 Europe CEE 7 China GB 2099 UK BS 1363
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Earth N Neutral L Live

2.4.2 Signal Cables

Before using a DVI signal cable, check whether the pins on the cable connector
are vertical and even. If not, please replace the cable.

Before connecting the signal cable to the device, check whether there is any
object in the device connector. If yes, remove the object first.

If the signal cable has not been used for a long time, discharge static electricity
before using it.

Under normal working conditions of the device, it is recommended that non-
technical professionals do not perform hot-swapping to avoid device damage.

2.4.3 Miscellaneous

Signal cables must be bound separately from strong current cables or high
voltage cables.

When the temperature is too low, severe shock and vibration may cause brittle
cracking of the plastic sheath of the cable. All cables should be laid and installed
when the temperature is above zero.

If the storage temperature of the cable is below zero, the cable must be moved to
room temperature and stored for more than 24 hours before laying and
installation.

When carrying cables, especially in a low-temperature environment, always handle
the cable with care. Violent handling, such as pushing down the cables directly
from a high place, is prohibited.

2.5 Electrical Safety

2.5.1 Battery

The battery is not intended to be replaced.
Always follow the relevant instructions to dispose of batteries.

Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of
a battery can result in an explosion.

Leaving a battery in an extremely high temperature surrounding environment can
result in an explosion or the leakage of flammable liquid or gas.

A battery subjected to extremely low air pressure may result in an explosion or the
leakage of flammable liquid or gas.
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2.5.2 Electromagnetic Interference

Keep the device away from transformers, high-voltage power lines and high-
current devices.

Keep the device away from high-power broadcast transmitters.

If there is a mobile communication transmitter around the device, its interference
degree should meet the requirements of relevant standards. If needed, take
necessary measures to prevent interference, such as shielding and isolation.

When using hand-held wireless communication devices, such as interphones,
keep at least 30 cm away from the device.

2.5.3 Anti-Static

Always wear anti-static wrist bands and insulating gloves when touching the
static-sensitive components.

Always hold the board by the edges to avoid touching the circuits or components,
and do not touch the chip with your hands.

The disassembled board must be packaged with anti-static packaging material
before storage or transportation.

2.6 Unpacking and Inspection

2.6.1 Unpacking

After receiving the device, check whether the packing box is damaged. If there is
any damage, do not open the box and contact the carrier in time to confirm the
damage to the device and matters related to compensation.

After unpacking, save the packing box and materials for possible storage and
transportation in the future.

2.6.2 Inspection

When the packing box is in perfect condition, unpack the box. Check the
appearance of the device for damage. If there is damage, please contact the
salesperson.

Check the box contents according to the packing list described in the certificate of
approval. If any item is missing, please contact the salesperson in time.

2.7 Device Labels

Labels Description

E Warranty void if removed

S ——————
WARRANTY
1 VOID IF
REMOVED
e

Do not open the chassis. If this label is damaged, the device
will not be covered by the warranty.

I Grounding

— The two ends of the grounding wire are connected to the
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Labels

Description

A\ cAuTioN | device and the grounding point respectively, which means

that the device must be grounded through the grounding

CONNECT GROUND
WIRE BEFORE USING

point to ensure the normal operation of the device and the
personal safety of the operators.

A caution | Sensitive electronic device

SENSITIVE ELE! 'ONIC
0O NO

ICE
o

Keep the device away from areas with strong
electromagnetic radiation to avoid electromagnetic

interference and thus affect the image output quality.

/\ CAUTION Device carrying

& o
f‘? TEAM LIFTING REQUIRED

HEAVY OBJECT The device needs to be carried by multiple people.

/\ CAUTION Removing cards

== REMOVE CARDS
E’ I BEFORE TAKING OUT

Remove cards before taking out the motherboard.

MOTHERBOARD

2.8 Notes and Cautions

2.8.1 Installation Notes

When the product needs to be installed on the rack, 4 screws (M5*12) should be
used to fix P20/P10 and 16 screws (M5*12) should be used to fix Q8. The rack for
installation shall bear at least four times the total weight of the mounted equipment.

a)

Elevated Operating Ambient - If installed in a closed or multi-unit rack assembly,
the operating ambient temperature of the rack environment may be greater than
room ambient. Therefore, consideration should be given to installing the
equipment in an environment compatible with the maximum ambient
temperature (Tma) specified by the manufacturer.

Reduced Air Flow - Installation of the equipment in a rack should be such that
the amount of air flow required for safe operation of the equipment is not
compromised.

Mechanical Loading - Mounting of the equipment in the rack should be such that
a hazardous condition is not achieved due to uneven mechanical loading.

Circuit Overloading - Consideration should be given to the connection of the
equipment to the supply circuit and the effect that overloading of the circuits
might have on overcurrent protection and supply wiring. Appropriate
consideration of equipment nameplate ratings should be used when addressing
this concern.

Reliable Earthing - Reliable earthing of rack-mounted equipment should be

maintained. Particular attention should be given to supply connections other
than direct connections to the branch circuit (e.g. use of power strips).

2.8.2 FCC Caution

Any changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

www.pixelhue.com
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This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
own expense.

2.8.3 Others

e Thisis Class A product. In a domestic environment, this product may cause radio
interference in which case the user may be required to take adequate measures.

e This product can only be placed horizontally. Do not mount vertically or upside-
down.

¢ Please read the specifications thoroughly and use the product in accordance with
the requirements. If you have any questions about the specifications, please
contact us immediately. If you use the product improperly, not following the
requirements, or for illegal purposes, you shall be solely responsible for any
consequences arising therefrom.

¢ If the product does not have the relevant certifications required by the countries or
regions where it is to be sold, please contact PIXELHUE to confirm or address the
problem. Otherwise, the customer shall be responsible for the legal risks caused
or PIXELHUE has the right to claim compensation.
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Terms and Definitions

PVW

PGM

Take

Cut

FTB
T-Bar

LOGO

BKG

MVR

AUX

AOI

Aspect Ratio

Contrast

Gamma

PVW is an abbreviation for Preview. The PVW area displays the pre-
editing content before it is sent to PGM.

PGM is an abbreviation for Program. The PGM area displays the real-
time output image.

Take is an action of sending the PVW content to PGM with a transition
effect.

Cut is an action of sending the PVW content to PGM directly, without
any transition effect.

FTB (Fade to Black) is an action of making the screen fade to black.

T-bar is a lever that manually controls the progress of sending PVW to
PGM.

LOGO is a special layer with the highest priority and is displayed in
front of all other layers. LOGO consumes no processing resources and
displays an unscaled image on the screen.

BKG is an abbreviation for background. BKG is a special layer that has
the lowest priority and is displayed beneath all other layers. BKG
consumes no processing resources and fills the whole screen.

MVR is an abbreviation for Multiviewer. An MVR connector is used to
connect a confidence monitor for displaying the specific input or
output content, such as the presenter's laptop.

AUX is an abbreviation for auxiliary. An AUX connector is used to
output the input source, PYW or PGM, to a specified monitor, such as
a teleprompter.

AOl is an acronym for Area of Interesting. AOI allows users to view a
specific output area they are interested in.

Aspect ratio is the ratio of a layer/image width to its height. It is
commonly expressed as two numbers separated by a colon, as in 16:9.

Contrast defines the difference between the darkest and brightest
areas of an image displayed on the screen. The greater this value is,
the bigger this difference will be.

Gamma defines the degree of distortion of the image color. The
greater this value is, the more distorted the color will be.
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Hue

Saturation

Color Space

Bit Depth

Frame Rate

DSK

Luma Key

Chroma Key

HDCP

Hue defines the gradation or variety of the image color. The greater
this value is, the more intense the color will be.

Saturation defines the purity or vividness of the image color. The
greater this value is, the purer the color will be.

Color space is a mathematical model that maps the colors that can be
reproduced by a device to a standard color model, usually the RGB
model.

Bit depth refers to the color information stored in an image. The higher
the bit depth of an image, the more colors it can store.

Frame rate (expressed in frames per second, or FPS) is the frequency
(rate) at which consecutive images called frames to appear on a
display. Frame rate may also be called the frame frequency, and be
expressed in hertz.

DSK (Downstream Keying) is an effect allowing one video signal to be
keyed on top of another video signal. The lightest portions of the DSK
signal replace the source video leaving the dark areas showing the
original video image.

Luma key refers to a process to composite a foreground clip over a
background clip based on the luma levels in a video or image. This is
most often useful for still images, such as a picture of a logo over a
black background.

Chroma key refers to a process that a specific color is removed from
an image, allowing that portion of the image to be replaced. This color
can be any solid color, most commonly blue or green.

HDCP stands for High-Bandwidth Digital Content Protection, a copy
protection scheme to eliminate the possibility of intercepting digital
data midstream between the source and the display. HDCP 1.4 is
designed for full HD content, while HDCP 2.2 relates to ultra HD 4K
media.
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Overview

About This Chapter

This chapter is designed to introduce you to PIXELHUE event presentation switching
solution.

Overview

¢ Solution Overview
e Control Overview

 Initial Inspection
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4.1 Solution Overview

The event presentation switching solutions include two parts basically: event
presentation switchers and event controllers/PixelFlow (PC). The solutions are
specifically designed for easy management of multi-display for small/medium/Ilarge-
sized events or visual management systems.

P20+U5/U5 Pro+PixelFlow

The P20 can work with the U5 or U5 Pro event controller. The following takes the U5
as an example for illustration.

Figure 4-1 Switcher mode (P20+U5+PixelFlow)

When the output capacity is 4K, two output connectors work as primary and the other
six work as backup. When the output capacity is DL, four output connectors work as
primary and the other four work as backup.

LED Screen (8K x 2K@60Hz) LCD Screen (8K x 2K@60Hz) Projection (8K x 2K@60Hz)

2x HDMI 2.0 (Primary Output)

I
i
P Projector E 5 Projector
4XVX1000 et N s
" H
4x OPT (Copying Output) 2x HDMI 2.0 (Copying Output) i
S [ IR,
4xDP 1.2/ HDMI 2.0 ) 4x HDMI 1.3
)= ] ] > 1x HDMI 1.3 1 l ! l
=2 ) == === — = | - ) -
wsio 2 0
4xDP 1.2/HDMI 2.0 EE._"E. e S = NS N
g 1Ly AUX1 AUX2 AUX3 AUX4
o 1 Ethernet Cable s 3

Multiviewer

4x12G-SDI (+==_31] Router

=
Ethernet Cable Ethernet Cable I vI USB Cable Output
Us [« o Outpu
A———

Stream Deck Control

Control PC

Figure 4-2 PGM only mode (P20+U5+PixelFlow)

When the output capacity is 4K, four output connectors work as primary and the
other four work as backup. When the output capacity is DL, four output connectors
work as primary and the other four work as backup.
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LED Screen (8K x 4K@60Hz) LCD Screen (8K x 4K@60Hz)

Projection (8K x 4AK@60Hz)

-

4x HDMI 2.0 (Primary Output)

|
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\
8x VX1000 T

i
8x OPT (Copying Output) 4x HDMI 2.0 (Copying Output)] ! 1
- 1 :
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Ethernet Cable

o8 =8 O L
: Multiviewer
 4x126-SD!I B [e2s_21] Router

=I0)| =2
Ethernet Cable Ethernet Cable et USB Cable Output
I wl tpt
us | M—
——— Control

Stream Deck
Control PC

i

P10+U5/U5 Pro+PixelFlow

The P10 can work with the U5 or U5 Pro event controller. The following takes the U5
as an example for illustration.

Figure 4-3 Switcher mode (P10+U5+PixelFlow)

When the output capacity is 4K, one HDMI 2.0 connector works as primary and the
other works as backup. When the output capacity is SL, four output connectors work
as primary and the other four work as backup. SL output capacity is used as an
example for illustration of projection

LED Screen (4Kx2K@60Hz) LCD Screen (4Kx2K@60Hz)

AUX1  AUX2
2x OPT (Copying Output) 1x HDMI2.0 (Primary Output) g]
2x HOMI1.3 I I
e -
E "‘{:; [;j 1x HDMI1.3
2x 12G-SDI Ethernet Cable )
1:;7 ’ [:’ I . Multiviewer
‘U S eee 00 | Router
us i Ethernet Cable ‘Emetnetcable I"'p"““’wl USB Cable Q i
AN

— Stream Deck Control
Control PC
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Projection (4Kx2K@60Hz)

AUX1  AUX2

i}

2x HOMI1.3 ‘

4xHDMI2.0/DP 1.2

o8 o8 3

0

2x 12G-SDI

IEIhernelCabe

L‘ﬁj‘ nd E] Multiviewer
Router

)
Eth | USB Cabl
s Etheret Cable | | Etheret Cable ]-l“ o able ; ouioun
Control

Stream Deck

Control PC

Figure 4-4 PGM only mode (P10+U5+PixelFlow)

When the output capacity is 4K, two HDMI 2.0 connectors are used for 4K output.
When the output capacity is SL, eight connectors are used for 2K output. 4K output is
used as an example for illustration of projection

LED Screen 8Kx2K@60Hz) LCD Screen (8Kx2K@60Hz)

4xVX1000

4xHDMI2.0/DP1.2

! 4x OPT (Copying Output) 2x HDMI 2.0 (Primary Output) [i I = iJ
——————————————————————— T T

2x HDMI1.3
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e A
See Multiviewer
[22s 98] rouer
s Ethernet Cable {E(hemelcable Use Cable Q Output
A——— Control

Stream Deck

(i,
I

Control PC
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Figure 4-5 Q8+U5/U5 Pro+PixelFlow
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P20/P10

The P20 and P10 are PIXELHUE's all-new 4K presentation switchers fully featured in
a compact form factor. Featuring high-quality 4K processing, the P series switchers
are designed with a wide variety of 4K connectors, including HDMI 2.0, DP 1.2, and
12G-SDI.The P20 and P10 can work in switcher mode or PGM only mode. In switcher
mode, a single P20 supports up to two 4Kx2K@60Hz outputs and a single P10
supports one 4Kx2K@60Hz output. In PGM only mode, the output resolution per P20
is up to 8Kx4K@60Hz and P10 is up to 8Kx2K@60Hz. Additionally, the P20 and P10
come with dedicated AUX outputs connecting to auxiliary devices such as
teleprompters, and a dedicated Multiviewer output is provided for live view of all the
inputs and outputs from one display. High-performance image deinterlacing is
supported.

Q8

The Q8 presentation switcher offers incredible real-time 4K video processing power.
It comes with at most 72x 4K input connectors and 48x 4K output connectors,
supporting up to 48x 4K concurrent inputs and 16x 4K concurrent outputs. A
maximum of 32x 4K mixing layers (true seamless transitions) in switcher mode or
64x 4K single layers in PGM only mode are supported.

Moreover, the Q8 provides a variety of exceptional features. Multiple different
connectors are designed on one input card or output card, including DP 1.2, HDMI 2.0
and 12G-SDI. The ST2110 input card supports 4x SFP25G ports, which not only offers
high bandwidth and bitwidth but also allows flexible transmission of video, audio, and
control data over IP networks. Additionally, the Q8 boasts the 8K video processing
capability. With these capabilities, the Q8 enables you to design and manage all live
events easily and economically. Thanks to the *VPU-based architecture, the number
of layers on a single output card can be doubled, eliminating any concerns about
running out of layer capacity.

Event Controller U5/U5 Pro

The U5 is a brand new compact-sized event controller and the U5 Pro is a flagship,
large-scale event controller developed by PIXELHUE. Compared to their
predecessors, they feature more innovative design highlights and more convenient,
powerful and friendly operation and control over multiple different devices in the
field, which will further facilitate your events today, such as corporate conferences,
interactive live events or shows, music tours, immersive art exhibitions, and more.

4.2 Control Overview

The P20, P10 and Q8 are exceptionally easy to operate. Various control options are
supported:

» Front panel buttons and graphical LCD (P20/P10/Q8)
» Event management software PixelFlow (P20/P10/Q8)
* Event controller U5/U5 Pro (P20/P10/Q8)
 Third-party control system Stream Deck (P20/P10/Q8)
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Front Panel

PixelFlow

The front panels of the P20 and P10 come with a 5-inch graphical LCD, a knob and a
variety of function buttons that allow for menu operations by pressing buttons. A USB
port is provided on the front panel for updating device firmware, import and export
files. For more information about the P20 and P10 front panels, please refer to 5
Hardware Introduction.

The front panels of the Q8 come with a 7-inch graphical touchscreen that allows for
menu operations. A USB port is provided on the front panel for cascading a second
Q8 device. For more information about the Q8 front panels, please refer to 5
Hardware Introduction.

The event management software PixelFlow allows you to manage and control the
presentation switchers uniformly. The software consists of several menus and tabs
that allow you to configure the devices, inputs, outputs, screens and layers, as well as
manage the presets and Multiviewer.

Event Controller U5/U5 Pro

Stream Deck

With the design concept of increasing operational efficiency and satisfying the
various changing needs that may arise from event scenarios, the U5/U5 Pro event
controllers come with all the crucial functionalities that you may need. Convenient
control over multiple presentation switchers and media servers greatly simplifies
your on-site deployment and brings more convenience and ease to your events.

The Q8 and P series (P10 and P20) seamless switchers support control through a
third-party device (Stream Deck). Stream Deck control enhances productivity and
streamlining of tasks by providing easy access to shortcuts, commands, and actions
with just a press of a button. For detailed operations, see 9 Stream Deck Control.

4.3 Initial Inspection

General

Unpacking

Before shipment, the devices were inspected and found to be free of mechanical and
electrical defects. As soon as the devices are unpacked, inspect for any damage that
may have occurred in transit, and make sure there are no broken parts and the unit is
free of dents. Save all packing material until the inspection is completed. If any
damage is found, please contact PIXELHUE or your local distributor immediately.

After unpacking, please always place the device on a stable, flat and insulated
support for handling or using.

After the unpacking, it is recommended you check carefully to see whether all
accessories are included according to the provided packing list.
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Hardware Introduction

About This Chapter

This chapter is designed to introduce you to the hardware configuration of the event
presentation switchers in detail.

Overview

¢ P20 Hardware Introduction

- Front Panel
- Rear Panel

¢ P10 Hardware Introduction

- Front Panel
- Rear Panel

¢ Q8 Hardware Introduction

- Front Panel
- Rear Panel

E Note:

All product pictures shown in this chapter are for illustration purposes only. Actual
product may vary.
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5.1 P20 Hardware Introduction
5.1.1 Front Panel

The P20 front panel is designed with a 5-inch graphical LCD, a knob and a variety of
function buttons that allow for menu operations by button presses. A USB port is
provided on the front panel for updating device firmware, import and export files.

Figure 5-1 P20 front panel

1. Chassis handles (L+R) 5. LCD screen

2. Power button 6. Knob

3. USB port 7. BACK button

4. Source buttons 8. Layer and function buttons

Chassis Handles

Power Button

USB Port

Two handles are provided for easy installation and transportation.

Press the button to turn on/off the device. To turn off the device, press the button
and select OK from the dialog box displayed on the LCD screen to confirm your
operation.

¢ Breathing dim white: The power supply is connected.

* Bright white: The device is turned on.

A Type-A USB 2.0 port is provided for updating device firmware, import and export
project files, EDID files, BKG files, LOGO files and logs via USB drive.

Source Buttons

Press a button to access the input settings menu or select the source. These buttons
can also be used to enter numbers.
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LCD Screen

Knob

Back Button

Button LED color and source status (INPUT 1 to 14):

* Dim white: No signal and not in use
¢ Breathing blue: Signal accessed and not in use

* Blue: Signal accessed and in use

AUDIO: The audio function will be implemented in future updates.

A 5-inch graphical LCD screen is designed for displaying all the menus, submenus
and messages.

After startup, the screen displays the home screen. For detailed information on the
home screen, refer to 6.1 P20/P10 Menu Operations.

Rotate the knob to scroll up or down through the menus.
* Rotate the knob clockwise to scroll down.

* Rotate the knob counter-clockwise to scroll up.
Press the knob to select menu items.

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or
unlock the front panel buttons.

Press the BACK button to exit a menu without making changes, to cancel an
operation, or to return to the home screen. Each press takes you back up the menu
tree one level.

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or
unlock the front panel buttons.

Layer and function buttons

* LAYER 1 to 7: Press a button to open the layer and access the layer menu. Press
and hold the button to close the layer.

Button LED color and source status:
- Dim white: The layer is closed.
- Bright blue: The layer is open.
- Blinking blue: The layer is in edit mode.
* PRESET: Press the button to access the preset settings menu.
- Dim white: The preset settings menu is not displayed.
- Blinking blue: The preset settings menu is displayed.

» SCALE: Press the button to enable the full screen scaling of the layer at the back
of the Z-order.

- Blinking blue: Full screen scaling is enabled successfully.

www.pixelhue.com 24



All-New Event Presentation Switching Solutions
User Manual 5 Hardware Introduction

* BKG: Press the button to turn on BKG (there are pictures in the gallery). Press and
hold the button to turn off BKG.

Button LED color and source status:
- Dim white: BKG is disabled.
- Bright blue: BKG layer is enabled.

¢ FN: This is a custom shortcut button and users can assign a function to the FN
button.

When Freeze, FTB (Fade to Black) or Genlock synchronization is assigned, press
the button to enable or disable the assigned function.

Button LED color and source status:
- Dim white: The function is disabled.
- Blue: The function is enabled.
* When Capture is assigned, press the button to access the Capture menu.
- Dim white: The Capture menu is displayed.
- Blinking blue: Capturing...

¢ TAKE: Press the button to switch content from PVW to PGM with a specified
transition effect.

- Dim white: Content is not switched.
- Blinking blue: Content is being switched.

5.1.2 Rear Panel

The P20 rear panel provides a variety of 4K I/0 connectors including 12x 4K inputs
(HDMI 2.0, DP1.2, 12G-SDI), 4x HDMI 2.0 outputs, and 8x 10G optical fiber ports.

Figure 5-2 P20 rear panel

(8 @ O ©6 60 ©

1. P_4K_12G SDI Audio-OPT Combo Card . Control connectors

3. Outputs 1to 4

6

2. Inputs 110 8 7. Power connector and switch
8. LED work lights
9

4. Multiviewer output . LED work light switches

5. AUX outputs
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P_4K_12G SDI Audio-OPT Combo Card

The P20 is designed with a P_4K_12G SDI Audio-OPT Combo Card which offers the
following input and output connectors.

4x 12G-SDI IN & LOOP (INPUT 9 to 12)
8x optical fiber output ports (OPT)

Inputs 1to 8

4K:

Switcher mode

OPT 1 copies the left half of the output image of HDMI 1.

OPT 2 copies the right half of the output image of HDMI 1.

OPT 3 copies the left half of the output image of HDMI 1.

OPT 4 copies the right half of the output image of HDMI 1.

OPT 5 copies the left half of the output image of HDMI 5.

OPT 6 copies the right half of the output image of HDMI 5.

OPT 7 copies the left half of the output image of HDMI 5.

OPT 8 copies the right half of the output image of HDMI 5.

PGM only mode

DL:

OPT 1 copies the left half of the output image of HDMI 1.

OPT 2 copies the right half of the output image of HDMI 1.

OPT 3 copies the left half of the output image of HDMI 3.

OPT 4 copies the right half of the output image of HDMI 3.

OPT 5 copies the left half of the output image of HDMI 5.

OPT 6 copies the right half of the output image of HDMI 5.

OPT 7 copies the left half of the output image of HDMI 7.

OPT 8 copies the right half of the output image of HDMI 7.

Switcher and PGM only modes

4x 3.5 mm audio jacks (AUDIO) including 2x line in & 2x line out (The audio

OPT 1 copies HDMI 1.
OPT 2 copies HDMI 1.
OPT 3 copies HDMI 3.
OPT 4 copies HDMI 3.
OPT 5 copies HDMI 5.
OPT 6 copies HDMI 5.
OPT 7 copies HDMI 7.
OPT 8 copies HDMI 7.

function will be implemented in future updates.)

Each includes a DP 1.2/HDMI 2.0. When two connectors have signals, only one can
be used as the input source at the same time.
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Outputs 1to 4

Each includes two HDMI 2.0:
e 4K

- In switcher mode, connectors 1 and 5 work as primary. Connectors 2, 3 and 4
copy connector 1, and connectors 6, 7 and 8 copy connector 5. The
resolutions of connectors 1 and 5 can be set independently.

- In PGM only mode, connectors 1, 3, 5 and 7 work as primary and connectors
2,4, 6 and 8 copy connectors 1, 3, 5 and 7, respectively. Connector 1 and 3
are in the same group and connectors 5 and 7 are in the same group.
Connectors in the same group have the same resolution.

- In both switcher and PGM only modes, connectors 1, 3, 5 and 7 work as
primary and connectors 2, 4, 6 and 8 copy connectors 1,3, 5 and 7,
respectively. Connector 1 and 3 are in the same group and connectors 5 and
7 are in the same group. Connectors in the same group have the same
resolution.

Multiviewer output
The P20 is designed with an HDMI 1.3 for Multiviewer output. A Multiviewer display

can be connected, allowing for live monitoring of all the inputs and outputs from one
display. The output resolution is fixed at 1920x1080@60Hz.

AUX Outputs

The P20 comes with four HDMI 1.3 for AUX outputs. Auxiliary devices such as
teleprompters can be connected. The output resolution defaults to
1920x1080@60Hz.

Ethernet Ports

¢ Two Ethernet ports are provided for control and live input view.
¢ One works as primary and the other as backup.

* They have the same function and share the same IP address.

Genlock IN & LOOP

Genlock synchronization signal connectors are provided.

¢ GENLOCK IN: Synchronization signal input
¢ GENLOCK LOOP: Synchronization signal loop output

Power Connector and Switch

¢ Power connector and rocker switch
¢ 100-240V~, 3.0-1.5A, 50/60Hz
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LED Work Lights a

nd Switches

At some event venues, the lights may be very dim. For users’ convenience, the
P20 is designed with two LED work lights to provide adequate light for rear panel
operations. The LED work lights come with pushbutton switches (red) next to
them.

Specifications of input and output video connections
* DP1.2

Maximum resolution: 4096x2160@60Hz/8192x1080@60Hz

Minimum resolution: 800x600@60Hz

Maximum width: 8192 pixels (8192x1080@60Hz)

Maximum height: 8192 pixels (1080x8192@60Hz)

Maximum frame rate: 120 Hz

EDID management (support for standard resolutions and custom resolutions)
HDCP 1.3 compliant

e HDMI 2.0

Maximum resolution: 4096x2160@60Hz/8192x1080@60Hz

Minimum resolution: 800x600@60Hz

Maximum width: 8192 pixels (8192x1080@60Hz)

Maximum height: 8192 pixels (1080x8192@60Hz)

Maximum frame rate: 120 Hz

Support for HDR

EDID management (support for standard resolutions and custom resolutions)
HDCP 2.2 compliant and downward compatible

e 12G-SDI

Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD)
Maximum resolution: 4096x2160@60Hz

Maximum frame rate: 60 Hz

Support for interlaced input signal

5.2 P10 Hardware Introduction
5.2.1 Front Panel

The

P10 front panel is designed with a 5-inch LCD, a knob and a variety of function

buttons that allow for menu operations by button presses. A USB port is provided on
the front panel for updating device firmware, import and export files.
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Figure 5-3 P10 front panel
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1. Chassis handles (L+R) 6. LCD screen

2. Power button 7. Knob

3. USB port 8. BACK button

4. Source buttons 9. Function buttons

5. Layer buttons

Chassis Handles

Power Button

USB Port

Two handles are provided for easy installation and transportation.

Press the button to turn on/off the device. To turn off the device, press the button
and select OK from the dialog box displayed on the LCD screen to confirm your
operation.

¢ Breathing dim white: The power supply is connected.

* Bright white: The device is turned on.

A Type-A USB 2.0 port is provided for updating device firmware, import and export
project files, EDID files, BKG files, LOGO files and logs via USB drive.

Source Buttons

Press a button to access the input settings menu or select the source. These buttons
can also be used to enter numbers.

Button LED color and source status (INPUT 1 to 6):

* Dim white: No signal and not in use

Breathing blue: Signal accessed and not in use

¢ Blue: Signal accessed and in use
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Layer Buttons

LCD Screen

Knob

Back Button

LAYER 1 to 6: Press a button to open the layer and access the layer menu. Press and
hold the button to close the layer.

Button LED color and source status:

* Dim white: The layer is closed.
e Bright blue: The layer is open.

* Blinking blue: the layer is in edit mode.

A 5-inch LCD screen is designed for displaying all the menus, submenus and
messages.

After startup, the screen displays the home screen. For detailed information on the
home screen, see 6.1 P20/P10 Menu Operations.

Rotate the knob to scroll up or down through the menus.
* Rotate the knob clockwise to scroll down.

* Rotate the knob counter-clockwise to scroll up.
Press the knob to select menu items.

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or
unlock the front panel buttons.

Press the BACK button to exit a menu without making changes, to cancel an
operation, or to return to the home screen. Each press takes you back up the menu
tree one level.

Press and hold the knob and BACK button simultaneously for 3s or longer to lock or
unlock the front panel buttons.

Function buttons

¢ PRESET: Press the button to access the preset settings menu.

- Dim white: The preset settings menu is not displayed.
- Blinking blue: The preset settings menu is displayed.

e SCALE: Press the button to enable the full screen scaling of the layer at the back
of the Z-order.

- Blinking blue: Full screen scaling is enabled successfully.

¢ FN: This is a custom shortcut button and users can assign a function to the FN
button.

When Freeze, FTB (Fade to Black), or Genlock synchronization is assigned, press
the button to enable the assigned function.

Button LED color and source status:
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- Dim white: The function is disabled.
- Blue: The function is enabled.
When Capture is assigned, press the button to access the Capture menu.
- Dim white: The Capture menu is displayed.
- Blinking blue: Capturing...
¢ TAKE: Press the button to switch content from PVW to PGM with a specified
transition effect.

- Dim white: Content is not switched.
- Blinking blue: Content is being switched.

5.2.2 Rear Panel

The P10 rear panel provides a variety of I/0 connectors including 6x 4K inputs (4x
DP1.2/HDMI 2.0 and 2x 12G-SDI), 8x outputs (2x HDMI 2.0 and 6x HDMI 1.3), and 4x
10G optical fiber ports.

Figure 5-4 P10 rear panel

1. Inputs 5and 6 6. AUX outputs

2. Inputs 1to 4 7. Outputs 1t0 8

3. OPT outputs 1to 4 8. Control connectors

4. Audio jacks 9. Power connector and switch
5. Multiviewer output

Inputs 5and 6

Two 12G-SDI IN & LOOP connectors are provided.

Inputs 1to 4

Each includes a DP 1.2 and HDMI 2.0. When both have signals, only one can be used
as the input source at the same time.

OPT Outputs 1to 4

Four optical fiber ports are provided for copying the output of the HDMI connectors.
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4K:

* Switcher mode
- OPT 1 copies the left half of the output image of HDMI 1.
- OPT 2 copies the right half of the output image of HDMI 1.
- OPT 3 copies the left half of the output image of HDMI 1.
- OPT 4 copies the right half of the output image of HDMI 1.
* PGM only mode
- OPT 1 copies the left half of the output image of HDMI 1.
- OPT 2 copies the right half of the output image of HDMI 1.
- OPT 3 copies the left half of the output image of HDMI 5.
- OPT 4 copies the right half of the output image of HDMI 5.

SL:

e Switcher mode
- OPT 1 copies HDMI 1 and HDMI 2.
- OPT 2 copies HDMI 3 and HDMI 4.
- OPT 3 copies HDMI 1 and HDMI 2.
- OPT 4 copies HDMI 3 and HDMI 4.
¢ PGM only mode
- OPT 1 copies HDMI 1 and HDMI 2.
- OPT 2 copies HDMI 3 and HDMI 4.
- OPT 3 copies HDMI 5 and HDMI 6.
- OPT 4 copies HDMI 7 and HDMI 8.

Audio Jacks (The audio function will be implemented in future updates.)

Four 3.5 mm dual-channel audio jacks are provided, including two line in jacks and
two line out jacks.

Multiviewer Output

The P10 is designed with an HDMI 1.3 for Multiviewer output. A Multiviewer display
can be connected, allowing for live monitoring of all the inputs and outputs from one
display. The output resolution is fixed at 1920x1080@60Hz.

AUX Outputs

The P10 comes with two HDMI 1.3 connectors for AUX outputs. Auxiliary devices
such as teleprompters can be connected. The output resolution defaults to
1920x1080@60Hz.

Outputs 1to 8

The P10 provides eight HDMI output connectors including two HDMI 2.0 and six
HDMI 1.3.

4K:
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¢ In switcher mode, connector 1 works as primary connector for 4K output and
connector 5 copies connector 1.

* In PGM only mode, connectors 1 and 5 can work as primary connectors and have
the same resolution.

SL:

* In switcher mode, connectors 1 to 4 work as primary and connectors 5 to 8 copy
connectors 1 to 4, respectively. Connectors 1, 2, 3 and 4 have the same resolution.

* In PGM only mode, eight connectors work as primary. All the connectors have the
same resolution.

Control Connectors

The P10 provides two Ethernet ports and a Genlock connector with loop-through.
Ethernet

Two Ethernet ports are used for control and live input view (One works as primary
and the other as backup. They share the same IP address.).

Genlock IN & LOOP
Genlock synchronization signal connectors are provided.

e GENLOCK IN: Synchronization signal input
¢ GENLOCK LOOP: Synchronization signal loop output

Power Connector and Switch

¢ Power connector: 100-240V~, 3.0-1.5A, 50/60Hz
e Power switch:

—  ON: Power on
- OFF: Power off

Specifications of input and output video connections
e DP1.2

- Maximum resolution: 4096x2160@60Hz/8192x1080@60Hz
- Minimum resolution: 800x600@60Hz
- Maximum width: 8192 pixels (8192x1080@60Hz)
- Maximum height: 8192 pixels (1080x8192@60Hz)
- Maximum frame rate: 120 Hz
- EDID management (support for standard resolutions and custom resolutions)
- HDCP 1.3 compliant
 HDMI 2.0
- Maximum resolution: 4096x2160@60Hz/8192x1080@60Hz
- Minimum resolution: 800x600@60Hz
- Maximum width: 8192 pixels (8192x1080@60Hz)
- Maximum height: 8192 pixels (1080x8192@60Hz)
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Maximum frame rate: 120 Hz
EDID management (support for standard resolutions and custom resolutions)
HDCP 2.2 compliant and downward compatible

12G-SDI

Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD)
Maximum resolution: 4096x2160@60Hz

Maximum frame rate: 60 Hz

Support for interlaced input signal

HDMI 1.3

Maximum resolution: 1920x1080@60Hz/2048x1080@60Hz
Minimum resolution: 800x600@60Hz

Maximum width: 2048 pixels (2048x1080@60Hz)

Maximum height: 2048 pixels (1080x2048@60Hz)
Maximum frame rate: 120 Hz

EDID management (support for standard resolutions up to 2048x1152@60Hz
and custom resolutions)

HDCP 1.4 compliant and downward compatible

5.3 Q8 Hardware Introduction

5.3.1 Front Panel

The Q8 front panel is designed with a 7-inch touchscreen, a power button, and two
LED strips. A LINK port is provided on the front panel to link a second Q8.

Figure 5-5 Q8 front panel
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Seamless Switcher
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No. Type Description

1 Power button Power on: Press the button to power on the device.

Power off: Press the button, and a shutdown prompt
window appears on the LCD screen. Click or tap Yes to
shut down the device.

2 LED strip Indicate the device running status.

3 Touchscreen Display the device status, menus, submenus and
messages for parameter settings.

4 USB 3.0 A USB type-A port used to update the device, export
device logs, and import and export project files.

5 LINK ports Reserved ports, used to link two Q8 units for cascading
and control.

e 3x CXP ports

® IxLINKIN

e IxLINKOUT

* 1xOPT

6 LINK port cover | The cover for LINK ports

5.3.2 Rear Panel

The Q8 rear panel provides a variety of I/0 connectors including 72x 4K input
connectors (HDMI 2.0, DP1.2, 12G-SDI, SFP25G), 48x output connectors (HDMI 2.0,
DP1.2, 12G-SDI, 10G OPT).
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Figure 5-6 Q8 rear panel
INT to IN6: Input Card Slots OUT1 to OUT4: Output Card Slots

i
a

Sl [ [

Power Connectors: 2 Primaries + 1 Backup Control Card

E Note

The picture above is the rear panel of the device when it is fully loaded. Users can
configure input and output cards as needed.

The input and output cards do not support hot-swapping, and the input and output
cards must be installed in ascending order of the card slot numbers.

The input and output cards can be replaced. Refer to the table below for input and
output card selection.

Card Slot Area | Configurable Input and Output Cards

Up to 6 input cards can be installed, which can be selected from the
following.

* Q_4x HDMI2.0+4x DP1.2+4x 12G-SDI Input Card
® Q_ST2110_4xSFP25G Input Card_l

Input card slot

Output card slot Up to 4 output cards can be installed.

Q_4x HDMI 2.0+4x 12G-SDI Optical Output Card

Control card Control Card
Power Support 2 primary and 1 backup power supplies. Before powering on
connector the device, connect at least two power supplies.

Power specifications: 100-240V~, 50/60Hz, 10A-5A
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5.3.2.1 Input card

When installing input cards, they must be installed starting from slot 1 and in
ascending order. No empty slots can be left between them.

Input cards do not support hot-swappable installation. Before installation, the device
must be powered off. Once the installation is completed, the device can be powered
on for use.

5.3.2.1.1 Q_4x HDMI2.0+4x DP1.2+4x 12G-SDI Input Card

12,
I

& & 8

Y
12G-SDI o 2 5  12G-SDI ¢ 7 12G-SDl g
_ .

9,
‘O

‘) = ]

HDMI2.0 HDMI'2.0

Connectors

* 4xHDMI 2.0
e 4xDP1.2
e 4x12G-SDI

Specifications

e 8x 4Kx2K@60Hz concurrent inputs per input card

¢ Each input card supports a maximum of 4-channel deinterlacing processing
e Each input card provides a maximum of 4 sync sources

 HDMI 2.0

- Up to 4Kx2K@60Hz 10bit 4:2:2, or 4Kx2K@60Hz 8bit 4:4:4

- Support for processing of 8-bit, 10-bit and 12-bit inputs

- Support for 4:2:0, 4:2:2 and 4:4:4 inputs

- Support for processing of Full and Limited range videos

- Support for HDR video inputs

- HDCP 1.4 and HDCP 2.2 compliant

- Support for deinterlacing processing

- Custom resolutions

Maximum width: 8192 pixels; maximum height: 8192 pixels

e DP1.2

- Upto 4Kx2K@60Hz 10bit 4:4:4, or 4AKx2K@60Hz 8bit 4:4:4
- Support for processing of 8-bit, 10-bit and 12-bit inputs
- Support for 4:2:2 and 4:4:4 inputs
- Support for processing of Full and Limited range videos
- Support for HDR video inputs
- HDCP 1.3 and HDCP 2.2 compliant
- Custom resolutions
Maximum width: 8192 pixels; maximum height: 8192 pixels
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e 12G-SDI

~ Support for ST-2082 (12G), ST-2081 (6G), ST-424 (3G), ST-292 (HD) and ST-
259 (SD) standard video inputs

- Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI
- Support for interlaced signal inputs
- No support for EDID management or bit depth settings

Status LEDs

Each input connector has a status LED which indicates source access status.

¢ On: The source is accessed.

e Off: The source is not accessed or it is abnormal.

5.3.2.1.2 Q_ST2110_4xSFP25G Input Card_l|

TN a "l
(J PRIMARY — 1 — BACKUP =g PRIMARY — 2 — BACKUP | iE
] ! EEEE .| | . EEEEE
z U oPT(256) ——/ : OPT (256) —

4x SFP25G

Connectors

Features
¢ 25G SFP28 interface: For video source transmission, control, and synchronous
clock input.

¢ Supports SMPTE 2110-10 and 2110-20, and backup supports the ST2022-7
standard.

» Hardware-based precision time protocol (PTP) guarantees the nanosecond-level
synchronization accuracy requirements of ST2059-1 and ST2059-2.

¢ The video interface and control interface are combined into one, supporting
standard NMOS discovery and registration devices (I1S-04), management and
control devices (IS-05).

¢ Simultaneous input of primary and backup video sources, enabling seamless
transition when necessary.

Connector Specifications

e 2 primary and 2 backup inputs per input card
Standard: Supports SMPTE ST 2110 (-10, -20) and SMPTE 2059 (-1, -2) standards.
¢ Backup: Supports SMPTE 2022-7 standard.

¢ Resolutions:

- Max resolution: 4096x2160@60Hz
- Minresolution: 800x600@60Hz
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¢ SDP management: Supports VESA standard input resolution.

¢ NMOS management: NMOS discovery and control according to standards 1S-04
and 1S-05

¢ Color gamut: BT.601/BT.709/BT.2020
* [P address: IPv4 DHCP and static IP

¢ Multicast protocol: IGMPv3, IGMPv2

* Ethernet:

- 25 GbE IEEE 802.3cc (25GBASE-LR)
-~ 25 GbE IEEE 802.3by (25GBASE-SR)

Port Configuration

You can configure the port information through the following three methods:
¢ Connect to the NMOS management software for visualized configuration.
¢ Import the SDP file for offline configuration.

¢ Through the event management software PixelFlow

- Video stream destination IP: port (primary/backup)
- Video source IP (primary/backup)
- Port local IP (primary/backup)

Video Source Specifications

Input Bit Depth Sampling Format Max Input Resolution
RGB 4:4:4 4096x2160@60HZz
SFP25G 8bit\10bit YCbCr 4:4:4
YCbCr 4:2:2
5.3.2.2 Output Card

When installing output cards, they must be installed starting from slot 1 and in
ascending order. No empty slots can be left between them.

Output cards do not support hot-swappable installation. Before installation, the
device must be powered off. Once the installation is completed, the device can be
powered on for use.

5.3.2.2.1 Q_4x HDMI 2.0+4x 12G-SDI Optical Output Card

12G-SDI 12G-SDI 1ZG-SDI

o HDMI 2.0 HDMI 2.0 HDMI 2.0 HDMI 2.0

30 Q )
)

Connectors

e 4xHDMI 2.0
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Specifications

Status LEDs

4x 12G-SDI
8x 10G OPT

The 4x HDMI 2.0 and 4x 12G-SDI connectors are divided into 4 groups. Each group
includes 1x HDMI 2.0 and 1x 12G-SDI connectors, and one connector copies the
output of the other. The 12G-SDI connector supports only standard resolutions
under the protocol. When the HDMI 2.0 connector is set to a custom resolution,
the 12G-SDI connector does not output.

- Connector 1 (HDMI 2.0) and connector 5 (12G-SDI) are in a group.
- Connector 2 (HDMI 2.0) and connector 6 (12G-SDI) are in a group.
- Connector 3 (HDMI 2.0) and connector 7 (12G-SDI) are in a group.
- Connector 4 (HDMI 2.0) and connector 8 (12G-SDI) are in a group.
4x HDMI 2.0

- Upto 4Kx2K@60Hz 8bit 4:4:4 output
- Support for 8-bit and10-bit output settings
- Support for 4:2:2 and 4:4:4 output settings
- Support for YCbCr and RGB color space settings
- No support for interlaced signal outputs
- Custom resolutions
Maximum width: 8192 pixels; maximum height: 8192 pixels

4x 12G-SDI

- Compatible with SD-SDI, HD-SDI, 3G-SDI and 6G-SDI
- No support for interlaced signal outputs

8x 10G OPT

- Support for single-mode and multi-mode optical outputs, transmission
distance up to 10km in single mode

- OPT ports copy outputs on video connectors

- OPT 1 and OPT 2 copy the output on connector 1 or 5.
- OPT 3 and OPT 4 copy the output on connector 2 or 6.
- OPT 5 and OPT 6 copy the output on connector 3 or 7.
- OPT 7 and OPT 8 copy the output on connector 4 or 8.

Each HDMI output connect has a status LED which indicates the connection status of
backend device. The 12G-SDI and optical port do not have status LEDs.

On: The output connection is normal.

Off: The output connection is abnormal.
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5.3.2.3 Control Card

(2}
m
r
[,
(o)
(e)
A

ETHERNET
2x Neutrik Gigabit Ethernet ports
¢ The two Ethernet ports work as a copy channel for each other
¢ Connect to the U5, U5 Pro or control computer
¢ Transmit the input view information to the control computer or U5/U5 Pro event
controller
e Support control by central control command
Multiviewer (MVR)
2x HDMI 2.0
Connect to the monitor to display the Multiviewer image in copy or independent
mode
* Inindependent mode, the two Multiviewer connectors are used to display two
different MVR images
* In copy mode, HDMI 2 copies the output on HDMI 1
USB 3.0
1x USB 3.0
e Export device logs
¢ Update the device and fix system bugs
AUDIO
1x 3.5mm audio input, 1x 3.5mm audio output
* IN for external audio input connection
e OUT for audio output
Dante

2x RJ45 digital network audio ports for audio input and output

¢ Support network audio input and output

¢ Support 64x64 audio swapping
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GENLOCK

Tx GENLOCK IN, 1x GENLOCK LOOP
e Support Bi-Level and Tri-Level

* GENLOCK IN: Accept the external sync signal
e GENLOCK LOOP: Loop the sync signal
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Menu Operations

About This Chapter

This chapter introduces you to the system menus of the P20/P10 and Q8, including
how the menus are accessed and the available functions and parameters. The menu
pictures are presented throughout the chapter.

Overview

e P20/P10 Menu Operations

- Startup and Shutdown
- Home Screen
- Input
- Output
- Screen
- Layer
- Preset
- Multiviewer (MVR)
- Network
- Advanced
- Mode
- About Us
- Language
* Q8 Menu Operations

- Startup and Shutdown
- Home Screen

a Note:

All menu pictures shown in this chapter are for illustration purposes only. Actual
product may vary.
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6.1 P20/P10 Menu Operations

The 5-inch LCD and a variety of buttons on the front panel of the P20/P10 allow for
pretty darn simple operations. The following sections will introduce the operations in
detail.

6.1.1 Startup and Shutdown

Connect all the necessary cables and power cords properly, locate and turn on the
rocker switch on the rear panel. The startup screen appears, as shown in Figure 6-1.
The P20/P10 front panel provides a 5-inch LCD screen allowing for more intuitive
operations.

Figure 6-1 Startup screen

PIXELHUE

To turn off the P20/P10, press the power button on the front panel and select OK
from the dialog box displayed on the LCD screen.

6.1.2 Home Screen

After the startup, the home screen is displayed. The following descriptions use the
P20 home screen as an example, as show in Figure 6-2 and Table 6-1.
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Figure 6-2 Home screen (P20)

P20 SYSTEM 8} 192.168.100.100 §3 (B

SCREEN1 Aux 2 FTB 3840 %2160 & GENLOCK
£ EoiT | [PUW L)

PGM
2 2 Mls5 6 i BACK UP
[z [{oa ] wos | wos| e
ot [[mos|

i d 2 MODE
o | os] e
EFFECTS
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PGM-2 PGM-1 PGM-2 2 [C2]s

Table 6-1 Home screen description

No. | Description

1 Displays the device information.
. Logo of PIXELHUE
P20 Device model
SYSTEM Device name
E Front panel lock
* When this icon is displayed, the front panel buttons are
locked.
* When this icon is not displayed, the front panel buttons are
unlocked.

Press and hold the knob and BACK button simultaneously for
3s or longer to lock or unlock the front panel buttons.

192.168.100.10 | Device IP address

0 For details, see 6.1.10 Network.

Connection status of the Ethernet port on the rear panel
. : An Ethernet cable is connected.
. E‘Ez No Ethernet cable is connected.

Connection status of the USB drive on the front panel
. : A USB drive is inserted.
. E: No USB drive is inserted.

2 SCREEN 1 Displays the information of common and AUX screens.

When there are multiple screens, you can rotate the knob to
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No. | Description

switch between the screens.

* When Test Pattern, FTB or Freeze is turned on, Test Pattern
FTB or FRZ is displayed at the top of this section.

* The screen resolution is displayed on the right of this
section.

® The layer resource usage is displayed at the bottom of this
section.

Layer source status:

* When an input source name is displayed, it indicates that
the source is selected. When the source name is in green,
the source is normal. When the source name is in gray, it
indicates no signal. M denotes that it is a MAIN layer.

* When N/A is displayed, no input source is selected and the
layer is blank.

3 GENLOCK Signal synchronization status
For details, see 6.1.11.1 Set Synchronization Signal Source.
BACKUP Device backup on/off
MODE Working mode of the device
e Switcher
e PGM Only
For details, see 6.1.12 Mode.
EFFECTS Transition effect
e Cut
* Fade
For details, see 6.1.7 Transition.
4 OUTPUT Displays the output connector statuses.

¢ When an output connector icon is in green, an output
device is connected.

¢ When an output connector icon is in blue, no output
device is connected.

¢ When the border of an output connector icon is in orange,
the connector is used for copying output.

On the home screen, press the knob to access the main menu screen and complete
relevant settings. The following sections will describe menu operations in detail.
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Figure 6-3 Main menu (P20)
% Input Input Source Input 1 4
& Output Connector HDMI2.0 «
Pyl Screen Capacity 4K 4
8 Layer Input Resolution 3840x2160@60Hz >
@) Transition Input Color >
* Preset InfoFrame Override >
= MVR HDCP
#, Network HDCP Status Encrypted
6.1.3 Input

The Input menu allows you to do the following:

¢ Select Connector Type

* Select Connector Capacity
* SetEDID

e Import and Export EDID

¢ Set Input Color

* Set InfoFrame Override

* SetHDCP

* View HDCP Status

6.1.3.1 Select Connector Type

Select the desired input connector to use it as the input source.

Prerequisites

e ForaDP 1.2/HDMI 2.0 input, only one connector can be selected as the input
source at the same time.

e Connector type selection is not available for the 12G-SDI connectors.

Notes:

After the input connector is changed:

* The layers on the common screen and AUX screen become blank.

e The connector properties such as the resolution and color settings are reset to the
defaults.
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Menu Orientation

On the main menu screen, scroll to and select Input > Connector.

Figure 6-4 Input connector selection (P20)

B Input
& Output

My Screen

4 Layer

@®) Transition

3553

Preset
= MVR

#, Network

Description

Input Source

. Connector
Capacity
Input Resolution
Input Color
InfoFrame Override

HDCP
HDCP Status

Input 1,

HDMI2.0 «

4K 4
3840x2160@60Hz >
>

>

On 4
Encrypted

Menu Iltem

Description

Input Source

Select an input source.
e P20

Includes 12x input sources. Inputs 1 to 8 contain 8x DP 1.2/HDMI 2.0

and Inputs 9 to 12 contain 4x 12G-SDI.

e P10

Includes 6x input sources. Inputs 1 to 4 contain 4x DP 1.2/HDMI 2.0

and Inputs 5 to 6 contain 2x 12G-SDI.

Connector

Select the type of the input connector. Either DP 1.2 or HDMI 2.0 can be

selected.

6.1.3.2 Select Connector Capacity

Select a connector capacity so that the device can calculate the number of layers
that can be added on the common screen according to the selected connector

capacity.

Prerequisites

An input source and connector type are selected. Connector type selection is not

available for 12G-SDI.

Notes

After the connector capacity is changed:

www.pixelhue.com




All-New Event Presentation Switching Solutions

User Manual 6 Menu Operations

¢ The layers on the common screen become blank and the DSK function is turned
off.

* The connector properties such as the resolution and color settings are reset to the
defaults.

Menu Orientation
On the main menu screen, scroll to and select Input > Capacity.
Figure 6-5 Connector capacity selection (P20)
N Input Input 1

& Output

Input Source

HDMI2.0 «

| Capacty .

Connector

My Screen

£ Layer

@) Transition

233>

Preset
= MVR

#, Network

Input Resolution
Input Color
InfoFrame Override

HDCP
HDCP Status

3840x2160@60Hz >
>
>

On 4
Encrypted

Description
Menu ltem Description
Capacity Resource usage of the input connector
e DL:4Kx1K
* 4K: 4Kx2K

6.1.3.3 Set EDID

Set input resolution and frame rate. You can either choose a standard resolution
provided by the system or customize a resolution, and set advanced parameters.

Prerequisites

¢ The video source is output by graphics card.

* Aninput source and connector type (DP 1.2/HDMI 2.0) are selected. EDID settings
are not available for the 12G-SDI connectors.

Notes

Advanced settings must be done by trained professionals.
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Menu Orientation

On the main menu screen, scroll to and select Input > Input Resolution.

Figure 6-6 Input resolution settings (P20)

Description

BN Input
& Output

Fy Screen

#* Layer

® Transition

2333

Preset
= MVR

¥, Network

Input Source

Connector
Capacity

Input Color
InfoFrame Override

HDCP
HDCP Status

Input 1

HDMI2.0 «

4K 4
3840x2160@60Hz >
>

>

On 4
Encrypted

Menu Item

Submenu ltem

Description

Current Resolution

Current input resolution: Pixel width and
height of the input source

Standard Resolution Commonly used resolution
Frame Rate Commonly used frame rate
Frames per second (Hz)
Custom Width Pixel width of the input source
Height Pixel height of the input source
Frame Rate Frames per second (Hz)
Advanced Frame Rate Frames per second (Hz)
H Total The total number of pixels per line
Width Pixel width of the active area

H Front Porch

The offset between the end of the active area

and the beginning of H sync

H Sync H sync width in pixels

H Polarity Polarity (active high or low) of the horizontal
sync pulse

V Total The total number of pixels per frame

Height Pixel height of the active area
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Menu ltem Submenu ltem | Description

V Front Porch | The offset in lines between the end of the
output active area and the beginning of V

sync
V Sync V sync width in lines
V Polarity Polarity (active high or low) of the vertical
sync pulse

After the settings are completed, select Apply for the settings to take effect.

6.1.3.4 Import and Export EDID

When there is something wrong with the input connector compatibility, import EDID
files without compatibility problems into the device. Or export EDID files from the
device and provide the files for other devices or input connectors to solve
compatibility problems.

Prerequisites

» Before importing an EDID file, copy the file (.bin and .dat) to the root directory of a
USB drive and insert the USB drive into the USB port on the front panel of the
P20/P10.

* Before exporting an EDID file, insert a USB drive into the front panel of the
P20/P10.

* Aninput source and connector type are selected. EDID import and export are not
available for 12G-SDI.

Notes

¢ The USB port on the P20/P10 front panel does not support USB HUB.

¢ Only one EDID file can be imported for an input connector and the file must be
less than 1 MB.

Menu Orientation

On the main menu screen, scroll to and select Input > Input Resolution > Import
EDID/Export EDID.

Figure 6-7 EDID import/export (P20)

B Input Input Source Input 1 4

B Input < Input Resolution

S Output Connector HDMI2.0 4 S Output Current Resolution 3840x2160@60Hz

[y Screen Standard >

i Screen Capacity 4K 4

& Layer | Input Resolution 3840x2160@60Hz >

4 Layer Custom
@) Transition Advanced
# Preset | Import EDID

= MVR Export EDID
¥, Network

@) Transition Input Color

1 Preset InfoFrame Override

= MVR HDCP

¥, Network HDCP Status Encrypted

www.pixelhue.com 51



All-New Event Presentation Switching Solutions

User Manual

6 Menu Operations

Description

* Import EDID

a. Scroll to and select Import EDID to access the EDID file screen.

b. Select the file to be imported.

c. Inthe dialog box that appears, select OK.
e Export EDID

d. Scroll to and select Export EDID to access the submenu.
e. From the drop-down options, select a file format (.bin or .dat).
f. Select Apply.

E Note:

If you want to modify the content of an imported EDID file, modify the file, import it
again and overwrite the original one.

6.1.3.5 Set Input Color

Set the color parameters of an input connector so that the color effect can be applied
to all the video sources accessed from this connector.

Prerequisites

An input source and connector type are selected. Input color settings are not

available for the 12G-SDI connectors.

Menu Orientation

On the main menu screen, scroll to and select Input > Input Color.

Figure 6-8 Input color settings (P20)

N Input
& Output

Py Screen

# Layer

@® Transition
¥ Preset
= MVR

#, Network
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Connector
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\ Input Color
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Description

Menu Item Description

Brightness Brightness is the shading of lights in the image. When the brightness
increases, viewers will be dazzled. When the brightness decreases, the
image becomes dark.

Contrast Contrast is the ratio of the luminance of the brightest color to that of
the darkest color. Generally, the higher the contrast, the clearer and
more colorful the image. On the contrary, the entire image becomes
gloomy. Contrast affects the exposure level of the entire image. It
makes the bright part brighter and the dark part darker.

Saturation Saturation is the colorfulness of the image. The higher the contrast,
the more vivid the image.

Hue Hue is the relative degree of how bright or dark the image is.

If you want to reset the parameters to their default values, select Apply.

6.1.3.6 Set InfoFrame Override

Set the override parameters of the input source. The parameters can be used by the
device for calculation. This operation does not change the original parameter values
of the input source.

Prerequisites

* Aninput source and connector type (DP 1.2/HDMI 2.0) are selected. InfoFrame
override settings are not available for the 12G-SDI connectors.

¢ To set dynamic range conversion, make sure the device is P20, the connector is
HDMI 2.0, and dynamic range conversion is turned on in Advanced. For details,
see 6.1.11.3 Turn on/off Dynamic Range Conversion.

Menu Orientation

On the main menu screen, scroll to and select Input > InfoFrame Override.
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Figure 6-9 InfoFrame override (P20)
BN Input Input Source Input 1
& Output Connector HDMI2.0 «
"y Screen Capacity 4K 4
# Layer Input Resolution 3840x2160@60Hz >
@ Transition Input Color >
" Preset | infoFrame Override >
= MVR HDCP on..
#5 Network HDCP Status Encrypted
Description

Menu Iltem

Description

Color/Sample

Set the input color space and sampling rate

Bit Depth

Set the input bit depth

Bit depth refers to the color information stored in an image. The higher
the bit depth of an image, the more colors it can store.

Quantization
Range

Set the input quantization range

Dynamic Convert the dynamic range. Free conversion between SDR, HDR10 and
Range HLG is supported.
This menu item is displayed only when Dynamic Range Conversion is
turned on (@D).
Color Gamut Set the input color gamut standard

This menu item is displayed only when Dynamic Range Conversion is

turned on (@D).

Tone Mapping

Set mapping mode. This menu item is displayed when Dynamic Range
is HDR10.

e @) On. Luminance overrides Peak Screen Brightness.
o (: Off. Luminance overrides Max CLL.

Luminance Peak luminance. This menu item is displayed when Dynamic Range is
HDR10 or HLG.

Ambient Ambient brightness. This menu item is displayed when Dynamic

Brightness Range is HDR10 or HLG.

When you set a parameter value to AUTO, the device will get the actual value from
the properties of the input source automatically.
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6.1.3.7 Set HDCP

HDCP (High-Bandwidth Digital Content Protection) is a coding scheme used to
protect audio and video signals traveling through DVI, HDMI, and DP from being
copied and illegally intercepted during a streaming session. Users can turn on/off

HDCP for input connectors. HDCP is turned on by default.

Prerequisites

An input source and connector type are selected.

Note

SDI does not support HDCP. If 12G-SDl is select as the input source, the HDCP

function will be unavailable.

Menu Orientation

On the main menu screen, scroll to and select Input > HDCP.

Figure 6-10 HDCP (P20)

B Input
& Output

Py Screen

8 Layer

@ Transition
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= MVR

#, Network

Description

Input Source

Connector
Capacity

Input Resolution
Input Color

InfoFrame Override

[T —
HDCP Status

Input 14

HDMI2.0 «

4K 4
3840x%2160@60Hz >
>

>

Encrypted

Select On or Off to turn on or off HDCP function for the input source.

6.1.3.8 View HDCP Status

View the HDCP status of the selected video source.

Prerequisites

An input source and connector type are selected. This is not available for 12G-SDI.

Menu Orientation

On the main menu screen, scroll to and select Input > HDCP Status.
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Figure 6-11 HDCP status (P20)
B Input Input Source Input 1
& Output Connector HDMI2.0 «
"y Screen Capacity 4K 4
& Layer Input Resolution 3840x2160@60Hz >
@ Transition Input Color >
 Preset InfoFrame Override b
= MVR HDCP
#, Network
Description
Menu ltem Description
HDCP Status HDCP status of the selected video source
® Encrypted: The video source is encrypted by HDCP.
* Not Encrypted: The video source is not encrypted by HDCP.
* Unknown: The HDCP encryption status is not obtained.
6.1.4 Output

The Output menu allows you to do the following:

Select Output Capacity
Set Output Resolution
Export EDID

Set Output Color

Set Output Information
Set HDCP

6.1.4.1 Select Output Capacity

Set the output capacity of the common screen.

Prerequisites

An output is selected. Output capacity selection is not available for AUX outputs.

Menu Orientation

On

the main menu screen, scroll to and select Output > Output Capacity.
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Figure 6-12 Output capacity (P20)
B Input Output OUTPUT 1-14
% ouput  [Capasity. 4K 4
Fy Screen Output Resolution 3840x2160@60Hz >
# Layer Output Color
@ Transition Output Information
¥ Preset HDCP
= MVR
¥, Network
Description
Menu ltem Description
Output Select an output for settings.

e OUTPUT: Primary output
e AUX: AUX output

Output Capacity | Select the output capacity of the common screen.
e P20

- DL: 4Kx1K

- 4K: 4Kx2K
e P10

- SL:2Kx1K

- 4K: 4Kx2K

6.1.4.2 Set Output Resolution

Set the resolution and frame rate of the common screen. You can select a standard
resolution provided by the system or customize a resolution, and complete advanced
settings.

Prerequisites

¢ The EDID information of the connected device is obtained.

¢ An output connector is selected.

Note

¢ Advanced settings must be done by trained professionals.

e After the output resolution is changed, the AOI parameters related to the
connector are reset to defaults.
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Menu Orientation

Description

B Input
% Output

Py Screen

## Layer

@ Transition

3333

Preset
= MVR

¥, Network

Output

Capacity

Output Color

Output Information

HDCP

On the main menu screen, scroll to and select Output > Output Resolution.

Figure 6-13 Output resolution settings (P20)

OUTPUT 1-14

4K 4

3840x2160@60Hz >

Menu Iltem

Submenu ltem

Description

Current Resolution

Current resolution: Pixel width and height of
the output image

Standard Resolution Commonly used resolution
Frame Rate Commonly used frame rate,
Frames per second (Hz)
Custom Width Pixel width of the output image
Height Pixel height of the output image
Frame Rate Frames per second (Hz)
Advanced Frame Rate Frames per second (Hz)
H Total The total number of pixels per line
Width Pixel width of the active area

H Front Porch

The offset between the end of the active area
and the beginning of H sync

H Sync H sync width in pixels

H Polarity Polarity (active high or low) of the horizontal
sync pulse

V Total The total number of pixels per frame

Height Pixel height of the active area
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Menu ltem Submenu ltem | Description

V Front Porch | The offset in lines between the end of the
output active area and the beginning of V

sync

V Sync V sync width in lines

V Polarity Polarity (active high or low) of the vertical
sync pulse

After the settings are completed, select Apply for the settings to take effect.

6.1.4.3 Export EDID

Prerequisites

Note

When the input connectors of the connected device has good EDID compatibility, the
P20/P10 can learn the EDID of the connected device via the output connectors and
the EDID information can be exported to a USB drive so that other input connectors
of the connected device can use the EDID information.

« AUSB drive is inserted into the USB port on the front panel of the P20/P10.
* The input connectors and the connected device are connected correctly.

* Anoutput is selected.

The USB port on the front panel of the device does not support USB HUB.

Menu Orientation

Description

On the main menu screen, scroll to and select Output > Output Resolution > Export
EDID.

Figure 6-14 Exporting EDID (P20)

B Input Output OUTPUT 1-14«

W Input < Output Resolution
% Output Capacity e

¥ Screen w_ution 3840=2160@60Hz >

# Layer Output Color

% Output Current Resolution 3840=2160@60Hz
"y Screen Standard

# Layer Custom

® Transition Output Information

¥ Preset HDCP

® Transition Advanced

## Preset | Export EDID
2 MVR = MVR

# Network #. Network

Select Export EDID to access the submenu, then select a file format (.bin or .dat) and
output connector, and select Apply to export the EDID information to the root
directory of the USB drive.
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6.1.4.4 Set Output Color

Set output color parameters. The final output color is the combination of layer color,
input color and output color.

Prerequisites

An output is selected.

Menu Orientation

Description

On the main menu screen, scroll to and select Output > Output Color.

Figure 6-15 Output color settings (P20)

B Input
% Output

Py Screen

#8 Layer

@ Transition

2333

Preset
= MVR

¥, Network

Output OUTPUT 1-14

Capacity 4K 4

Output Resolution

' Output Color

Output Information

3840x2160@60Hz >

HDCP

Menu ltem

Description

Brightness

Brightness is the shading of lights in the image. When the brightness
increases, viewers will be dazzled. When the brightness decreases, the
image becomes dark.

Contrast

Contrast is the ratio of the luminance of the brightest color to that of
the darkest color. Generally, the higher the contrast, the clearer and
more colorful the image. On the contrary, the entire image becomes
gloomy. Contrast affects the exposure level of the entire image. It
makes the bright part brighter and the dark part darker.

Saturation

Saturation is the colorfulness of the image. The higher the contrast,
the more vivid the image.

Hue

Hue is the relative degree of how bright or dark the image is.

6.1.4.5 Set Output Information

Set the parameters relating to the output signal.

www.pixelhue.com

60




All-New Event Presentation Switching Solutions

User Manual

6 Menu Operations

Prerequisites

An output is selected.

To set dynamic range conversion, make sure the device is P20 and a primary
output is selected.

Menu Orientation

Description

B Input
% Output

P Screen

## Layer

@ Transition

b33 52

Preset
= MVR

¥, Network

On the main menu screen, scroll to and select Output > Output Information.

Figure 6-16 Output information (P20)

Output OUTPUT 1-14

Capacity 4K 4
Output Resolution 3840x2160@60Hz >
Output Color

HDCP

Menu ltem

Description

Color/Sample

Set output color space and sampling rate.

Bit Depth Set output bit depth.
Bit depth refers to the color information stored in an image. The higher
the bit depth of an image, the more colors it can store.
Dynamic Convert the dynamic range. Free conversion between SDR, HDR10 and
Range HLG is supported.
This menu item is displayed only when Dynamic Range Conversion is
turned on (@D).
Gamma Set gamma value.

This menu item is displayed only when Dynamic Range Conversion is

turned on (@D).

Color Gamut

Set output color gamut standard.
This menu item is displayed only when Dynamic Range Conversion is

turned on (@D).

Tone Mapping

Mapping mode. This menu item is displayed when Dynamic Range is
HDR10.
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Menu Item Description

¢ @D): On. Luminance overrides Peak Screen Brightness.
o (D: Off. Luminance overrides Max CLL.

Luminance Peak luminance. This menu item is displayed when Dynamic Range is
HDR10 or HLG.

6.1.4.6 Set HDCP
HDCP (High-Bandwidth Digital Content Protection) is a coding scheme used to

protect audio and video signals traveling through DVI, HDMI, and DP from being
copied and illegally intercepted during a streaming session. Users can select an
HDCP version for the output connector or turn off the HDCP function. HDCP is turned
on by default.
Prerequisites
An output is selected.
Menu Orientation
On the main menu screen, scroll to and select Output > HDCP.
Figure 6-17 HDCP (P20)
N Input Output OUTPUT 1-14

% Output Capacity 4K 4

Fy Screen Output Resolution 3840x2160@60Hz >

## Layer Output Color

@ Transition Output Information

" Preset  [HDGR..

= MVR

¥, Network

Description

Select an HDCP version, or select Off to turn off HDCP.

6.1.5 Screen

The Screen menu allows you to do the following:
* Set Screen Status
¢ Set Connector Resolution

¢ Set Mosaic
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» Set Edge Blending

» Set Screen Color

¢ Set Output Information
* Set PGM Edit

» Set Display Status

6.1.5.1 Set Screen Status

Enable or disable the screen.

Prerequisites

The screen is a common screen or AUX screen.
Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1/AUX1 > Screen
Status.

Figure 6-18 Screen status (P20)

W input | Seeent W input <
M Output Screen2 M Output | Screen Status L ]

"y Screen AUX1 "y Screen Connector Resolution 3840=2160@60Hz >

# Layer AUX2 &% Layer Mosaic Settings

® Transiion  AUX3 ® Transiton | Edge Blending

W Preset AUXA ¥ Preset Screen Color
= MVR = MVR Output Information

#. Network #, Network PGM Edit

Description
Set Screen Status to @ (on) or (I (off).

6.1.5.2 Set Connector Resolution

Set the connector resolution and frame rate. Users can select a standard resolution
or customize a resolution and set advanced parameters.

Prerequisites

¢ The EDID of the connected display device is obtained.

» _The screen is a common screen or AUX screen and Screen Status is set to @,
Notes

¢ The advanced parameters must be set by the trained personnel.

« After the output resolution is changed, the AOI parameters of the connector is
reset automatically.
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Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1/AUX1 > Connector
Resolution.

Figure 6-19 Connector resolution (P20)

Description

Bonput  [ESeeRI
M Output Screen2

"y Screen AUX1

# Layer AUX2

® Transition AUX3

[ Preset AUX4
= MVR

# Network

M Input <
M Output Screen Status )

|- Gonnector Resolution

Mosaic Settings

"y Screen 3840x2160@60Hz »

#* Layer

-f?" Transition

Edge Blending

¥ Preset Screen Color
& MVR Qutput Information

# Network PGM Edit

Menu Item

Submenu ltem

Description

Current Resolution

Current resolution: Pixel width and height of
the output image

Standard Resolution Commonly used resolution
Frame Rate Commonly used frame rate,
Frames per second (Hz)
Custom Width Pixel width of the output image
Height Pixel height of the output image
Frame Rate Frames per second (Hz)
Advanced Frame Rate Frames per second (Hz)
H Total The total number of pixels per line
Width Pixel width of the active area

H Front Porch

The offset between the end of the active area
and the beginning of H sync

H Sync H sync width in pixels

H Polarity Polarity (active high or low) of the horizontal
sync pulse

V Total The total number of pixels per frame

Height Pixel height of the active area

V Front Porch

The offset in lines between the end of the
output active area and the beginning of V
sync

V Sync

V sync width in lines

V Polarity

Polarity (active high or low) of the vertical
sync pulse
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After the settings are completed, select Apply for the settings to take effect.

6.1.5.3 Set Mosaic

Set screen mosaic by using easy mode or advanced mode.

Prerequisites

The screen is a common screen and Screen Status is setto @),

Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > Mosaic Settings.

Figure 6-20 Mosaic settings (P20)
M Input | Screent B Input <
M Output Screen? S Output Screen Status -

"y Screen AUX1 "y Screen Connector Resolution 3840=2160@60Hz >

oer | Mosaie Setings

# Layer AUX2

® Transition  AUX3 ® Transiton  Edge Blending

¥ Preset AUX4 ¥ Preset Screen Color

= MVR = MVR Qutput Information

# Network # Network PGM Edit

Description

Menu ltem Description

Mode Select a mode for mosaic settings

® Easy: Set the total screen width and height. The P20/P10 will
generate a mosaic solution automatically.

e Advanced: Select a mosaic layout template (the number of rows
and columns of the output connectors).

Total Width Pixel width of the screen
This parameter is displayed when the Easy mode is selected.

After you select Apply, this parameter value keeps the same as the
value in the mosaic plan.

Total Height Pixel width of the screen
This parameter is displayed when the Easy mode is selected.

After you select Apply, this parameter value keeps the same as the
value in the mosaic plan.

Mosaic Layout | Rows and columns of output connectors on the screen

This menu item is displayed only when Advanced is selected as the
mosaic mode.

Number of output connectors that can be used for mosaic:
e P20

- In PGM only mode, four output connectors can be used for
mosaic.

In switcher mode, two output connectors can be used for
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mosaic.
e P10

- 4K: In PGM only mode, two connectors can be used for
mosaic. In switcher mode, one connector can be used.

- SL:In PGM only mode, eight connectors can be used for
mosaic. In switcher mode, four connectors can be used.

Replace If an output connector used on the mosaic layout fails, you can
Connector replace the connector with another normal connector via menu
operations.
Procedure:

Select Replace Connector, select the connector to be replaced on the
right, scroll to and select another normal connector.

If the selected normal connector is in use, the normal connector and
the failed connector will be swapped.

AOI Settings Set the pixel width and height and start position of the output
connector on the mosaic screen.

This menu item is displayed only when Advanced is selected as the
mosaic mode.

When the resolution of the output connector is higher than the actual
screen resolution, AOI settings allow the output connector to meet
the mosaic requirements without changing the original resolution of
the connector.

Submenu description:

e Connector: Select the connector for AOI settings.
® Width: Set the pixel width.

® Height: Set the pixel height

® H Position: Set the horizontal start position.

® V Position: Set the vertical start position.

LCD Bezel Set the parameters related to LCD bezel compensation.
Compensation | ¢  status: Turn on (@) or off (CIM) LCD bezel compensation.
* H Spacing: Total width of bezels

® V Spacing: Total height of bezels

After the settings are completed, select Apply for the settings to take effect.

6.1.5.4 Set Edge Blending

Edge blending is a technique used when using multiple projectors to display different
regions of a single image. To display a single seamless image, adjacent projectors
need to overlap edges slightly and compensate for the double brightness created in
different regions.

Prerequisites

* The screen is a common screen and Screen Status is set to @),

« The offset angles of the projectors have been adjusted.
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Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > Edge Blending.

Figure 6-21 Edge blending (P20)

B Input | Sereenl N Input <
S Output Sereen2 S Output Screen Status -
"y Screen AUX1 "y Screen Connector Resolution 3840~2160@60Hz >

@ Layer AUXZ % Layer Mosaic Settings

® Transition  AUX3

@ Transition | Edge Blending

# Preset Sereen Color

B Preset AUX4
= MVR = MVR OQutput Information

%} Network #. Network PGM Edit

Description
Menu ltem Description
Connector Select a connector for edge blending settings.
Edge Select an edge for blending.
Feathering Turn on or off Feathering.
e @:0n
o I Off
Gamma The feathering gamma for the blending area
Width The feathering width for the blending area
The blending area is inside the projector image and facing inward.

6.1.5.5 Set Screen Color

Set the color parameters of the screen

Prerequisites

The screen is a common screen and Screen Status is set to @),

Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > Screen Color.

Figure 6-22 Screen color (P20)

B onput  [Sereentilll H input <
& Output Screen2 8 Output Screen Status L )
"y Screen AUX1 Fy Screen Connector Resolution 3840x2160@60Hz >

& Layer Mosaic Settings

# Layer AUX2
® Transition  Edge Blending

AUX3

B Preset AUX4 B Preset lor

= MVR = MVR Output Information

*1 Network #] Network PGM Edit
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Description

Menu Item Description

Brightness Brightness is the shading of lights in the image. When the
brightness increases, viewers will be dazzled. When the brightness
decreases, the image becomes dark.

Contrast Contrast is the ratio of the luminance of the brightest color to that
of the darkest color. Generally, the higher the contrast, the clearer
and more colorful the image. On the contrary, the entire image
becomes gloomy. Contrast affects the exposure level of the entire
image. It makes the bright part brighter and the dark part darker.

Saturation Saturation is the colorfulness of the image. The higher the contrast,
the more vivid the image.

Hue Hue is the relative degree of how bright or dark the image is.

Brightness Brightness is the shading of lights in the image. When the

brightness increases, viewers will be dazzled. When the
brightness decreases, the image becomes dark.

6.1.5.6 Set Output Information

Set the parameters of the output signal.

Prerequisites

» The screen is a common screen and Screen Status is set to @,

¢ HDR range conversion is available for P20 only.

Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > Output
Information.

Figure 6-23 Output information (P20)

B Input | Screen1 B Input <
& Output Screen2 & Output Screen Status )
"y Screen AUX1 Iy Screen Connector Resolution 3840x2160@60Hz >

& Layer AUX2 & Layer Mosaic Settings

® Transiion  AUX3 ® Transition  Edge Blending

B Preset Screen Color

~ WR | Quiputinfomnaton

# Network PGM Edit

# Preset AUX4

= MVR

#1 Network

Description

Menu ltem Description

Color/Sample | Set output color space and sampling rate.

Bit Depth Set output bit depth.
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Bit depth refers to the color information stored in an image. The
higher the bit depth of an image, the more colors it can store.

Dynamic Convert the dynamic range. Free conversion between SDR, HDR10 and
Range HLG is supported.
This menu item is displayed only when Dynamic Range Conversion is
turned on (@D).
Gamma Gamma value
This menu item is displayed only when Dynamic Range Conversion is
turned on (@D).
Color Gamut Set output color gamut standard.

This menu item is displayed only when Dynamic Range
Conversion is turned on (@),

Tone Mapping | Mapping mode. This menu item is displayed when Dynamic Range is
HDR10.

e @): On. Luminance overrides Peak Screen Brightness.
(®: Off. Luminance overrides Max CLL.

Luminance Peak luminance. This menu item is displayed when Dynamic Range
is HDR10 or HLG.

6.1.5.7 Set PGM Edit
Turn on or off PGM edit.

Prerequisites

e The device is in switcher mode. In PGM only mode, PGM Edit cannot be set and
turned on by default.

» The screen is a common screen or AUX screen and Screen Status is set to @0.

Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > PGM Edit.

Figure 6-24 Output information (P20)

N Input | Screenl M Input <
M Output Screen2 S Output Screen Status -
"v Screen AUX1 "y Screen Connector Resolution 3840=2160@60Hz >

# Layer AUX2 & Layer Mosaic Settings

® Transiion  AUX3 ® Transiton  Edge Blending

# Preset AUX4 # Preset Screen Color

=~ MVR = MVR Qutput Information

, Network | PGMEdit

# Network
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Menu Item Description
PGM Edit Turn on or off PGM edit.
e @:0n

The edits you make on the LCD menu modify the layers on PGM
and the edit process is displayed on the screen in real time.

o (I Off
The edits you make on the LCD menu modify the layers on PVW.

6.1.5.8 Set Display Status

Make the screen display content normally, fade to black, freeze the current frame of
the input source, or display test patterns.

Prerequisites

The screen is a common screen or AUX screen and Screen Status is set to @).

Menu Orientation

On the main menu screen, scroll to and select Screen > Screen1 > Display.

Figure 6-25 Display status (P20)

e Soreent Bopt ¢

S Output Screen2 S Output Connector Resolution 3840=2160@60Hz >

“v Screen AUX1 “y Screen Mosaic Settings

8 Layer Edge Blending

# Layer AUX2

® Transition Screen Color

® Transition AUX3

¥ Preset AUX4 # Preset formation

= MVR = MVR PGM Edit

#] Network %, Network Display Normal 4

Description
e Common Screen
Set Display to Normal, FTB, Freeze or Test Pattern.
e AUX Screen
Set Display to Normal, FTB, or Freeze.

After Test Pattern is selected for a common screen, users can set the following
parameters in the sub-menu.

Menu Item Description

Pure Color Test pattern color

Gradient Gradient style of the test pattern
Grid Grid style of the test pattern
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Brightness Test pattern brightness

Spacing Level | Spacing between different colors

This option is displayed only when the test pattern contains multiple
colors.

Spacing (px) Spacing between grid lines
This option is displayed only when the grid style is specified.

Line Width Width of grid lines
This option is displayed only when the grid style is specified.

Speed Moving speed of grid lines
This option is displayed only when the grid style is specified.

6.1.6 Layer

The Layer menu allows you to do the following:
* Set Regular Layers

» Set Basic Information

* Manage LOGO

Set AUX Layers

6.1.6.1 Set Regular Layers
6.1.6.1.1 Create and Delete Layers

Create, delete and clear regular layers. The LCD menus of P20 are used as examples
in this section for illustration.

Menu Orientation

On the main menu screen, scroll to and select Layer.

Description

Select a common screen, set Layer Type to Regular, and then do the following as
required.

¢ Create aregular layer

Select Create Layer.

B Input Select Screen Screent 4

& Output Layer Type Regular «

Ty Screen  [CreatelLaver.

&% Layer L1_Layer1

® Transition Clear All Layers
B Preset
= MVR

¥, Network

¢ Delete aregular layer
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Select the layer to be deleted to access the sub-menu and then select Delete
Layer.

M Input Select Screen Screent 4 M Input < L1_Layer1

& Output Layer Type Regular « & Output CUT & FILL
[y Screen Create Layer [ Screen DSK

& Layer Mask

% Layer er

@ Transition Clear All Layers ®) Transition Border

¥ Preset # Preset Shadow

= MVR

= MVR Flip

f Network  [EDSleteliayer

¥, Network

* Clearregular layers
Select Clear All Layers.

B Input Select Screen Screent «
& Output Layer Type Regular 4
¥ Screen Create Layer

& Layer L1_Layer1

® Transition ayers

B2 Preset
= MVR

¥, Network

Note: If PGM is displayed next to Select Screen, it denotes that PGM Edit is turned
on. If not, PGM Edit is turned off.

6.1.6.1.2 Set Basic Information

Set the basic information of regular layers.
Prerequisites

A common screen and regular layer are selected.
Note

If the layer source bandwidth is exceeded, the layer displays a black screen.
Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name.

Figure 6-26 Basic layer information (P20)

N Input Select Screen Screen 4 M Input < L1_Layerl

M Output | Input Source Input 1-HDMI 4

'y Screen Lock Aspect Ratio L

& Ouiput Layer Type Regular 4

"y Screen Create Layer

® o RS

# Layer Aspect Ratio Custom 4
® Transition Clear All Layers ® Transition Width

¥ Preset

B Preset Height

= MVR = MVR H Position

¥, Network #, Network W Position
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Description

Menu Item Description

Input Source Select an input source for the layer

Lock Aspect Ratio | Lock or unlock the aspect ratio of the layer resolution.
e @: Locked
o (®: Unlocked

Aspect Ratio Set the ratio of the layer width to the layer height.

After the aspect ratio is changed, the layer height keeps
unchanged and the layer width is calculated automatically.

Width Specify the layer width.
Height Specify the layer height.
H Position Specify the horizontal start position of the layer on the common

screen. The coordinates of the pixel at the top left of the main
screen is (0, 0).

V Position Specify the vertical start position of the layer on the common
screen. The coordinates of the pixel at the top left of the main
screen is (0, 0).

Scaling Mode Set the scaling mode of the layer.
e (Custom: The layer is scaled according to your settings.

* Pixel to Pixel: The layer resolution is the same as the input
resolution. If the input source is cropped, the layer resolution is
the same as the resolution after cropping.

® Full Screen: The layer fills the entire screen.

Z-Order Set the priority order of the layer.
® Bring Forward

® Send Backward

® Bring to Front

* Send to Back

When there are black borders or unnecessary information on the input source, input
crop allows you to crop the input source and display the desired area.

6.1.6.1.3 Set Input Crop

Prerequisites
* A common screen and regular layer are selected.

* The layer source is accessed.

Note

The input source status and capacity after cropping is the same as the original.
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Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Input Crop.

Description
Menu Item Description
Status Turn on/off input crop.
e @:0n
o (I Off
H Position Set the horizontal start position of the cropped area.
V Position Set the vertical start position of the cropped area.
Width Set the pixel width of the cropped area.
Height Set the pixel height of the cropped area.

Crop Effect Example

6.1.6.1.4 Set Layer Color

Set layer color parameters.

Prerequisites

A common screen and regular layer are selected.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Layer Color.

Description

Menu ltem Description

Brightness Brightness is the shading of lights in the image. When the brightness
increases, viewers will be dazzled. When the brightness decreases, the
image becomes dark.

Contrast Contrast is the ratio of the luminance of the brightest color to that of
the darkest color. Generally, the higher the contrast, the clearer and
more colorful the image. On the contrary, the entire image becomes
gloomy. Contrast affects the exposure level of the entire image. It
makes the bright part brighter and the dark part darker.

Saturation Saturation is the colorfulness of the image. The higher the contrast,
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the more vivid the image.

Hue Hue is the relative degree of how bright or dark the image is.

Monochrome Turn on/off monochrome.

e @) On. The layer image is in black and white.
o (I Off

Invert Colors Turn on/off color inversion.
e @D On. The colors of the layer image is inverted.

o (I Off

Opacity Set color opacity.

6.1.6.1.5 Set Cut & Fill

Set the parameters related to Cut & Fill. The original layer serves as the Fill layer, and
the output will display the Cut layer that overlaps with the Fill layer, allowing users to
define the output shape and effect more flexibly.

Prerequisites
A common screen and regular layer are selected.
Notes

¢ When the Cut & Fill function is enabled, the DSK function is disabled.

* The total resources for the Cut layer are 2x DL (1x 4K), and the Cut layer capacity
must be less than or equal to that of the Fill layer.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > CUT & FILL.

Description
Menu ltem Description
Status Turn on or turn off the function.
e @ :0On
o I Off
CUT Source The input source type of the Cut layer
Type

CUT Source The input source of the Cut layer

Negative Turn on or turn off the invert colors function.

e @D): On, allowing black areas to be transparent and white areas to
be cut

o (D Off, allowing white areas to be transparent and black areas to
be cut
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X The horizontal initial position of the Cut layer relative to the Fill layer
Y The vertical initial position of the Cut layer relative to the Fill layer
Width The horizontal pixels of the Cut layer
Height The vertical pixels of the Cut layer

6.1.6.1.6 Set DSK

Use luma key or chroma key for input sources.

Prerequisites
e A common screen and regular layer are selected.

* The layer source is accessed.

Notes

After DSK is turned on, the layer capacity changes to 4K automatically.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > DSK.

Description
Menu ltem Description
Status Turn on/off DSK.
o @:0n
o (ID: Off
Mode DSK mode

® |uma key: Suitable for application scenarios where the
brightness of the background is significantly smaller
than that of the foreground. The result of luma key is that
the background becomes transparent and the
foreground is keyed out.

e Chroma key: Suitable for application scenarios with a
single background color, such as blue/green screen

matting.
Luma Clip Distinguish between the foreground and background.
Gain Hue softness of the transition area

The greater the value, the softer the transition.

Foreground Turn on or turn off foreground color adjustment.
Color e @): On. The RGB of the related parameter can be set to
adjust the keying effect.
o (I Off
RGB RGB values of the foreground color
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Description

Chroma

Pick Hue

Set the RGB values of the pick point

* Method 1: Specify the coordinates of the pick point on
the input source, and the RGB values of the point will be
displayed.

¢ Method 2: Specify the RGB values.

After the settings, click Apply. You can also adjust the
following parameters to optimize the keying effect.

Hue Ramp

Distinguish between the foreground and background.

Hue Clip

Hue range

The greater the value, the larger the removal area. The
maximum value is the current value of Hue Ramp.

Saturation Clip

Distinguish between the foreground and background.

Saturation The hue softness of the transition area

Gain The larger the value, the softer the transition.

Spill Remove the overflow from the foreground image edges
and semi-transparent areas.

Shadow Remove the shadow areas.

Highlight Remove the highlight areas.

Edge Smooth | Turn on or turn off edge smooth.

e @ 0n
o (ID: Off

6.1.6.1.7 Set Layer Mask

Set parameters related to layer mask. The masked area will be transparent and
invisible. The layer resolution keeps unchanged.

Prerequisites

A common screen and regular layer are selected.

Note

Enabling layer mask will disable the layer border.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Mask.

Description

Menu ltem

Description

Status

Turn on/off layer mask.
e @:0n
o (I Off
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Mask Top Set the area to be masked on the top of the layer.
Mask Bottom | Set the area to be masked on the bottom of the layer.
Mask Left Set the area to be masked on the left of the layer.
Mask Right Set the area to be masked on the right of the layer.
Mask Effect Example

6.1.6.1.8 Set Layer Borders

Set the border of a layer.

Prerequisites

A common screen and regular layer are selected.

Note

Enabling layer mask will disable the layer border.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Border.

Description
Menu Item Description
Status Turn on/off layer border.
e @:0n
o (I Off
Border Set the layer border type.
Width Set the width of the left and right borders.
Height Set the height of the top and bottom borders.
Color Set the RGB of the border color.
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Border Effect Example

6.1.6.1.9 Set Border Shadow

Set the layer shadow position, size, opacity, edge blur and color.

Prerequisites

A common screen and regular layer are selected.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Shadow.

Description

Menu ltem Description

Status Turn on/off layer shadow.
e @:0n
o (I Off

X The horizontal initial position of shadow on the common screen.
The coordinates of the pixel at the top left of the common screen
is (0, 0).

Y The vertical initial position of shadow on the common screen. The
coordinates of the pixel at the top left of the common screen is (0,
0).

Width Set the shadow width.

Height Set the shadow height.

Opacity Set the shadow opacity.

Edge Blue Set the shadow edge blur.

Color Set the shadow color.

6.1.6.1.10 Set Layer Flipping

Flip layers horizontally, vertically, or horizontally and vertically.

Prerequisites

A common screen and regular layer are selected.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Flip.

www.pixelhue.com 79



All-New Event Presentation Switching Solutions

User Manual

6 Menu Operations

Description

Menu ltem Description

* None: Don't flip the layer.
* Flip Horizontally: Flip the layer horizontally.
® Flip Vertically: Flip the layer vertically.

® Flip Horizontally and Vertically: Flip the layer horizontally and
vertically

Flipping Effect Example

|
Original

6.1.6.2 Manage BKG

Apply, export, delete and import BKG files, and save captured images as BKG files.

Prerequisites

Notes

Before importing a BKG file, copy the file (.png, .bmp, .jpg, .jpeg) to the root
directory of a USB drive and insert the USB drive into the USB port on the front
panel of the P20/P10.

Before exporting a BKG file, insert a USB drive into the USB port on the front
panel of the P20/P10.

The USB port on the front panel of the P20/P10 does not support USB HUB.
The BKG does not use the layer resources.

The BKG image automatically fits to the screen and is always at the back of the
layer order.

When you are importing a BKG file using the event controller or PixelFlow, you
are not able to import BKG images using the P20/P10.

The total number of BKG and LOGO files cannot exceed 255 and the total
storage space for BKG and LOGO files is up to 512 MB.
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The maximum resolution of a single BKG file is 65536x65536 pixels.

Menu Orientation

On the main menu screen, scroll to and select Layer.

Figure 6-27 BKG (P20)

Description

B Input
& Output

Pl Screen

&% Layer

@ Transition

222

Preset
= MVR

¥, Network

Select Screen Screen1 4

mbaverlipe BKG 4

Status

BKG
Import BKG

Capture

Select a common screen, set the layer type to BKG, and then do the following as
required.

Apply BKG

a. Turn on BKG. (@)
b. Select BKG to open the BKG file screen.

c. Select a BKG file. In the dialog box that appears, select Apply to use the BKG
file as the background image of the common screen.

Export BKG

a. Turn on BKG. (@)
b. Select BKG to open the BKG file screen.
c. Select a BKG file. In the dialog box that appears, select Export.

d. Inthe dialog box that appears, select OK to export the BKG file to the root
directory of the USB drive.

Delete BKG

a. Turn on BKG. (@)
b. Select BKG to open the BKG file screen.
c. Select a BKG file. In the dialog box that appears, select Delete.

d. Inthe dialog box that appears, select OK to delete the BKG file.

Import BKG

a. Select BKG Import to open the BKG file list screen.
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b. Select a BKG file. In the dialog box that appears, select OK to import the
BKG file.

Capture

a. Select Capture to access the submenu.

b. From the drop-down options, select PGM or an input source for capture.
c. Select Capture.
d

After an image is captured successfully, select Save to save the captured
image as a BKG file.

6.1.6.3 Manage LOGO

Prerequisites

Notes

Menu Orientation

Apply, export, delete and import LOGO files.

Before importing a LOGO image, copy the LOGO file (.png, .bmp, .jpg, .jpeg) to
the root directory of a USB drive and insert the USB drive into the USB port on the
front panel of the P20/P10.

Before exporting a LOGO image, insert a USB drive into the USB port on the front
panel of the P20/P10.

The USB port on the front panel of the P20/P10 does not support USB HUB.
LOGO does not use the layer resources.

The LOGO image is always at the front of the layer order and cannot be resized.
You can change the position of the BKG image.

When you are importing a LOGO file using the event controller or PixelFlow, you
are not able to import LOGO files using the P20/P10.

The total number of BKGs and LOGOs cannot exceed 255 and the total storage
space for BKG and LOGO files is up to 512 MB.

The maximum resolution of a single LOGO file is 512x512 pixels.

On the main menu screen, scroll to and select Layer.
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Figure 6-28 LOGO (P20)

N Input Select Screen Screen1 4
& Output . LayerType LOGO 4
Fy Screen Status @
4% Layer LOGO LOGO1>
@ Transition Import LOGO
¥2 Preset H Position
&= MVR V Position
#, Network Capture

Description

e Apply LOGO
a. Turn on LOGO. (@)
b. Select LOGO to open the LOGO file screen.
c. Select a LOGO file. In the dialog box that appears, select Apply to use the
LOGO file as the LOGO of the common screen.
d. Go back to the previous menu.
e. Specify H Position and V Position to set the position of the LOGO on the
screen, that is the horizontal and vertical start position relative to the top left
(0,0) of the screen.
*  Export LOGO
a. Turn on LOGO. (@)
b. Select BKG to open the LOGO file screen.
c. Select a LOGO file. In the dialog box that appears, select Export.
d. Inthe dialog box that appears, select OK to export the LOGO file to the root

directory of the USB drive.

Delete LOGO

a. Turn on LOGO. (@)

b. Select LOGO to open the LOGO file screen.

c. Selecta LOGO file. In the dialog box that appears, select Delete.

d. Inthe dialog box that appears, select OK to delete the LOGO file.
e Import LOGO

a. Select LOGO Import to open the LOGO file screen.

b.

Select a LOGO file. In the dialog box that appears, select OK to import the
LOGO file.
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6.1.6.4 Set AUX

Layers

6.1.6.4.1 Create and Delete Layers

Create, delete and clear AUX layers. The LCD menus of P20 are used as examples in
this section for illustration.

Menu Orientation

On the main menu screen, scroll to and select Layer.

Description

Select an AUX screen, set Layer Type to AUX, and then do the following as required.

Create an AUX layer

Select Create Layer.

N Input Select Screen Screen1 4

% Output Layer Type AUX «

AUX1

Fyl Screen

% Layer

® Transition Clear All Layers
B Preset
= MVR

#, Network

Delete a AUX layer

Select the layer to be deleted to access the sub-menu and then select Delete

Layer.

B Input Select Screen Screent s

& Output Layer Type AUX 4

Create Layer

[ —

Clear All Layers

[ Screen
4% Layer
@ Transition
¥ Preset
= MVR

#, Network

Clear AUX layers
Select Clear All Layers.

BN Input Select Screen Screent «

% Output Layer Type AUX 4

Fyl Screen Create Layer

AUX1

i Layer

® Transition

B Preset
= MVR

#, Network

6.1.6.4.2 Set Basic Information

Set the basic information of AUX layers.

N Input
% Output
"y Screen

+F Layer

@ Transition

B Preset
&= MVR

#l Network

<
Width

Height

H Position

V Position

Scaling Mode Custom 4

Input Crop >

iaiaiaLaver
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Prerequisites

A common screen and AUX layer are selected.
Note

If the layer source bandwidth is exceeded, the layer displays a black screen.
Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name.

Figure 6-29 Basic layer information (P20)

N Input Select Screen Screenl M Input <

M Output Layer Type AUX

" Screen Create Layer

| S—

Clear All Layers

4 Layer

® Transition

B Preset

S Ouput  [inputSource
" Screen Lock Aspect Ratio
&% Layer Aspect Ratio

® Transition Width

¥ Preset Height

Input 1-HDMI 4
L J

Custom 4
1920 £

19202

= MVR

# Network

Description

= MvR H Position

. Network V Position

Menu Iltem

Description

Input Source

Select an input source for the layer

Lock Aspect Ratio

Lock or unlock the aspect ratio of the layer resolution.
e @) Locked
o (I®: Unlocked

Aspect Ratio

Set the ratio of the layer width to the layer height.

After the aspect ratio is changed, the layer height keeps
unchanged and the layer width is calculated automatically.

Width Specify the layer width.

Height Specify the layer height.

H Position Specify the horizontal start position of the layer on the common
screen. The coordinates of the pixel at the top left of the main
screen is (0, 0).

V Position Specify the vertical start position of the layer on the common
screen. The coordinates of the pixel at the top left of the main
screen is (0, 0).

Scaling Mode Set the scaling mode of the layer.

e (Custom: The layer is scaled according to your settings.

* Pixel to Pixel: The layer resolution is the same as the input
resolution. If the input source is cropped, the layer resolution is
the same as the resolution after cropping.

® Full Screen: The layer fills the entire screen.
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6.1.6.4.3 Set Input Crop

When there are black borders or unnecessary information on the input source, input
crop allows you to crop the input source and display the desired area.

Prerequisites
¢ A common screen and AUX layer are selected.

* The layer source is accessed.

Note

The input source status and capacity after cropping is the same as the original.

Menu Orientation

On the main menu screen, scroll to and select Layer > Layer Name > Input Crop.

Description
Menu ltem Description
Status Turn on/off input crop.
e @:0n
o (I Off
H Position Set the horizontal start position of the cropped area.
V Position Set the vertical start position of the cropped area.
Width Set the pixel width of the cropped area.
Height Set the pixel height of the cropped area.

Crop Effect Example

6.1.7 Transition

Select a mode to switch content from PVW to the PGM.
Prerequisites

The device is in switcher mode. This menu is not available in PGM only mode.
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Menu Orientation

On the main menu screen, scroll to and select Transition.

Figure 6-30 Switching (P20)

BN Input

& Output

Py Screen

£ Layer

®) Transition

5551

& MVR

#, Network

Description

Preset

Transition Effect
Duration

Selected Screens

Menu Iltem

Description

Switching
Mode

Select a mode to switch content from PVW to PGM.
* SWAP: Swap the contents on the PVW screen and PGM screen.
® COPY: Copy the content on the PVW screen to the PGM screen.

Transition
Effect

Select a transition effect.
e Cut: Switch content from PVW to PGM with no transition effect.
e Fade: Switch content from PVW to PGM with a fade effect.

Duration

Duration of the transition effect.

Selected
Screens

Screens selected for switching, including common screens and AUX
screens. Multiple screens can be selected.

6.1.8 Preset

Save the content on PVW or PGM as a preset, load and delete presets.

Note

A maximum of 128 presets can be saved.

Menu Orientation

On the main menu screen, scroll to and select Preset.
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Figure 6-31 Preset (P20)
B Input et1
& Output Preset2
Fy Screen Preset3
# Layer Preset4
@ Transition Preset5
* Preset Presett
= MVR Preset7
¥, Network 008 Preset8
Description

e Save a preset

- In switcher mode, select a blank preset and then select Save from PVW or
Save from PGM from the window that appears.

- In PGM only mode, select a blank preset and then select Save Preset from
the window that appears.

After the preset is saved successfully, the status of the preset changes to Saved.
e Load a preset

Select a saved preset and select Load from the dialog box that appears to use the
preset on the screen.

¢ Delete a preset

Select a saved preset and select Delete from the dialog box that appears to clear
the content in the preset.

6.1.9 Multiviewer (MVR)

Set the layout on the Multiviewer screen.

Note

* The resolution of the Multiviewer screen is fixed at 1920x1080@60Hz.

¢ If the input source exceeds the bandwidth limits, the Multiviewer monitor will
display a black screen.

Menu Orientation

On the main menu screen, scroll to and select MVR.
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Figure 6-32 Multiviewer (P20)

% nput  [MVRLayout Layoutis

% Output HDCP Off 4

¥ Screen Layout1 Preview

£ Layer

@ Transition

2222

Preset
 V \V/

¥, Network

Menu ltem Description
MVR Layout Select a layout for the Multiviewer screen.
e P20

- Switcher mode: 7 layout templates are provided.

- PGM only mode: 5 layout templates are provided.
s P10

- Switcher mode: 9 layout templates are provided.

- PGM only mode: 7 layout templates are provided.

After a Multiviewer layout is selected, all the accessed input sources
are displayed on the Multiviewer windows automatically.

HDCP Select an HDCP version or turn off HDCP.

6.1.10 Network

Manually specify a static IP address for the device or set the device to obtain an IP
address automatically.

Menu Orientation

On the main menu screen, scroll to and select Network.
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Figure 6-33 Network settings (P20)
B Input ess de:90:1d:d8:10:23
& Output Network Mode Manual 4
Iyl Screen IP Address 192.168.0.10 2
& Layer Subnet Mask 255.255.255.0 £
) Transition Default Gateway 192.168.0.1
Preset Reset Apply
Description
Menu ltem Description
MAC Address Display the physical address of the device.
Network Mode Select an IP address configuration method.
* Manual: Specify a static IP address for the device manually.
® Auto: The device obtains an IP address automatically.
IP Address IP address of the device
Subnet Mask Subnet mask of the device
Default Gateway Default gateway address of the current device

If you want to reset the parameters to their default values, select Reset.

6.1.11 Advanced

The Advanced menu allows you to do the following:

Set Synchronization Signal Source

Set Input Backup

Turn on/off Dynamic Range Conversion

Return to Home

Set Fn Button

Reset to Factory Settings

Run Diagnostics

Import and Export Project Files

Update Firmware

Export Logs
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6.1.11.1 Set Synchronization Signal Source

Select a synchronization signal source for the output signal.

Prerequisites

Before Genlock settings, the synchronization signal source is connected to the
Genlock connector on the rear panel of the P20/P10.

Menu Orientation

On the main menu screen, scroll to and select Advanced > Synchronization.

Figure 6-34 Synchronization signal source (P20)

4 Ouput [ Synchronization

Wy Screen Input Backup

" Dynamic Range Conversion

&% Layer
Return to Home

@ Transition Fn

22

Preset Factory Reset

= MVR Diagnostics
Project File
Update

#, Network

{} Advanced Log Export

Description
Menu ltem Description
Status Turn on/off synchronization.
o @:0n
o (I Off
Source Select a synchronization source.

® Genlock: Sync to the frame frequency of the Genlock input signal.

* Input X: Sync to the frame frequency of the selected input source.
X stands for the input source number.

6.1.11.2 Set Input Backup

Set input source backup relationships. When the primary source fails, the backup
source takes over automatically without downtime.

Note

¢ The capacity of the primary and backup input connectors must be the same.
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« After input backup settings, the capacity and type of the related connectors
cannot be changed.

Menu Orientation

On the main menu screen, scroll to and select Advanced > Input Backup.
Figure 6-35 Input backup (P20)

& Output Synchronization

Fy| Screen - Input Backup

" Dynamic Range Conversion
&F Layer

Return to Home
@ Transition Fn

2

Preset Factory Reset

= MVR Diagnostics
Project File
Update

{"} Advanced Log Export

#, Network

Description

Menu ltem Description

Status Turn on/off input source backup.

e @) On. When the current source has no signal, the backup source
takes over automatically.

o (I Off
Primary Turn on/off primary source preferred.
Preferred o @D On. The primary source is preferred.
o (I Off

From the drop-down options on the left and right, select primary and backup sources
to establish input backup relationships.

If you want to reset Primary Preferred status and all backup relationships to the
defaults, select Reset.

6.1.11.3 Turn on/off Dynamic Range Conversion

Turn on or off the dynamic range conversion feature.

Prerequisites

The device is P20.
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Menu Orientation

On the main menu screen, scroll to and select Advanced > Dynamic Range
Conversion.

Figure 6-36 Dynamic range conversion (P20)

% Output Synchronization
Wy Screen Input Backup

" luBynamic Range Conversion
&* Layer

Return to Home
@ Transition Fn

22

Preset Factory Reset

= MVR Diagnostics
Project File
Update

"} Advanced Log Export

#, Network

Description
Dynamic Turn on/off dynamic range conversion
Range This function enables free conversion between SDR, HDR10 and HLG.
Conversion
o @:0n
o (I Off

6.1.11.4 Return to Home

Set the period during which the system stays at the current screen before returning to
the home screen automatically when no operation is performed.

Note

If a dialog box is displayed, the system will not return to the home screen
automatically after the specified period of time.

Menu Orientation

On the main menu screen, scroll to and select Advanced > Return to Home.
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Figure 6-37 Return to Home (P20)
& Output Synchronization
Py Screen Input Backup
. Dynamic Range Conversion
&% Layer
m I Home
@ Transition =
¥ Preset Factory Reset
= MVR Diagnostics
) Project File
» Network Update
3 Advanced Log Export
Description

Scroll to Return to Home and press the knob to make the parameter value editable.
Rotate the knob to adjust the parameter to the desired value and press the knob to
apply the parameter.

6.1.11.5 Set Fn Button

Assign a function to the FN shortcut button on the front panel of the P20/P10 so that
users can quickly access the assigned function. Functions that can be assigned to
the FN button include turning on/off Genlock synchronization, freeze and FTB.

Menu Orientation

On the main menu screen, scroll to and select Advanced > Fn.

Figure 6-38 FN button settings (P20)

& Output Synchronization

Wy Screen Input Backup

. Dynamic Range Conversion
&F Layer
Return to Home

@ Transition -

B2 Preset Factory Reset

= MVR Diagnostics
Project File
Update

'y Advanced Log Export

#, Network
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Description

Select Fn to access the submenu. Select Synchronization, Freeze or FTB to assign
the selected function to the FN button.

6.1.11.6 Reset to Factory Settings
Reset the P20/P10 parameter settings to the factory defaults.

Note

¢ This action does not change the firmware version of the device.
* Do not disconnect the power supply during the process.

* After factory reset, the device restarts automatically.
Menu Orientation

On the main menu screen, scroll to and select Advanced > Factory Reset.

Figure 6-39 Factory reset (P20)

& Output Synchronization

7y Screen Input Backup

. Dynamic Range Conversion
&% Layer

Return to Home
@ Transition Fn

¥ Preset - Factory Reset
= MVR Diagnostics
Project File

£, Network Update

{3 Advanced Log Export

Description

¢ Keep User Data

Reset all the parameters to their default values except the network parameters,
project files, EDID files, gallery files, and display language.

a. Select Factory Reset to access the submenu.
b. Select Keep User Data.
c. Select OK in the dialog box that appears.

¢ Reset All

Reset all the parameters to default values, except network parameters and project
files.

a. Select Factory Reset to access the submenu.
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b. Select Reset All.
c. Select OK in the dialog box that appears.

6.1.11.7 Run Diagnostics
Run diagnostics for the P20/P10 to identify and troubleshoot problems.

Menu Orientation

On the main menu screen, scroll to and select Advanced > Diagnostics.

Figure 6-40 Diagnostics (P20)

& Output Synchronization

Py Screen Input Backup

" Dynamic Range Conversion
&F Layer

Return to Home
@ Transition En

w2

Preset Factory Reset

= MVR mliaggostics
Project File
Update

"} Advanced Log Export

#, Network

Description

Select Diagnostics to access the submenu and select Run. After the diagnostics,
view the result.

6.1.11.8 Import and Export Project Files

Import project files from a USB drive to the P20/P10 and export project files from the
P20/P10 to a USB drive. A project file contains configuration files and data.

Prerequisites

» Before importing a project file, copy the file (.uprj) to the root directory of a USB
drive and insert the USB drive into the USB port on the front panel of the P20/P10.

« Before exporting a project file, insert a USB drive into the USB port on the front
panel of the P20/P10.

Notes
The USB port on the front panel of the P20/P10 does not support USB HUB.
Menu Orientation

On the main menu screen, scroll to and select Advanced > Project File.
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Figure 6-41 Project file (P20)

& Output Synchronization

P9 Screen Input Backup

" Dynamic Range Conversion
& Layer

Return to Home
@ Transition =

n

w2

Preset Factory Reset

= MVR Diagnostics

. Project File
Update

() Advanced  Log Export

#, Network

Description

e Import a project file
a. Select Project File to access the submenu.
a. Select Import Project File to open the project file screen.
b. Select a project file.

c. Inthe dialog box that appears, select OK to import the project file in the root
directory of the USB drive.

¢ Export a project file
a. Select Project File to access the submenu.
b. Select Export Project File.

c. Inthe dialog box that appears, select OK to export the project file to the root
directory of the USB drive.

6.1.11.9 Update Firmware
Update the firmware of the P20/P10.

Prerequisites

Before firmware update, copy the update file (.img) in the root directory of a USB
drive and insert the USB drive into the USB port on the front panel of the P20/P10.

Notes

* The USB port on the front panel of the P20/P10 does not support USB HUB.

* After firmware update, the device restarts automatically.
Menu Orientation

On the main menu screen, scroll to and select Advanced > Update.
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Figure 6-42 Firmware update (P20)

& Output Synchronization

B Screen Input Backup

" Dynamic Range Conversion
&F Layer

Return to Home
@ Transition Fn

222

Preset Factory Reset

= MVR Diagnostics
Project File

[ —

3 Advanced Log Export

#, Network

Description

Select Update to open the update file screen. Select a file and select OK in the dialog
box that appears.

6.1.11.10 Export Logs
Export logs from the P20/P10 to a USB drive.

Prerequisites

A USB drive is inserted into the USB port on the front panel of the P20/P10.
Notes

The USB port on the front panel of the P20/P10 does not support USB HUB.
Menu Orientation

On the main menu screen, scroll to and select Advanced > Log Export.
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Figure 6-43 Exporting logs (P20)

& Output Synchronization

W9 Screen Input Backup

" Dynamic Range Conversion
& Layer

Return to Home
@ Transition =

n

w2

Preset Factory Reset

= MVR Diagnostics
Project File
Update

© Advanced |
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Description

Select Log Export to access the submenu. Select Apply to export the log files to the
root directory of the USB.

6.1.12 Mode

Set the working mode of the device to switcher or PGM only.
Menu Orientation

On the main menu screen, scroll to and select Mode.

Figure 6-44 Working mode (P20)
¢ Screen

& Layer

@ Transition

#2 Preset

= MVR

¥, Network

{3 Advanced

¥ Mode
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Description

Select Switcher or PGM Only. After a working mode is selected, v appears on the
bottom right, as shown in Figure 6-44.

6.1.13 About Us

View the P20/P10 firmware version, the email address and official website of
PIXELHUE.

Menu Orientation

On the main menu screen, scroll to and select About Us.

Figure 6-45 About us (P20)

#* Layer

®) Transition PIXELHUE

V1.3.0

22>

Preset
= MVR

#, Network w4 service@pixelhue.com

7 Advanced € www.pixelhue.com

® Mode

B About Us

6.1.14 Language

Set the display language of the menu. English and Simplified Chinese are available.
Menu Orientation

On the main menu screen, scroll to and select Language.
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Figure 6-46 Language (P20)

@ Transition

223

Preset

= MVR

#, Network ' | ”Egl - ' m

%y Advanced (5] 257

® Mode
B About Us

® |anguage

Description

Select f&j#&H3C or English. After a language is selected, v appears on the bottom
right, as shown in Figure 6-46.

6.2 Q8 Menu Operations
6.2.1 Startup and Shutdown

Connect all the necessary cables and at least two power cords properly, and press
the power button on the front panel to power on the Q8.

To turn off the Q8, press the power button on the front panel and select OK from the
dialog box displayed on the LCD screen.

6.2.2 Home Screen

After the startup, the home screen is displayed.
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Figure 6-47 Home screen
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Table 6-2 Home screen description

No. | Content Description

>
N

1 Information N .
e N&®: Device manufacturer logo.

bar
* Q8: Device model.

¢ SHEBEIMINGCHENG: Device name, which can be modified on
the control computer.

* 192.168.0.10: Device IP address, which can be modified on
the device LCD or the control computer.

O Turn off LCD display.

2 Input card Show the input card and its connector status.

information | ¢ Green: The connector is accessed with a source and the
source is normal.

* White: The connector is not accessed with source.
* Gray: The connector is unavailable.
® Orange: The connector’'s accessed source is abnormal.

3 Output card Show the output card and its connector status.
information | ¢ Green connector: The connector is connected to the backend
device.

e White connector: The connector is not connected to the
backend device.

¢ Gray connector: The connector is unavailable.

4 Power Show the power supply connection status.

connector e Green: The connector is connected with a power supply and
the power is supplied.

* White: The connector is not connected with a power supply
and the power is not supplied.
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5 Control card | Show the control card connector status.
connector * Green: The connector is connected and works normally.

* White connector: The connector is not connected or works

abnormally.
6 Voltage Show the device working voltage status.
status ¢ Normal: The voltage of each module in the device is normal.
e Abnormal: The voltage of one or some modules in the device
is abnormal, and the device needs troubleshooting.
7 Temperature | Show the device working temperature status.
status e Normal: The temperature of each module in the device is
normal.

® Abnormal: The temperature of one or some modules in the
device is too high, and the device needs troubleshooting.

8 Fan status Indicate whether the fan speed is normal when the device is
working.

¢ Normal: The speed of each fan in the device is normal.

e Abnormal: The speed of one or some fans in the device is
abnormal, and the device needs troubleshooting.

9 Settings Click to enter the device menu where you can perform the
following device operations.

* Network settings: Configure the device IP address.

® Device information: Check the device's chassis and card
version, and fan status.

* Advanced settings: Perform factory reset settings, firmware
update, project file import and export, log export, and AC back
settings for the device.

¢ About us: Check the official website and technical support
email address of the device manufacturer.

6.2.3 Network Settings

Step 1 On the home screen, tap —% located at the bottom right corner to enter the settings

screen.

Step 2 Select Network to enter the network settings screen.

Step 3 Configure the device IP address information.
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Figure 6-48 IP address settings
< Back e 192.168.100.100

%%
9 Network

Network Mode: (®) Manual () DHCP

E.g Device
{:} Advanced

IP Address: |192.168.100.100

Subnet Mask:
Q Language
Gateway:
About Us
MAC Address: OE:9E:AE:B4:HB:AR

The device supports both automatic (DHCP) and manual IP configuration. When the
device is connected via router or switch, DHCP is recommended. The router or switch
will automatically assign IP address to the device. When the network mode is set to
Manual, you need to set IP Address, Subnet Mask and Gateway.

E Note

When manually configuring the IP address, the device IP address and the control
computer IP address must be on the same network segment.

Step 4 Tap Apply to complete the settings.

6.2.4 Device Information

On the Device screen, you can check the power supply status, card temperature and
fan running status of the device.
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Figure 6-49 Device information

He 192.168.100.100

Voltage Cards

Card No. Temp MB Version Card Version

IN1 V1.0.0.0.S3.T3 V1.0.0.0.S3.T3

Language IN2 V1.0.0.0.S3T3 V1.0.0.0.S3.T3

IN3 V1.0.0.0.S3T3 V1.0.0.0.S3.T3

38 About Us
IN4 V1.0.0.0.S3.T3 V1.0.0.0.S3.T3

\) V1.0.0.0.S3.T3 V1.0.0.0.S3.T3

IN6 V1.0.0.0.S3T3 V1.0.0.0.S3.T3

Two ways to enter the Device screen:

« Onthe home screen, tap —% located at the bottom right corner to enter the
settings screen. Then, tap Device on the left.

¢ On the home screen, tap the icon in the status bar on the right to enter the
corresponding screen under Device.

- @: Displays the voltage status of the connected power supply. Tap this icon
to enter the Voltage screen under Device, where you can check the
connection status of the three power supplies and whether the power
connector voltage is normal.

- @: Displays the device card temperature. Tap this icon to enter the Card
screen under Device, where you can check the card temperature and version.

- @: Displays whether the device fans are running normally. Tap this icon to
enter the Fans screen under Device, where you can check the status of all the
device fans.

6.2.5 Advanced Settings

In advanced settings, you can do the following operations:

* Factory reset

¢ Update firmware

¢ Import and export project files
e Export log files

¢ Set the device status after AC power back

On the home screen, tap =% located at the bottom right corner to enter the settings
screen. Then, tap Advanced to enter the advanced settings screen.
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Figure 6-50 Advanced settings

< Back f@ 192.168.100.100

%
Network Factory Reset Update Projects

! Device

Advanced

Q Language % O

Keep User Data Reset All

About Us

User data includes EDID files, gallery, device name and language settings

Factory Reset

This function is used to quickly clear the data saved in the device. All parameters will
be restored to the default values.

« Keep User Data: During factory reset, the network configuration, EDID files, gallery,
device name and language settings will be kept, while other parameters will be
restored to the default values.

¢ Reset All: All device parameters will be restored to the default values.
Update Firmware

The Q8 supports firmware update via USB drive. To do that, save the update file in the
root directory of the USB drive and then insert the drive into the USB port on the
control card of the Q8.

On the Advanced screen, tap Update to enter the firmware update screen and the
system will automatically detect and read the update file in the USB drive.
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Figure 6-51 Firmware update

< Back He 192.168.100.100

Network Factory Reset Update Projects

& Device
(® USB-1/Q8V1.0.CO.Tl.img

A
dvanced O USB-1/Q8V1.0.C0T2.img

® Language () USB-1/Q8V1.0.C0T2.img

About Us

Select the target update file, tap Update, and the system will automatically update the
device.

After the update is complete, the device will automatically restart.

Import and Export Project Files

The Q8 supports import and export of configured project information via USB drive,
allowing you to quickly complete device configuration.

* To export project files, insert the USB drive that is used to save the files into the
USB port on the control card of the Q8.

* To import project files, save the files in the root directory of the USB drive and then
insert the drive into the USB port on the control card of the Q8.

On the Advanced screen, tap Projects to enter the project file import and export
screen.
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Figure 6-52 Importing and exporting project file
< Back e 192.168.100.100

%
» Network Factory Reset Update Projects AC Back

E‘f Device

{:} Advanced

Q Language

Import File Export File

About Us

¢ Importing project file: Tap Import File, and the system will automatically read the
project files in the USB drive. After selecting the target file, tap OK, and the system
will automatically import the file to the device. After the import is complete, the
device will automatically restart.

* Exporting project file: Tap Export File, and the system will automatically export the
current configured project file to the selected USB drive.

Export Logs

The Q8 supports export of the device running logs via USB drive. When the device
has an exception, the logs can help you quickly troubleshoot the problem.

To export logs, insert the USB drive that is used to save the logs into the USB port on
the control card of the Q8.

On the Advanced screen, tap Logs to enter the log export screen.
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Figure 6-53 Exporting logs

< Back Te 192.168.100.100

%
, Network Factory Reset Update Projects

! Device

Advanced

Q Language LJ’
Log Export
About Us

Tap Log Export to export the device logs to the selected USB drive.

Set Device Status After AC Back

Set whether the device automatically powers on after the power is supplied.
Figure 6-54 AC back
< Back e 192.168.100.100

Network Factory Reset Update Projects

Power On Power Off Last State

* Power On: After the power is supplied, the device automatically powers on.

« Power Off: After the power is supplied, the device remains in the power-off state.
To power on the device, press the power button on the device front panel.

e Last State: After the power is supplied, the device remains in the last state.
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6.2.6 Language

The Q8 supports both Chinese and English Ul languages. You can change the
language on the Language screen.

6.2.7 About Us

On the About Us screen, you can check the device system version and the device
manufacturer related information.
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User Manual
Event Management Software PixelFlow
About This Chapter
This chapter provides a detailed description of each section of the event
management software PixelFlow, as well as a step-by-step approach to configure the
projects, devices, screens, layers, Multiviewer, presets and more.
Overview

» Software Installation and Connection
* Project Management

* Device Management

¢ Screen Configuration

* Layer Operation

* Multiviewer (MVR)

* Preset Management

* Screen Maintenance

¢ Software Settings
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7.1 Software Installation and Connection

7.1.1 Software Installation

Prerequisites

¢ The software package is obtained.
¢ A computer meeting the following requirements is prepared:

- Operating system: Windows 10 (64-bit) or later
- CPU: Intel® Core™ i5 or later
- RAM: 8 GB or greater

Installation Method

Run the .exe file and follow the setup wizard to complete the installation. If a firewall
prompt appears, choose to allow the installation.

Installation Result

After a successful installation, the PixelFlow software icon ﬂ is displayed on the
desktop. Double-click this icon to open the PixelFlow software.

7.1.2 Software Connection

The PixelFlow software is installed on the control computer. The control computer
can connect to the device in the following two ways:

¢ Via Ethernet cable

Connect the device and the control PC directly via Ethernet cable and set a static
IP address for the device to let it and the control PC be on the same network
segment.

e Via LAN

Connect the device and the control PC to the same LAN via a router and set the
device to automatically obtain an IP address.

E Notes
e The device in this chapter refers to the P20, P10 or Q8 seamless switcher.

e The software pictures given in this chapter are used for illustration purposes
only. The actual user interface may vary slightly due to product enhancement.
The content of the pictures can be slightly different from reality, such as the
form and position of the software windows, input source images and more.
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7.2 Project Management

Create, edit and delete projects, and view project details. The project file (.uprj) can
be exported by a device, and then imported into other devices of the same model, so
as to quickly apply the device parameters and resource files in the project file.

7.2.1 Create New Projects

Create a new project and add one or more devices.

* Before creating an online project, there must be online devices available.

* For creating a virtual project, virtual devices are not required initially, but it is
possible to create virtual devices during the process of creating a virtual project.
Virtual devices do not have any physical connections, but simulate the
configuration scenarios of real devices, providing convenience for users to use
and understand the software.

Step 1 Select Projects on the left side of the interface to show the project list.

Figure 7-1 Project list

Projects

Online Projects |  Virtual Projects

Project Name +  Last Modified

Mo online projects found

Step 2 If creating a project for an online device, click New Project on the Online Projects tab
interface.

If creating a project for a virtual device, select the Virtual Projects tab and click the
New Project.
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Figure 7-2 Create new online projects

New Project
Project Name | Projects 3

Project Type Online Projects Virtual Projects

Device List (18 items) o Selected Devices (0 items)

System1
10.40.80.20

System1
10.40.80.80

System1
10.40.80.84
System1
10.40.80.101

System1
10.40.80.147

System1 SN

10.40.80.165 a

No data
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Figure 7-3 Create new virtual projects
New Project
Project Name | Projects 1
Project Type (| Online Projects Virtual Projects

Device List (0 items) o Selected Devices (O items)

SN

ol

No data

Step 3 Name the project.
Step 4 Select the devices that you want to include in this project, and click Add.

For a virtual project, you can click Create a new virtual device. In the dialog box that
appears, set the name, model, and IP address for the virtual device, then click OK to
add it to the selected devices list.

E Note

A device can be added to one project only.
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Step 5

Figure 7-4 Add virtual devices

New Virtual Device

Device Model | Q8
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Related operations are as follows:

* Remove: Withdraw the selected devices in Selected Device List to Device List.
¢ Add All: Add all the devices in Device List to Selected Device List.

* Remove All: Withdraw all the devices in Selected Device List to Device List.
After the settings, click OK.

After a project is successfully created, you will enter the device configuration
interface.

E Note

In the project list area, you can perform the following project-related operations:

e Rename project: Hover the mouse over the desired project and click that
appears on the right side of the project name.

e Enter project: Click Enter in the Action column.

e  Edit project: Click Edit in the Action column.

e Delete project: Click Delete in the Action column.

e View project details: Click Details in the Action column.

7.2.2 Import Projects

Step 1

Import the local project files to the device. Please note that the device model must
match with that in the project file.

Select Projects on the left side of the interface to show the project list.

Step 2 Click Import Project or go to Projects > Import from the menu bar.
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The Import Project button on both the Online Projects and Virtual Projects tab
interfaces serves the same purpose and has the same functionality.

Step 3 In the dialog box that appears, select a project file (.uprj) and click OK.

Step 4 In the displayed Import Project File box, select Online Projects or Virtual Projects.

Figure 7-5 Import project files
Import Project File

Online Projects Virtual Projects

Matching List

Device in File Online Device Matching Result Parameters

System1 Devicel Resource Files
127,001 192.168.50.10 Device Parameters

Step 5 After successful device matching, select the data you want to import and click OK.

7.2.3 Export Projects

Export the device project files to your local computer.
Step 1 Select Projects on the left side of the interface to show the project list.

Step 2 Select the Online Projects or Virtual Projects tab, double-click the project name or
click Enter in the Action column to enter the device configuration interface.

Step 3 From the menu bar, select Projects > Export.

Step 4 In the displayed dialog box, select the desired data.

Figure 7-6 Export project files
Export Project File
OSD, internal source, 3D
v System 1

Device Paramelers

Resource Files

Step 5 Click Export.
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Step 6 In the displayed dialog box, select a file path and click Save.

/.3 Device Management

7.3.1 Enter Device Configuration Page

7.3.1.2 Online Devices

Step 1 Select Device on the left side of the interface to show the device list.

Figure 7-7 Online device list

Device List &

System1
10.40.80.84 | P20

Step 2 On the Online Devices tab page, if the device is not logged in, click on Login. In the
dialog box that appears, simply click Login (keeping the default values for username
and password). If the device is already logged in, skip this step.

Figure 7-8 Device login

Step 3 Click B to refresh the device list.
Step 4 (Optional) Switch the display style of the device list as desired.
« E3: Graphical view

- View the device name, IP address and model.
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- Double clicking the device front panel image allows you to access the device
configuration interface.

System1 System1
10.40.80.186 | Q8 10.40.80.225 | P20

« B List view

- View the device name, IP address, model, and the project the device belongs
to.

- Inthe Action column, you can access the device configuration interface.

- Place the mouse over the device information and click that appears on
the right side of the device name to change the device name.

Device Name + IP Address
System1 10.40.80.84

System1 10.40.81.52

System1 10.40.81.101

Step 5 Perform either of the following actions to enter the device configuration page.

« In the graphic view mode (El), double click the image of the device front panel.

« Inthe list view mode (&), click Enter in the Action column.

7.3.1.3 Virtual Devices

Step 1 Select Device from the left side of the interface to enter the device list interface.

Step 2 Select the Virtual Devices tab.

Figure 7-9 Virtual device list

Device List &

Projects

Device1
192.16850.10 | Q8

Step 3 Click E&.
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Step 4 In the pop-up dialog, set the device name, model, and IP address, and click OK.

Once created, the device will be displayed in the list and will be in the default started
state.

. .: The device is started.
. .: The device is off.

E Note

For devices in the list, you can perform the following batch operations:
e Start all devices: Click Start All.
e  Shut down all devices: Click Shut Down All.

e Delete specific devices: Click Edit, select the devices you want to delete, and
click Delete.

e Delete all devices: Click Edit, select Select All, and click Delete.

Figure 7-10 Add virtual devices
New Virtual Device

Name | Devicel
Device Model | Q8

IP Address 192

Card Slots
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Step 5 (Optional) Switch the list display style according to your preferences.
« [E3: Graphic style
- View device status, name, IP address, and model.

- Double click the device front panel image to access the device configuration
interface.

- Place the mouse over the device to start or shut down, configure (change
device name, IP address), or delete the device.
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) Devicel ) Device2 Device3 Deviced
192.168.50.10 | Q8 192.168.50.11 | Q8 192.168.50.12 | Q8

192.168.50.13 | Q8

« E: List style.

- View device status, name, IP address, model, and the project to which the
device belongs.

- Inthe Action column, you can access, start or shut down, configure (change
device name, IP address), and delete the device.

- Place the mouse over the device and click that appears on the right side
of the device name to change the device name.

Device Name < IP Address

192.168.50.10

192.168.50.11

Step 6 Perform either of the following actions to enter the device configuration page.

* In the graphic view mode (), double click the image of the device front panel.

¢ Inthe list view mode (E), click Enter in the Action column.
7.3.2 Configure Device Properties

Select the device on the left side of the device configuration interface, and then
configure the device-related properties on the right pane.

Figure 7-11 Device properties (P20)

opT AUDIO

[0 o O e e A« SO Gl
0: 00O 0:0

OUTPUT 1/PGM-1 OUTPUT2/PGM-2 ‘OUTPUT3/PGM-3 OUTPUT4/PGM-4

= — R — R —— R — R —
v Synchronization

> Systom1

7.3.2.1 Rename Device
Change the device name.
Prerequisites

None
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Notes

None

Interface Example (P20)

Device Name System1

Firmware Version V1.1.0.T2

Device SN 202328945008

MAC Address AA:BB:6F:00:00:23

Description

Enter a name for the device in the text box next to Device Name.

E Note

In the device list on the left side of the interface, you can also right click the device
name and select Rename from the context menu to change the device name as well.

7.3.2.2 Configure IP Address

Manually set a static IP address for the device or let the device to automatically
obtain an IP address.

Prerequisites

None
Notes

None

Interface Example (P20)

v Network Settings

Network Mode
|IP Address
Subnet Mask

Gateway

Description

Configure the following parameters and click Apply to make the settings take effect.

Parameter Description

Network Mode Select the IP configuration method.

* Manual: Manually set a static IP address for the device.
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Parameter Description
e DHCP: The device automatically obtains an IP address.

IP Address The device IP address
Subnet Mask The subnet mask of the IP address
Gateway The default gateway

7.3.2.3 Configure Sync Source

Enable the sync function and configure the sync source for the output.

Prerequisites

* Before enabling the Genlock sync function, make sure the sync signal has been
connected to the Genlock connector of the device.

* The device model is Q8 and the screen has already been created.

Notes

None

Interface Example (P20)

v Synchronization

v System

Sync To*

Description

Parameter Description

Sync To Turn off the sync function; or turn on the function and then
select the sync source to be used.

e Off: Disable the sync function.

® Genlock: Sync with the frame rate of the accessed Genlock
signal.

* Input-X: Sync with the frame rate of the selected input
source.

X indicates the serial number of the input source and the
actual format shall prevail.

When the function is enabled, the frame rate of the sync
source will be displayed.

7.3.2.4 Configure Output Mapping

Turn on or turn off the output mapping function. If turned on, each output displays its
slot number in the loading area of the screen.

www.pixelhue.com 123



All-New Event Presentation Switching Solutions

User Manual

7 Event Management Software PixelFlow

Prerequisites

The device model is Q8.

Notes

None

Interface Example (Q8)

Mapping [ ]

Description

Parameter

Description

Mapping

Turn on or turn off the function.
e ©):0n
o (O off

E Note

In the device list on the left side of the interface, you can also right click the device
name and select Mapping from the context menu to enable or disable the mapping

function as well.

7.3.2.5 Configure HDR Format Conversion

Turn on or turn off the HDR format conversion function. If turned on, you can set the
HDR-related parameters for the input and output.

Prerequisites

The device model is the P20.

Notes

None

Interface Example (P20)

HDR Format Conversion [ ]

Description

Parameter

Description

HDR Format
Conversion

Turn on or turn off the function.
e @) 0n
o (O off
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7.3.2.6 Switch Working Mode

When the device supports dual working modes (Switcher and PGM Only), you can
switch to either mode that satisfies your actual needs.

Prerequisites

The device model is the P20 and P10.

Notes

None

Interface Example (P20)

Working Mode

Description

Select Switcher or PGM Only from the drop-down list.

7.3.2.7 Configure Date and Time

Configure the time zone, date and time of the device.
Prerequisites

None
Notes

None

Interface Example (P20)

v Time
Time Zone (UTC+08:00) Asia/Shanghai

Date 2023-06-29

Time 13417

(" Edt )

Description

Click Edit and the time parameters become editable. Set the time zone, date and time
respectively, and then click Apply.

www.pixelhue.com 125



All-New Event Presentation Switching Solutions

User Manual

7 Event Management Software PixelFlow

7.3.2.8 Configure Input Source Backup

Prerequisites

Notes

Configure the backup relation between two sources. For two input sources with a hot
backup relationship, when the primary source has no signal, it will automatically
switch to the backup source.

None

* The function is applicable when the capacities of the input connectors are the
same.

¢ After the function is enabled, the switching of the connector capacity and
connector type are not supported.

Interface Example (P20)

Description

Step 1
Step 2
Step 3
Step 4

v Input Source Backup [ ]

Primary Source Preferred ©

+ Add i3 Delete All

Primary Source Backup Source

Set the Input Source Backup switch to #0.
Select or deselect Primary Source Preferred.
Click Add.

Select a primary source and a backup source respectively from two drop-down lists
to establish a hot backup pair.

The green color indicates the source is accessed normally and ready for use.

To delete a hot backup pair, click next to the pair. To delete all hot backup pairs,
click Delete All.

7.3.2.9 Configure Device Backup

Prerequisites

Enable the device backup function for the screen.

For screens with the device backup function turned on, when a layer's input source
has no signal or does not exist, all output connectors of the screen will immediately
stop outputting any signal, and switch to the backup link together with the sending
cards and receiving cards.

None
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Notes

The Multiviewer signal is not affected by device backup function.

Interface Example (P20)

v Device Backup ©

All

Description
Parameter Description
Device Backup Turn on or turn off the function.
e @:0n

- All: Select all screens.
- Specific screen name: Select the desired screen.

o OB off

7.3.2.10 Reset to Factory Settings

Reset the device data and settings to factory default values.
Prerequisites

None

Notes

* Please do this with great caution.
* The reset action does not affect the device firmware version.
« Power-off is not allowed during the reset process.

* The device will restart automatically after the reset is completed.

Interface Example (P20)

v Factory Reset

Keep user data

Reset all

Description

Select Keep user data or Reset all, and then click Apply.

¢ Keep user data

www.pixelhue.com 127



All-New Event Presentation Switching Solutions
User Manual 7 Event Management Software PixelFlow

Retain the network parameters, project files, EDID files, gallery files and device
language settings.

¢ Reset all

Retain the network parameters and project files.
7.3.2.11 Shut Down or Restart Device
Shut down the device, or restart the device.
Prerequisites
None
Notes
None

Interface Example (P20)

Restart Shut Down

Description
Click Restart or Shut Down, and then click Yes in the displayed dialog box.
7.3.3 Configure Input Properties

Click the target input connector on the graphical device rear panel (if you need to
configure the card properties, please click the desired card on the rear panel), and
then set the input-related properties in the property area on the right pane.

Figure 7-12 Input properties (P20)

INPUT 12 oPT AuDIO

o' O

00 00 00 o OO0 Sy

INFUT 8 OUTPUT 1/PGM-1 OUTPUT 2/PGM2 OUTPUT 3/PGM-3 OUTPUT 4/PGM4
= = [
INPUT 4 MVR AUX

S —————— e W K-
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7.3.3.1 Configure Card Properties

Set the input connectors to be used, connector capacity (resource occupation) and
deinterlacing function.

Prerequisites

* The connector capacity is available on the P20 and P10.

* The deinterlacing function is available on the Q8.
Notes

If the connector is set to be NOT used:

* The corresponding layers on the main screens and AUX screens will become
empty layers.

¢ Some connector properties will be restored to defaults, such as resolution and
color parameters.

If the connector capacity is switched on the P20 and P10:

* The corresponding layers on the screens will become empty layers, and the DSK
function will be turned off.

¢ Some connector properties will be restored to defaults, such as resolution and
color parameters.

Interface Example (Q8)

Input Card Properties

v Select Connector Sl
Input 3-1 Input3-2 (G| |Input33 ()| Input3-4

Deinterlace Deinterlace

HDMI HDMI HDMI HDMI

Input3-5 ()| |Input3-6 ()| |Input3-7 ()| Input 3-8

Deinterlace Deinterlace Deinterlace
DP DP DP DP
Input 39 (37 || Input 3-10 ()| Input 3-11 Input 3-12
Deinterlace Deinterlace
SDI SDI

Description

¢ Switch the connector capacity.
Select SL or 4K from the drop-down list.
» Select the connectors to be used.
The connector status descriptions are as follows:
- @: selected
~ @: Not selected
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* Set the deinterlacing function.

Click the Deinterlace icon.
Deinterlace . 0On

R, o

After the settings, click Apply.

7.3.3.2 View Input Source Info

View the basic properties of the input connector and change the input connector
name.

Prerequisites

A fine signal is connected to the input connector.

Notes

None

Interface Example (P20)

v Source Information

Connector Name Input 2-HDMI 2.0

Type HDMI 2.0
Slot No. Input 2
Resolution @ 1920x1080 px
Frame Rate 59.94 Hz
Bit Depth 8bit

Color/Sample RGB 4:4:4
Color Gamut Rec.709

Quantization Range FULL
Dynamic Range SDR
Metadata 2
Connector Gapacity 4K
HDCP

Description

On the Basic tab interface, change the connector name as required.

7.3.3.3 Configure Override Parameters

Configure the InfoFrame override parameters of the input source, so that the device
can use it when doing some calculations. This action does not change the parameter
values that come with the input source.

Prerequisites

The HDR-related parameter settings are applicable to the HDMI 2.0 connectors on

the P20, and make sure you have turned on the HDR format conversion function in

the device property configuration page before the settings. For specific operations,
please refer to 7.3.2.5 Configure HDR Format Conversion.
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Notes

None

Interface Example (P20)

Vv InfoFrame Override

Color/Sample Follow Input
Bit Depth Follow Input
Quantization Range | Follow Input

Dynamic Range Follow Input

Color Gamut Follow Input

Description

On the Basic tab interface, configure the following parameters.

Type Parameter Description
General Color/Sample The sampling format of the input
parameters ) - ] ] ) —
Bit Depth The bit depth of the input, i.e., the binary digits to
represent a single color
Quantization The quantization range of the input
Range

HDR parameters | Dynamic Range | The HDR format of the input

Color Gamut The color gamut standard of the input

Select Follow Input and the device will read the attribute values that come with the
input source.

7.3.3.4 Configure EDID

Configure the resolution and frame rate of the input. You can select the standard
resolution provided by the device, customize a resolution, or set the advanced
parameters.

Prerequisites

* The front-end device outputs the video source from the graphics card.

¢ The input connector must be DP 1.2 or HDMI 2.0. 12G-SDI does not support this
function.

Notes

It is recommended the advanced settings are carried out by the trained personnel
only.
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Interface Example (P20)

~ EDID
Resolution 3840x2160

Frame Rate 60.00

Advanced

H Total

H Active

H Front Porch
H Sync

H Polarity

V Total
V Active

V Front Porch

V Sync

V Polanty

Description

On the EDID tab interface, configure the following parameters and click Apply after

the settings.

Parameter | Sub-Parameter

Description

Resolution -

The number of horizontal pixels and vertical pixels of
the image

Config method:

® Select the desired resolution from the drop-down
list.

e Select Custom from the drop-down list, and then
set the width and height values respectively.

Frame Rate | -

The image frames every second (unit: Hz)

Advanced H Total

Total pixel count per line

H Active

The horizontal size in pixels of the active area

H Front Porch

The offset between the end of the active area and the
beginning of the H sync

H Sync

The horizontal sync width in pixels (or between
pixels)

H Polarity

The polarity of the horizontal sync pulse

V Total

Total pixel count per column

V Active

The vertical size in pixels of the active area

V Front Porch

The offset in lines between the end of the active
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Parameter | Sub-Parameter | Description

output area and the beginning of V sync

V Sync The vertical sync width in rows (or between rows)

V Polarity The polarity of the vertical sync pulse

7.3.3.5 Import and Export EDID
When compatibility problem occurs on an input connector, import an intact EDID file

into the device; or export an EDID file from a device and provide the EDID file to other
devices or input connector to solve the compatibility problem.

Prerequisites

The input connector must be DP 1.2 or HDMI 2.0. 12G-SDI does not support this
function.

Notes

Each input connector supports importing one EDID file only and the EDID file must be
less than 1 MB.

Interface Example (P20)

“ EDID Import/Export

EDID Import EDID Export

Description

e EDID Import

On the EDID tab interface, click EDID Import. In the dialog box that appears, select
an EDID file and click Open.

* EDID Export

On the EDID tab interface, click EDID Export. In the dialog box that appears, select
a path and click Save.

E Note

If you need to modify the content of an imported EDID file, just modify it and then re-
import it to overwrite the original one.

7.3.3.6 Configure Input Color

Set the image quality parameters of the input connector, so that all video sources
connected to it will have the same image quality.

Prerequisites

None
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Notes

None

Interface Example (P20)

v Color

Contrast
ContrastR
ContrastG

ContrastB

Bnghtness.
BrightnessR

BrightnessG

BrightnessB

Saturation

Description

On the Effect tab interface, configure the following parameters.

Parameter

Description

Contrast

The ratio of the luminance of the brightest color to that of the
darkest color

Adjust the contrast value either as a whole or individually adjust
the RGB components.

Brightness

The shading of lights in the image

Adjust the brightness value either as a whole or individually adjust
the RGB components.

Hue

The relative degree of how bright or dark the input source image is

Saturation

The color purity of the image
The higher the value, the more vivid the color.
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7.3.3.7 Configure DSK
Achieve the luma keying or chroma keying effect on the input source.

Prerequisites

¢ The device model is Q8.

If your device is the P10 or P20 and you want to achieve the DSK effect, please
refer to 7.3.3.7 Configure DSK to set the related parameters in the layer property
area.

¢ Afine signal is connected to the input connector.
Notes

None
Interface Example (Q8)

v DSK
Luma key

Chroma key

Clip ¥

Vv Foreground Color

Color

Description

On the DSK tab interface, configure the following parameters.

Type Parameter Description
Function DSK Turns on or turn off the function.
switch e @ 0n

o (I Off

Description:

¢ Luma key: Suitable for application scenarios where
the brightness of the background is significantly
smaller than that of the foreground. The result of
luma key is that the background becomes
transparent and the foreground is keyed out.

¢ Chroma key: Suitable for application scenarios with
a single background color, such as blue/green
screen matting

Luma key Clip To distinguish between the foreground and
parameters background

www.pixelhue.com 135



All-New Event Presentation Switching Solutions

User Manual

7 Event Management Software PixelFlow

Type Parameter Description
Gain The hue softness of the transition area
The larger the value, the softer the transition.

Foreground Turn on or turn off the function.

Color o @): On. After the function is turned on, the
associated parameter Color can be used to adjust
the keying effect.

o (O Off
Color The RGB values of the foreground color
Chromakey | Pick The RGB values of the pick point
parameters e Config method 1: Click Pick, and then click the
position to be picked in the input source image.
® Config method 2: Set the coordinates of the pick
point in the input source image.
® Config method 3: Set the RGB values of Background
Point.
After the settings, click Apply. You can also adjust the
following parameters to optimize the keying effect.

Hue Ramp To distinguish between the foreground and

background

Hue Clip The hue range

The larger the value, the larger the removal area. The
maximum value is the current value of Hue Ramp.

Saturation To distinguish between the foreground and

Clip background

Gain The hue softness of the transition area

The larger the value, the softer the transition.

Spill To remove the overflow from the foreground image

edges and semi-transparent areas

Shadow To remove the shadow areas

Highlight To remove the highlight areas

Edge Smooth | Turn on or turn off the function.

e @ 0n
o (I Off

7.3.4 Configure Output Properties

Click the target output connector on the graphical device rear panel, and then set the
output-related properties in the property area on the right pane.
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Figure 7-13 Output properties (P20)

INPUT 11 INPUT 12 opT AUDIO

O
00 00 00 HEHEE o6
INPUT B8 QUTPUT 1/PGM-1  OUTPUT 2/ PGM-2 OUTI‘UU/PGMT OUTPUT 4/ PGM-4.

il — i — R — i — N — R —

7.3.4.1 Configure Card Properties

Select the desired output connectors and enable the output connector copying
function. The copy connector outputs the same image as the primary output
connector outputs.

Prerequisites

¢ The connector capacity configuration is applicable to the P10 and P20.

* The function of output connector copying and the selection of output connectors
are applicable to the Q8.

Notes

When the copy connector is already used to load the screen, you cannot enable the
connector copying function for the output card where the copy connector is located.

Interface Example (P20)

Output Card Properties

Capacity
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Interface Example (Q8)

Qutput Card Properties

Connector Copying

v Select Connector

Output 1-1

ouT 1-1
HDMI

Output 1-2

ouT 1-2
|_*HDMI

Output 1-3

ouT 1-3
HDMI

Output 14
Group
4 lourta
HDMI

Description

(&) | | Output 15

ouT 15
SDI

Output 1-6

ouT 1-6
SDI

(&) | | Output 1-7

OUT 17
SDI

Output 1-8

ouT 1-8
SDI

Parameter

Description

Capacity

Set the output connector capacity from the drop-down list.

Connector Copying

The function switch

o @:0n

o (I Off

The default copy relations between connectors are as follows:

* HDMI: Connectors 1 and 3 are primary connectors. Connector
2 copies the output on connector 1, while connector 4 copies
the output on connector 3.

e SDI: Connectors 5 and 7 are primary connectors. Connector 6
copies the output on connector 5, while connector 8 copies the
output on connector 7.

Select Connector

Select the desired output connectors.
o @ sclected

o .: Not selected

When the connector copying function is disabled, select the
required output connectors and click Apply.

7.3.4.2 View Output Info

View the basic output properties, and change the output connector name.
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Prerequisites

None

Notes

None

Interface Example (P20)

Description

Name(main})

Name(backup)

Type

Slot No.

GConnector Capacity
Output Resolution
Frame Rate

Bit Depth
Color/Sample

Color Gamut

Dynamic Range

OUTPUT 1-1

OUTPUT 1-2
OUTPUT 3-5
OUTPUT 3-6

HDMI 2.0
Output 1-1

4K
3840x2160 px
60 Hz

8bit

RGB 4:4:4
Rec.709

SDR

On the Basic tab interface, enter a new connector name, and then click elsewhere in
the interface to complete the connector name change.

7.3.4.3 Configure Output Info

Configure the output-related parameters.

Prerequisites

The device model is Q8.

Notes

None

Interface Example (Q8)

Description

» Qutput Information

Color/Sample

Bit Depth

RGB 4:4:4

8bit

On the Basic tab interface, configure the following parameters.
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Parameter Description
Color/Sample The sampling format of the output
Bit Depth The bit depth of the output, i.e., the binary digits to represent a
single color

7.3.4.4 Configure Output Timing

Configure the resolution and frame rate of the output. You can select the standard
resolution provided by the device, customize a resolution, or set the advanced
parameters.

Prerequisites
The back-end device EDID is obtained.

Notes

It is recommended the advanced settings are carried out by the trained personnel
only.

Interface Example (P20)

v Timing

Resolution 3840x2160
Frame Rate 60.00
Advanced

H Total

H Active

H Front Porch

H Sync

H Polarity

V Total

V Active

V Front Porch

V Sync

V Polarity

Description

On the Timing tab interface, configure the following parameters and click Apply after
the settings.

Parameter | Sub-Parameter | Description
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Resolution

The number of horizontal pixels and vertical pixels of
the image

Config method:

¢ Select the desired resolution from the drop-down
list.

¢ Select Custom from the drop-down list, and then
set the width and height values respectively.

Frame Rate

The image frames every second (unit: Hz)

Advanced

H Total

Total pixel count per line

H Active

The horizontal size in pixels of the active area

H Front Porch

The offset between the end of the active area and the
beginning of the H sync

H Sync The horizontal sync width in pixels (or between
pixels)

H Polarity The polarity of the horizontal sync pulse

V Total Total pixel count per column

V Active The vertical size in pixels of the active area

V Front Porch

The offset in lines between the end of the active
output area and the beginning of V sync

V Sync

The vertical sync width in rows (or between rows)

V Polarity

The polarity of the vertical sync pulse

7.3.4.5 Export EDID

Prerequisites

Notes

When the EDID compatibility of the input connector of the back-end device is good,
the device can learn the EDID of the back-end device through the output connector
and export the EDID to a local computer for possible future use.

¢ The output connector is connected to the back-end device normally.

* The output is a main output (not AUX output).

None

Interface Example (P20)

v EDID Export
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Description

On the Timing tab interface, click EDID Export. In the dialog box that appears, select a
path and click Save.

7.3.4.6 Configure Output Color

Configure the output color parameters. The ultimate output image quality is decided
by the layer color, input color and output color settings.

Prerequisites

None
Notes

None

Interface Example (P20)

v Color

Confrast ¥
ContrastR ¥
ContrastG ¥

ContrastB ¥

Bnghtness ¥
BrightnessR ¥ ™

BrightnessG ¥

BrightnessB ¥

Hue ¥™

Saturation ¥

Description

On the Effect tab interface, configure the following parameters.

Parameter Description

Contrast The ratio of the luminance of the brightest color to that of the
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Parameter Description

darkest color

Adjust the contrast value either as a whole or individually adjust
the RGB components.

Brightness The shading of lights in the image

Adjust the brightness value either as a whole or individually adjust
the RGB components.

Hue The relative degree of how bright or dark the input source image is

Saturation The color purity of the image
The higher the value, the more vivid the color.

7.3.4.7 Configure Multiviewer

Configure the connector mode and resolution of the Multiviewer connector.

Prerequisites
The device model is the Q8.
Notes

None

Interface Example (Q8)

Multiviewer Properties

v Multiviewer Connector Settings

Connecior Mode Independent

Connector Resolution | 2560x1080@60Hz

Description

Configure the following parameters and click Apply.

Parameter Description

Connector Mode Configure the working mode of the Multiviewer connector.

* |ndependent: Two Multiviewer connectors output their own
monitoring images.

® Copy: HDMI 2 copies the monitoring data on HDMI 1.

When the output resolution is set to 4Kx2K@60Hz, only copy
mode is supported.

Connector Resolution | Select the desired connector resolution.
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7.4 Screen Configuration

7.4.1 Configure Screens

Configure the layout of a main (not AUX) screen, as well as add and replace the
output connectors. The connectors of the same type and output resolution can be
configured for the same mosaic screen.

Step 1 Enter the device configuration page as described in 7.3.1 Enter Device Configuration
Page.

Step 2 Select the target device on the left, and then select Screen at the top of the page.

Figure 7-14 Screen configuration (P20)

Step 3 Click to add a new screen.
* To delete a single screen, place the mouse on the screen name and click [ x |
¢ To delete all screens, click E

Step 4 Click the screen name to select a screen.

Step 5 Click the layout style icon in the toolbar above the editing area, or click to
customize the layout by setting the number of rows and columns.

Figure 7-15 Toolbar (P20)

Zoom to Selected 1x1 1x2 2x1 x4  4x1 Custom Layout

O 0 8B I 8 M B H @«

Zoom Out Zoom In Auto Fill 1x3 3x1 2x2 Lock/Unlock

Step 6 Drag the output connector to the desired screen to complete the screen
configuration.
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To change an output, simply drag another output connector to the screen.

7.4.2 Configure Screen Properties

Click the desired screen, and then set the screen-related properties in the property
area on the right pane.

7.4.2.1 Rename Screens
Change the screen name.

Prerequisites

None

Notes

None

Interface Example (P20)

v Screen Properties

Screen Name Screen 1

Screen Properties Main Screen
Output Connectors 1
Mosaic Size 3840x2160

Description

On the Basic tab interface, enter a new screen name, and then click elsewhere in the
interface to complete the screen name change.

7.4.2.2 Configure Connector Position

Configure the start position of the output connector.
Prerequisites

None
Notes

None

Interface Example (P20)

v Connector Position

H Position

V Paosition
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Description

On the Basic tab interface, configure the following parameters.

Parameter Description
H Position The horizontal start position of the output connector
V Position The vertical start position of the output connector

7.4.2.3 Configure Test Patterns

Test patterns are used to check the connection relation between the output
connectors and the screen, and check whether the screen display is good.

Prerequisites

The screen is a main (not AUX) screen.
Notes

None

Interface Example (P20)

V Test Pattern

== |l

Brightness
. 100% .,

Spacing (px)

Grid Width

Speed

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Test Pattern Turn on or turn off the function.
° D; On
o (I Off
After the function is enabled, select the desired test pattern.

www.pixelhue.com 146



All-New Event Presentation Switching Solutions
7 Event Management Software PixelFlow

User Manual

Parameter Description

Brightness Sett the brightness of the test pattern.

Spacing Level Set the spacing between different color areas.
If a multi-color test pattern is selected, this parameter is
displayed.

Spacing (px) Set the spacing between the lines.
If a grid test pattern is selected, this parameter is displayed.

Grid Width Set the width of the grid lines.

Speed Set the moving speed of the lines.

7.4.2.4 Configure AOI

When the output connector resolution is greater than the actual screen resolution,
you can configure an unequal mosaic rather than changing the resolution of the
output connector.

Prerequisites
The screen is a main (not AUX) screen.

Notes

None

Interface Example (P20)

v AOI Settings

OUTPUT 2-3 3840.* 2160

Height

Description

Select the output connector on the canvas, and then configure the following
parameters on the Basic tab interface. After the settings, click Apply.
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Parameter

Description

X

The horizontal offset relative to the starting position of the original
connector

The vertical offset relative to the starting position of the original
connector

Width

The horizontal pixels

Height

The vertical pixels

7.4.2.5 Configure Screen Color

Configure the screen color parameters.

Prerequisites

None

Notes

None

Interface Example (P20)

v Color

Contrast ¥™
ConfrastR ¥
ContrastG ¥

ContrastB ™

Bnghtness ¥

BrightnessR ¥

BrnightnessG ¥ >

BrightnessB ¥

Saturation ¥™
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Description

On the Effect tab interface, configure the following parameters.

Parameter Description

Contrast The ratio of the luminance of the brightest color to that of the
darkest color
Adjust the contrast value either as a whole or individually adjust
the RGB components.

Brightness The shading of lights in the image
Adjust the brightness value either as a whole or individually adjust
the RGB components.

Hue The relative degree of how bright or dark the input source image is

Saturation The color purity of the image

The higher the value, the more vivid the color.

7.4.2.6 Configure Timing

Configure the resolution and frame rate of the output. You can select the standard
resolution provided by the device, customize a resolution, or set the advanced

parameters.

Prerequisites

The EDID of the back-end device is obtained.

Notes

It is recommended the advanced settings are carried out by the trained personnel

only.

After the output resolution is changed, the AOI parameters associated with the
connector will be automatically reset.
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Interface Example (P20)

v Timing

Resolution 3840x2160

Frame Rate 60.00

Advanced
H Total
H Active
H Front Porch
H Sync

H Polarity

V Total

V Active

V Front Porch
V Sync

V Polarity

Description

On the Output tab interface, configure the following parameters and click Apply.

Parameter | Sub-Parameter

Description

Resolution | -

The number of horizontal pixels and vertical pixels of
the image

Config method:

¢ Select the desired resolution from the drop-down
list.

e Select Custom from the drop-down list, and then
set the width and height values respectively.

Frame Rate | -

The image frames every second (unit: Hz)

Advanced H Total

Total pixel count per line

H Active

The horizontal size in pixels of the active area

H Front Porch

The offset between the end of the active area and the
beginning of the H sync

H Sync

The horizontal sync width in pixels (or between
pixels)

H Polarity

The polarity of the horizontal sync pulse

V Total

Total pixel count per column

V Active

The vertical size in pixels of the active area
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V Front Porch The offset in lines between the end of the active
output area and the beginning of V sync

V Sync The vertical sync width in rows (or between rows)

V Polarity The polarity of the vertical sync pulse

7.4.2.7 Configure Output Parameters
Configure the output-related parameters.

Prerequisites

Before setting the HDR format conversion related parameters here, make sure your
device is the P20 and you have turned on the HDR format conversion function. For
specific operations, please refer to 7.3.2.5 Configure HDR Format Conversion.

Notes

None

Interface Example (P20)

v Parameter Settings

Color/Sample RGB 4:4-4
Bit Depth 8bit
Dynamic Range SDR

Color Gamut Rec 709

Gamma
®

Description

On the Output tab interface, configure the following parameters.

Type Parameter Description

General Color/Sample The sampling format of the output

parameters ) ] ) - —
Bit Depth The bit depth of the output, i.e., the binary digits

to represent a single color

HDR parameters | Dynamic Range | The dynamic range format of the output

Color Gamut The color gamut standard of the output

Gamma The Gamma value

7.4.2.8 Configure Edge Blending

Edge blending is a technique used when using multiple projectors to display different
regions of a single image. To display a single seamless image, adjacent projectors
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need to overlap edges slightly and compensate for the double brightness created in

different regions.

Prerequisites

¢ The screen is a common screen.

* The offset angles of the projectors have been adjusted.

Notes

None

Interface Example (P20)

v Edge Blending
Edge

Feathering

Feather Gamma ¥

Feather Width

Description

0

" Reset \I

On the Advanced tab interface, configure the following parameters.

Parameter

Description

Edge

Select the edge for blending.

Feathering

Turn on or turn off the function.
° ‘:]; On
o (I: Off

Feather Gamma

The feathering gamma for the blending area

Feather Width

The feathering width for the blending area

The blending area is inside the projector image and facing
inward.

7.4.2.9 Configure LCD Bezel Compensation

Configure the edge compensation parameters for LCD splicing screens to make the
image visually integrated.

Prerequisites

None
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Notes

None

Interface Example (P20)

v LCD Bezel Compensation

Horizontal Spacing 0

Vertical Spacing 0

Description

On the Advanced tab interface, configure the following parameters.

Parameter Description

LCD Bezel Turn on or turn off the function.

Compensation e ) 0n
o (I Off

Horizontal Spacing The total width of the borders at the horizontal joints of the
screens

Vertical Spacing The total width of the borders at the vertical joints of the
screens

7.4.2.10 Configure Virtual Pixels

With the help of the virtual pixel function, the complicated calculations during the
screen configuration process will not be troublesome.

Prerequisites

The screen is a common screen.
Notes

The virtual pixels have no effect on the actual output content.
Interface Example (P20)

Vv Virtual Pixels

Target Size Actual Size

3840

2160

[:- Apply -::I [:- Reset -::I
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Description

On the Advanced tab interface, configure the following parameters and click Apply.

Parameter Description

Virtual Pixels Turn on or turn off the function.
° D; On
o (I: Off

Width (Actual Size) The width of the actual screen

Height (Actual Size) The height of the actual screen

7.5 Layer Operation
7.5.1 Add Layers

Add the layers to the screen. Multiple layers can be added to a main screen, but only
one layer can be added to an AUX screen. The AUX screen layer fills the screen, with
its size and position unadjustable.

Step 1 Enter the device configuration page as described in 7.3.1 Enter Device Configuration
Page.

Step 2 Select the target device on the left, and then select Programming at the top of the
page.

Figure 7-16 Programming (P20)
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Step 3 Click a screen name to select the screen, or click Multiple select to select multiple
screens.

Step 4 Add the layers to the screens.
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¢ Main screen: Drag an input source to the screen. If the device model is Q8, you
can also drag the PGM from other screens to the current screen.

e AUX screen: Drag an input source in the input list or a PGM in the screen list to the
AUX screen.

Step 5 Perform the desired layer operations as required.

Figure 7-17 Layer operations

Screen 1

Ry ’
~ N .“' -~ e
Input 1-HDMI 2.0

~
e

@0 HH © B

B8 | of swap_ Copy ) - 29
Comenrom ) ™) ) | G @

1 Lock/Unlock PGM 16 Bring to front

2 Capture PGM 17 Send to back

3 Lock/Unlock layer 18 Fill horizontally

4 1:1 display 19 Fill vertically

5 Maximize display 20 Fill screen

6 Delete 21 Align

7 Maximize/Restore 22 Copy

8 Zoom out 23 Mirror horizontally

9 Zoom in 24 Swap PVW and PGM

10 Zoom to selected 25 Copy PVW to PGM

11 Auto fill 26 Match PVW with PGM

12 Clear 27 Transition effect

13 Lock/Unlock PGM and PVW 28 Transition duration

14 Bring forward 29 FTB
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15 Send backward 30 Freeze

Send PVM to PGM via the following three ways:

¢ CUT: Send PVW to PGM without any transition effect.
e TAKE: Send PVW to PGM with a time-specified transition effect.

¢ T-BAR: Send PVW to PGM with a transition effect, and the transition duration
depends on the time duration you push the T-Bar.

E Note

The layer or preset operations are NOT allowed during the transition process.

7.5.2 Manage Gallery

Select the Gallery tab and do the following in the BKG or LOGO area as required.
Import Images (.png/.bmp/.jpg/.jpeg)

Click , select the desired images in the displayed dialog box and then click Open.

Export Images

Click Edit, select the images you want to export, and click . In the pop-up dialog
box, choose a destination path, and click OK.

Delete Images

Click Edit, select the images to be deleted, and then click . In the pop-up dialog
box, click Yes.

7.5.3 Configure Layer Properties

Select the desired layer, and then set the layer-related properties in the property area
on the right pane.

7.5.3.1 Configure Basic Properties

Configure the layer name, flipping, aspect ratio, as well as position and size.
Prerequisites

None
Notes

The AUX layer fills the AUX screen, with the layer size and position unadjustable.
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Interface Example (P20)

Layer1

Flip

Aspect Ratio

v Position & Size

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Name The layer name
Flip The layer flipping mode

The supported options include None, Flip Horizontally, Flip
Vertically, Flip Horizontally and Vertically.

Aspect Ratio

The ratio of the layer's width to its height

After the aspect ratio is changed, the height of the layer remains
unchanged, and the device automatically calculates its width.

X The horizontal starting position of the layer on the main screen
The coordinates of the first pixel in the upper left corner of the
main screen are (0,0).

Y The vertical starting position of the layer on the main screen
The coordinates of the first pixel in the upper left corner of the
main screen are (0,0).

W The horizontal size of the layer.
The minimum width of a layer can only be scaled down to 1/64 of
the layer width.

H The vertical size of the layer.

The minimum height of a layer can only be scaled down to 1/64 of
the layer height.

7.5.3.2 Configure Layer Borders

Configure the border style of a layer.

Prerequisites

The layer is a regular (not AUX) layer.
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Notes
If the layer mask function is turned on, the border function is turned off.

Interface Example (P20)

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Border Turn on or turn off the function.
e ©D:0n
o (B Off
Type The layer border type
Width The width of the layer left or right border
Height The height of the top or bottom border
Color The layer border color
When the border function is set to ), this parameter is available.

7.5.3.3 Configure Layer Mask

Configure the mask-related parameters. The masked area becomes transparent and
the layer size remains the same.

Prerequisites
The layer is a regular (not AUX) layer.

Notes

If the layer mask function is turned on, the border function is turned off.
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Interface Example (P20)

v Mask

Mask Top =

Mask Bottom *>

Mask Left

Mask Right ¥

Description

On the Basic tab interface, configure the following parameters.

Parameter Description
Mask Turn on or turn off the function.

e D 0n

o (I Off
Mask Top Set the masked area height from the top edge of the layer.
Mask Bottom Set the masked area height from the bottom edge of the layer.
Mask Left Set the masked area width from the left edge of the layer.
Mask Right Set the masked area width from the right edge of the layer.

7.5.3.4 Configure Layer Color

Configure the layer color parameters.
Prerequisites

The layers is a regular (not AUX) layer.

Notes

None
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Interface Example (P20)

Description

v Color

Contrast £

ContrastR

ContrastG

ContrastB >

Brightness ¥

BrightnessR *

BrightnessG *

BrightnessB *

Saturation ¥

Opacity

Monochrome

Invert Colors

On the Effect tab interface, configure the following parameters.

Parameter Description

Contrast The ratio of the luminance of the brightest color to that of the
darkest color
Adjust the contrast value either as a whole or individually adjust
the RGB components.

Brightness The shading of lights in the image
Adjust the brightness value either as a whole or individually adjust
the RGB components.

Hue The relative degree of how bright or dark the input source image is

Saturation The color purity of the image

The higher the value, the more vivid the color.
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Parameter Description
Opacity The layer opacity
Monochrome Turn on or turn off the function.

e @0): 0On, and the layer image is show in black and white.

o (I Off

Invert Colors

Turn on or turn off the function.

o @) 0n, and the layerimage is show in the complementary color
of its original color.

o (I Off

7.5.3.5 Crop Input Sources

When there are black borders or other redundant info in the input source image, the
required picture can be retained through the cropping the input source, so as to
improve the screen utilization.

Prerequisites

¢ The device model is the P20 and P10.

* The layer is a regular (not AUX) layer, and the layer input source is a good one.

Notes

The status and capacity of the cropped input source are consistent with that of the

original one.

Interface Example (P20)

v Layer Source Crop

Height

Description

On the Advanced tab interface, configure the following parameters.

Parameter

Description

Layer Source Crop

Turn on or turn off the function.
° D; On
o (I Off
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Parameter

Description

X

The horizontal initial coordinate of the cropped part upon the
current input source

The vertical initial coordinate of the cropped part upon the
current input source

Width

The horizontal pixels of the cropped part

Height

The vertical pixels of the cropped part

7.5.3.6 Configure Cut & Fill

Configure the relevant parameters for the Cut & Fill function.

The original layer serves as the Fill layer, and the output will display the Cut layer that
overlaps with the Fill layer, allowing users to define the output shape and effect more

flexibly.

Prerequisites

The layer is a regular layer.

Notes

¢ When the Cut & Fill function is enabled, the DSK function is disabled.

¢ Forthe Q8, the Cut & Fill function occupies two layer resources.

» Forthe P10 and P20, the total resources for the Cut layer are 2x DL (1x 4K), and
the Cut layer capacity must be less than or equal to that of the Fill layer.
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Interface Example (P20)

Vv Cut&Fill

Cut Source

Select a source here

Invert Colors

Curve Adjustment

Cut Layer
X e

Y &

Width ¥

Height *>

Description

On the Advanced tab interface, configure the following parameters.

Parameter Description

Cut & Fill Turn on or turn off the function.
e ) 0n
o (I Off

Cut Source The input source of the Cut layer

Config method: Click . to select an input source in the pop-up
dialog box, and click OK.
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Parameter

Description

You can also delete or replace the input source if necessary.

Invert Colors

Turn on or turn off the function.

e ©0): 0n, allowing black areas to be transparent and white
areas to be cut

o (®: Off, allowing white areas to be transparent and black
areas to be cut

Curve Adjustment

The color curve for the Cut layer, which is used to adjust the
transition effect of the Cut layer

The farther apart the X coordinates of 1 and 2 are, the smoother
the transition will be.

X The horizontal initial position of the Cut layer relative to the Fill
layer

Y The vertical initial position of the Cut layer relative to the Fill layer

Width The horizontal pixels of the Cut layer

Height The vertical pixels of the Cut layer

7.5.3.7 Configure DSK

Achieve the luma keying or chroma keying effect on the input source.

Prerequisites

¢ The device model is the P10 and P20. If your device is the Q8 and you want to
achieve the DSK effect, please refer to 7.3.3.7 Configure DSK to set the related
parameters in the input property area.

* The layers is a regular (not AUX) layer, and the layer input source is a good one.

Notes

After the DSK function is enabled, the layer capacity will automatically change to 4K,
and the cut & fill function will be disabled.

Interface Example (P20)

v DSK
Luma key

Chroma key

Clip ¥

Saturation Gain ¥

~ Foreground Color

Color
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Description

On the DSK tab interface, configure the following parameters.

Type

Parameter

Description

Function
switch

DSK

Turns on or turn off the function.
o @:0n

o (I Off

Description:

* Luma key: Suitable for application scenarios
where the brightness of the background is
significantly smaller than that of the
foreground. The result of luma key is that the
background becomes transparent and the
foreground is keyed out.

¢ Chroma key: Suitable for application scenarios
with a single background color, such as
blue/green screen matting.

Luma key
parameters

Clip

To distinguish between the foreground and
background

Gain

The hue softness of the transition area
The larger the value, the softer the transition.

Foreground
Color

Turn on or turn off the function.

o @) On. After the function is turned on, the
associated parameter Color can be used to
adjust the keying effect.

o (I: Off

Color

The RGB values of the foreground color

Chroma key
parameters

Pick

The RGB values of the pick point color

® Config method 1: Click Pick, and then click the
position to be picked in the input source image.

® Config method 2: Set the coordinates of the
pick point in the input source image.

® Config method 3: Set the RGB values of
Background Point.

After the settings, click Apply. You can also adjust
the following parameters to optimize the keying
effect.

Hue Ramp

To distinguish between the foreground and
background

Hue Clip

The hue range

The larger the value, the larger the removal area.
The maximum value is the current value of Hue
Ramp.

Saturation Clip

To distinguish between the foreground and
background
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Type Parameter Description

Gain The hue softness of the transition area
The larger the value, the softer the transition.

Spill To remove the overflow from the foreground
image edges and semi-transparent areas
Shadow To remove the shadow areas
Highlight To remove the highlight areas
Edge Smooth Turn on or turn off the function.
o @):0n
o CID: Off

7.5.4 Manage Presets

To manage presets, click Screen Preset on the right side of the Programming
interface and perform the corresponding actions as needed.

Figure 7-18 Preset management (P20)

Save Presets

Click a screen name to select an individual screen, or select Multiple select and click
the desired screens one by one. Then, perform the following actions as required:

¢ Q8:
Click Save from PGM or Save from PVW.
e P20 and P10:

In Switcher mode: Click Save from PGM or Save from PVW.
In PGM Only mode: Click Save Preset.
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Load Presets

In the preset list, select the desired preset to load it.

* Q8:
The preset is loaded to PVW.
¢ P20andP10:

In Switcher mode: The preset is loaded to PVW.
In PGM Only mode: The preset is loaded to PGM.

After the preset is successfully loaded, the corresponding indicator light at the top
left of the preview area will light up:

e ®: The preset is loaded to PVW.
e ®:The preset is loaded to PGM.

Rename Presets

Place the mouse over the preset and click [B. Enter a new name and then click
elsewhere to make the change take effect.

Delete Single Preset
Place the mouse over the preset and click Ed. in the pop-up dialog box, click Yes.
Delete All Presets

Click Edit, check Select All, and click i@ n the pop-up dialog box, click Yes.

7.6 Multiviewer (MVR)
7.6.1 Configure MVR Layout

Configure the layout of the MVR windows. When the bandwidth of the input source
exceeds the limit, the corresponding MVR image is black.

When the MVR connector of Q8 is in independent mode, an input source or screen
cannot be simultaneously previewed by both MVR1 and MVR2.

Step 1 Enter the device configuration page as described in 7.3.1 Enter Device Configuration
Page.

Step 2 Select the target device on the left, and then select Multiviewer at the top of the
page.
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Figure 7-19 MVR management (Q8)

Step 3 Select a layout style. When the device model is the Q8, you can also click to
customize the number of rows and columns of the windows.

Step 4 If the device model is the Q8, drag an input in the input list or drag PYW and PGM in
the screen list to the MVR window.

If the device model is the P20 and P10, please skip this step.

To replace a signal of a specified window, simply drag another signal to the window.
After a signal is selected, the following operations can be performed:

* Delete signal: Click to delete the signal from the window.

¢ Maximize signal image: Click to maximize the signal image according to the
windows it crosses.

To delete all signals, click .

7.6.2 Configure MVR Properties

Configure the position, UMD and borders of the MVR window.
Prerequisites

The device model is the Q8.
Notes

None
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Interface Example (Q8)

Multiviewer Properties

~ Window Position

v UMD

Color

~ Border

Width
®

Height

Description

Select an added MVR signal, and then set the related properties in the property area

on the right pane.

Type Parameter Description
Window position X The X coordinate of the window on the MVR
screen
Y The Y coordinate of the window on the MVR
screen
Width The horizontal pixels of the window
Height The vertical pixels of the window
UMD UMD Turn on or turn off the function.
e ®D:0n
o O off
Color The color of the UMD text
Border Width The width of the layer left or right border
Height The height of the top or bottom border
Color The layer border color
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7.7 Screen Maintenance

7.7.1 Device Maintenance

In the menu bar, select Maintain. Select the Device tab and the target devices, and
then do the following as required.

Figure 7-20 Device maintenance

T Device Type Action

Update
E Note

During the update process, power-off and all operations are NOT allowed.

Step 1 Click Update.

Step 2 In the pop-up dialog box, select the update file (.img) and click OK.
Step 3 Confirm the devices to be updated, and click the Update button.

Step 4 In the pop-up dialog box, click Yes and wait until the update completes.

Step 5 After the update completes, click OK.

Restart

Click Restart. In the displayed dialog box, click Yes to restart the device.

Factory Reset

E Notes

e Please do this with great caution.

e Thereset action does not affect the device firmware version.

e Power-off is NOT allowed during the reset process.

e The device will restart automatically after the reset is completed.

Click Factory Reset. In the pop-up dialog box, select Keep user data or Reset all, and
then click OK.

¢ Keep user data

Retain the network parameters, project files, EDID files, gallery files and device
language settings.
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¢ Reset all

Retain the network parameters and project files.

Figure 7-21 Factory reset

Faciory Reset

Please select a fa[:tnry reset method:
Keep user data

Reset all

Export Logs

Click Export Log. In the dialog box that appears, select a path and click Save to save
the device logs to local computer.

7.7.2 Device Diagnostics

In the menu bar, select Maintain. Select the Diagnostics tab, select a device from the
drop-down list, and click Diagnostics.

After the diagnostics completes, you can view the test result and take necessary
measures as required.

Figure 7-22 Device diagnostics
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7.8 Software Settings
7.8.1 Switch Ul Language

In the menu bar, go to Settings > Language to switch the Ul language.

7.8.2 Configure Input View

In the menu bar, go to Settings > Input View.

¢ V:The function is enabled, and the input source will have a live image in the
software interface.

¢ No mark: The function is disabled.

7.8.3 Export Logs

In the menu bar, go to Settings > Export Software Logs.

¢ OnaPC, you can export the logs of the PixelFlow software.

¢ On an event controller, you can export the logs of both the PixelFlow software and
event controller.

7.8.4 View Software Info

In the menu bar, go to Help > About Us to view the software-related info.
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U5/U5 Pro Event Controllers

About This Chapter
This chapter introduces you to the U5/U5 Pro event controller.
Overview

¢ Introduction

* Device Operations
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8.1 Introduction

The U series event controllers are equipped with two touchscreens, a main
touchscreen and a smart touchscreen. On the main touchscreen, you can do various
intuitive and free configurations for the seamless switchers, such as configurations
of layers, layer position, input sources, output resolutions, input keying, layer borders,
input crop and presets.

The 8" smart touchscreen displays still images, timecode, switcher and event
controller status, and a Multiviewer image (Multiviewer 1, Multiviewer 2, or HDMI 1.3),
and can be customized as a virtual MIDI keyboard.

The U series event controllers include the following two models:

e U5 event controller

¢ U5 Pro event controller

8.2 Hardware Introduction
8.2.1 Front Panel

U5 Front Panel

Figure 8-1 U5 front panel

1. Main touchscreen 7. Function control area
2. Screen buttons 8. Switching control area
3. Layer buttons 9. T-Bar

4. Input buttons 10. Power button

5. Preset buttons 11. MIDI module area

6. Smart touchscreen

a Note

The U5 LCD screen can be folded and lock at any angle between 45° and 125°.
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U5 Pro Front Panel

Figure 8-2 U5 Pro front panel

0o N o o0k~ 0N

. Main touchscreen

. Device buttons

. Screen buttons

. Input buttons

. Layer buttons

. Preset buttons

. Function control area

. Camera and timecode control area

T R | (Y

9. Smart touchscreen

10. Number buttons

11. Switching control area
12. MIDI module area

13. Power button

14. T-Bar

15. Keyboard

16 Drawers
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8.2.2 Rear Panel

U5 Rear Panel

Figure 8-3 U5 rear panel

1

1.2x USB 3.0 5. 2x HDMI 2.0+1x HDMI 1.3 connectors

2. Timecode module connector 6. 4x USB 2.0 ports
(optional module)

3. Gooseneck lamp connector 7. USB (type-B)
4. 2x ETHERNET ports 8. 1x Power module

U5 Pro Rear Panel

Figure 8-4 U5 Pro Rear Panel
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1.2x USB 3.0

2. Gooseneck lamp connector

3. Timecode module connector

4. 2x ETHERNET ports

Connector Description

5. 2x HDMI 2.0+1x HDMI 1.3 connectors

6. USB (type-B)

7. 4x USB 2.0 ports

8. 2x Power modules

No.

Area

Connector

Qty

Function

uSB

USB 3.0

2x USB 3.0 on the right side of U5

Connect to the mouse, keyboard,
USB drive, etc.

Gooseneck lamp
connector

Connect the gooseneck lamp.

The U5 has one gooseneck lamp
connector and the U5 Pro has two.

Timecode | LTC
module

3-pin XLR
connector

TXLTCIN, 2x LTC OUT

e Connect to the external LTC-
format timecode input device.

e LTC timecode output

MTC

5-pin XLR
connector

1x MTC IN, 1x MTC OUT, 1x USB
(type-B)
e MTC IN: Connect to the external

MTC-format timecode input
device.

e MTC OUT: MTC timecode output

e USB DEVICE: Support input and
output of MTC timecodes from
USB MIDI device

ETHERNET

Neutrik
Ethernet ports

2x Neutrik Gigabit Ethernet ports

® (Connect to the Ethernet control
port of the backend control
device.

® Support mutual backup mode.
The two Ethernet ports use the
same IP address.

¢ Support independent mode. The
two Ethernet ports use two IP
addresses.

e Support transmission of the
input view information.

MULTIVIEWER

HDMI 2.0

® Generally connect to the MVR
connector of the seamless
switcher to view the output
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monitoring.

* Up to 4Kx2K@60Hz

HDMI HDMI 1.3 1 ® Generally connect to the output
connector of the media server to
display its user interface.

¢ Up to 2Kx1K@60Hz

USB USB 2.0 4 Connect to the mouse, keyboard,

USB drive, etc.

MIDI / KVM USB (type-B) 1 e KVM: Connect to a PC or media
server via USB cable for KVM
control.

e MIDI: Connect to the MIDI control
device for MIDI command
output.

e KVM and MIDI can be turned on
at the same time.

Power module - 1 * Power connector specifications:

) or 100-240V~, 6A, 50/60Hz

2

The U5 has one power module.

The U5 Pro has two power
modules, one primary and one
backup.

8.3 Device Operations

8.3.1 Basic Operations

8.3.2 Startup and Shutdown

Prerequisites

Press: Press the button and release it within 3 seconds.

Hold down: Press and hold the button for 3 seconds or longer.

Click/Tap: Click or tap the menu once on the screen.

Double click/tap: Click or tap the same area twice quickly.

Combination of buttons: Hold down f

:‘ S . . .
I or to activate combination

function and then press another function button to trigger the corresponding

function.

Pinch in or stretch out: Place two fingers on the touchscreen and pinch in or
stretch out. This operation is only to zoom in or out pictures on the smart

touchscreen.

A power supply is connected and the power is supplied normally.
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Startup

Shutdown

| . . .
Pressthe & button in the upper right corner of the panel, and the system will
automatically start up. After startup, the main touchscreen displays the home screen.

Power off the event controller through the following methods:

* Pressthe O button in the upper right corner of the panel, select OK in the pop-
up dialog box on the main touchscreen, and the system will shut down.

. |
¢ During the startup process, hold down the O button to force shutdown.

* 0On the main touchscreen, choose Settings > Event Controller at the top and select
the Other tab on the displayed page. In the Event Controller Power area, click Shut
Down, and the device will automatically shut down.

Restart Event Controller

On the main touchscreen, choose Settings > Event Controller at the top and select
the Other tab on the displayed page. In the Event Controller Power area, click Restart,
and the device will automatically restart.

a Note

During startup or shutdown, the PIXELHUE logo is displayed on the home screen.

8.3.3 Main Touchscreen

The U5 has a 21.5” multi-touch main touchscreen with a resolution of 1920x1080.

The U5 Pro has a 43.8” multi-touch main touchscreen with a resolution of
1920x1080.

On the main touchscreen, the built-in software user interface is displayed for you to
do a lot of operations, such as adding devices, configuring screens, configuring
inputs and outputs, configuring gallery, adding and deleting layers, configuring
presets, configuring Multiviewer, importing and exporting project files, configuring
the smart touchscreen, configuring the event controller skin, language and light, and
much more.

The main touchscreen supports the click, double-click, tap and double tap operations
via the connected mouse or your finger.

8.3.4 Device Buttons

The U5 does not support switching between connected devices through buttons,
while the U5 Pro supports switching between up to 16 connected seamless
switchers through buttons. However, the buttons do not page-turning.

When only one device is connected to the U5 Pro, the buttons in its device area will
be automatically used as screen buttons.
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Figure 8-5 Device buttons
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Operations and status description of the 16 Device buttons:

e The LCD button displays the device name. Pressing the button switches to the
device corresponding to the button name for you to control that device.

¢ White: A device is bonded to this button but not selected.
¢ Green: A device is bonded to this button and is being operated.
* Yellow: A device is bonded to this button, but the device is offline.

¢ Blank button: No device is bonded to this button.

8.3.5 Screen Buttons

Pressing a screen button selects the corresponding screen, and the PVW page of
that screen will be displayed on the main touchscreen.

The screen name displayed in the screen button can be modified through the screen
editing page.

The screen quantity and screen name depend on the selected device connected to
the event controller.

Figure 8-6 Screen buttons
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Screen Button Status

The screen buttons have the following statuses:
¢ Green: Screens are added to this button and being operated.
* Yellow: Screens are added to this button but not selected.

¢ Blank: No screens are added to this button.
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Screen Button Operations

Press the screen button (yellow) bound with screens to select this screen. After
the screen is selected, the screen button turns green, and the corresponding
screen in the main touchscreen enters the PVW activated status.

Press different screen buttons consecutively to select multiple screens.

Holding down the selected screen cancels screen selection. The button will turn
yellow, and the screen corresponding to the button will become unselected in the
main touchscreen.

Pressing the button with no screens bound (blank button) quickly creates a
screen. For that created screen, the system uses an unused and top-ranked output
connector to add a screen. If there is no unused output connector, an empty
screen will be created.

Screen Page Up/Down

If there are too many screens, they will be displayed on different screen pages on the
screen buttons. The first page is displayed by default and the page jumping operation
is performed in the following method.

Page Down: Press g to jump to the next page. For example, when the page

button displays Page 1 currently, press to jump to the screens displayed in
Page 2.

Page Up: Button combination should be used.

- U5: Press ﬂ while holding down the control button & in the control area
to jump to the previous page. For example, when the page button displays

| and ﬂ buttons to jump to the

Page 2 currently, use the combination of !
screens displayed in Page 1.

L2

- U5: Press ﬂ while holding down the control button E¥is®8 in the control
area to jump to the previous page. For example, when the page button

displays Page 2 currently, use the combination of and n buttons to
jump to the screens displayed in Page 1.

8.3.6 Input Source Buttons

Press an input source button to select an input source for the layer.

When a layer is selected, press an input source button to switch the layer input
source.

The U5 Pro has 30 input buttons and 2 page turning buttons.

The U5 has 15 screen buttons and 1 page turning button. To jump to the previous

page, use the combination of I

84 and . buttons.
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8.3.7 Layer

Figure 8-7 Input source buttons
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The input source page turning button supports cyclic page turning.

All the input sources are bound to the input buttons by default. When the input source
changes, the button name will be automatically updated.

The status of input source buttons are described as follows:

¢ Green: The input source is being used by the selected layer.

* Yellow: The input source corresponding to the button has signal but it is not used
by the layer.

* Red: The input source corresponding to the button has signal but it is used by the
layer.

¢ Orange: The input source corresponding to the button exceeds the connector's
load capacity.

* White: The input source corresponding to the button has no signal.

¢ Blank button: The button does not have corresponding input source.

Buttons

Pressing a layer button selects the corresponding layer and the PVW page of the
screen corresponding to that layer will be displayed on the main touchscreen with
that layer in the selected status.

The layer name displayed in the layer button can be modified on the layer editing

page.

¢ The U5 Pro has 34 layer buttons and 2 page turning buttons.

e The U5 has 15 layer buttons and 1 page turning button. To jump to the previous
page, use the combination of and B buttons.

Figure 8-8 Layer buttons
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Layer Button Status

* Green: The layer is selected.
* Yellow: The layer is added but not selected.

* Blank button: The button does not have corresponding layer.

Layer Button Operations

» Pressing the layer button (yellow) bound with layer selects this layer. After the
layer is selected, the layer button turns green. On the main touchscreen, the PVW
area of the screen where the layer belongs to enters the activated status and the
corresponding layer is selected.

» Pressing the button with no layers bound (blank button) quickly creates a layer.
The system uses an unused and top-ranked source with signal as the source for
that created layer.

The default source used by the system is the one connected to the input
connector that has the smallest number on the input card with the smallest
number as well.

8.3.8 Preset Buttons

Pressing the preset button loads a saved preset to the screen PVW area.

The preset name displayed in the preset button can be modified on the preset list
page.

e The U5 Pro has 34 preset buttons and 2 page turning buttons.

¢ The U5 has 15 preset buttons n 1 page turning button. To jump to the previous
| and (2] buttons.

page, use the combination of !

Figure 8-9 Preset buttons
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Preset Button Status

¢ Green: The preset has been loaded to the screen PVW.
¢ Yellow: The preset is saved but not loaded.

¢ Red: The preset has been loaded to the screen PGM.
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Blue: This button is bound with the program of the media server. Pressing this
button switches the program of the media server.

Purple: This button is bound with a preset and the program of the media server.
Press this button to switch the program of the media server and switch the preset
of the seamless switcher.

Blank button: The button does not have corresponding preset or program.

8.3.9 Function Control Area

Figure 8-10 Function control area of U5 Pro

— . “
PGM EDIT

f‘\—-{ \ r-u—\; — \ Y
o DSK TOP BUTTON
=3\ o)

COPY | FLIP ‘

FTB: Make the output image fade to black.
FRZ: Freeze the current frame of the output image.
MATCH PGM: Press to synchronize all layer information in PGM to PVW.

PGM EDIT: Enable or disable the PGM editing function. After it is enabled,
the layers in the current screen PGM can be edited.

/: Control button, which can be used together with another button.
Press and hold this key, and then press another function button to realize a

specific function. For example, press ﬂ while holding down (=] on the U5 Pro
to jump to the previous page.

: MVR button for checking the Multiviewer image on the right side of the
main touchscreen from the MULTIVIEWER and HDMI IN connectors on the rear
panel. If you press it consecutively, the Multiviewer image will be switched with
the order of MULTIVIEWER (HDMI 1) > MULTIVIEWER (HDMI 2) > HDMI |

&=3: MEDIA button. When the HDMI IN connector is connected to the media server,
its user interface will be displayed on the main touchscreen. If its user interface is
displayed by pressing the MVR button, pressing the MEDIA button enables KVM
control.

E: Press to stretch the selected layer to fill the screen area(s) in which the
selected layer is located before it is stretched.

E: Press to enter the DSK page for you to do chroma key and luma key
operations on the input source.
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./
H

=) : Press to bring the selected layer to front.

=) Press to send the selected layer to back.

: Press to copy the selected layer.

: Press to flip the selected layer

LOCK
T-BAR

] |

: Hold down to lock the T-Bar. After it is locked and then pushed, the layer will
not be switched.

: Hold down to lock the front panel and main touchscreen of the event
controller. After locked, they cannot be used.

u: In the U5 event controller, press this button to turn the page of the two rows of
buttons on the left of this button.

Blank button: Reserved button for custom functions.

8.3.10 Camera and Timecode Control Area

The U5 Pro allows for adjusting the PTZ camera position and the timecode output.

||
/

R
[Jt
Y,

=

J
|

‘. \“ {

]
)

o

(

0

SAVETO

: Save to button. Press to activate the save to function and the button
flashes yellow. Then, press a preset button, and the current layer or program will
be saved to the selected preset.

n: Delete button. Press to activate the delete function and the button
flashes yellow. Then, press a preset, layer or screen button, and the selected
preset, layer or screen will be deleted.

0

1MATCJ [ﬂ m LDJ : Timecode module control buttons
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Press to start or stop

Press to switch timecode source displaying timedoce

Press to switch timecode frame rate Press to reset timedcode

¢ PTZ camera adjustment buttons:

Save to Pattern

- E==semlll' Save the PTZ position after adjustment as a pattern for quick PTZ
switching in the future. Press the button to activate it and it flashes yellow.
Then, press Pattern 1 or Pattern 2 to save the PTZ camera positions in the

two buttons.

- E / E / g / u:Adjustthe PTZ camera shooting angle up,

down, left and right.

”P;n:rj {P;tt;ri‘
- / S&8¥ The saved PTZ camera positions. Press these buttons to apply
the position to quickly adjust the PTZ camera.

8.3.11 Smart Touchscreen

Figure 8-11 Smart touchscreen home

o

aA

Still Images Timecodes Health Multiviewer

www.pixelhue.com 186



All-New Event Presentation Switching Solutions
User Manual 8 U5/U5 Pro Event Controllers

Import Still Images

Step 1 Save the pictures to be imported into the smart touchscreen to the USB drive.
Step 2 Insert the USB drive to the USB port on the side panel of the event controller.

Step 3 On the main touchscreen, choose Settings > Event Controller, and select the Smart
Screen tab to enter the tab page.

_|_
Step 4 In the Still Images area, click - to add a pictures.

Step 5 Select the inserted USB drive in the pop-up dialog box, select the necessary picture
files, and click Open to import the selected pictures to the smart touchscreen.

Up to 8 pictures in png, jpeg, jpg, and bmp formats can be imported into the smart
touchscreen.

View Images on Smart Touchscreen

On the smart touchscreen, click Still Images to enter the subpage.

« Stillimages are displayed in full screen mode on the smart touchscreen by
default.

« Swipe left or right to view the next or previous image. The images will cycle in a
continuous loop as long as you keep swapping.

e After you turn on slideshow function, the images will automatically cycle in a
continuous loop as long as the slideshow function is turned on.

¢ Pinch with two fingers to zoom in or out the still images.

View Timecode

On the smart touchscreen, click Timecodes and view the timecode information of
output.

Figure 8-12 Timecode displayed

Userbit: 3453324F01
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There are two ways to and configure timecode:

¢ On the main touchscreen, choose Settings > Event Controller, select the Smart
Screen tab to enter the tab page, and configure the timecode display format and
display information.

¢ Inthe “timecode control area” on the U5 Pro panel, press the corresponding
button to change the timecode format, enable or reset timecode.

Check Event Controller Running Status

On the home of smart touchscreen, click Health to enter the subpage where you can
check the following information:

¢ CPU, RAM, motherboard, and disk running status
* Power supply and HDMI connector connection status

¢ Transmission rate of the Ethernet ports

Figure 8-13 Event controller health

Motherboard Chip

ma
Norneid Normal

DDR Temperature

Voltage (Vint) Normal  Voltage (Vaux) Normal  Voltage (Vbram) Normal

a e ll = MW 1 &= MVR 2 &> HDMIIN

View Multiviewer Images

On the home of smart touchscreen, click Multiviewer to enter the Multiviewer (MVR)
page.
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Figure 8-14 Video page

The following requirements must be met to view Multiviewer images.

¢ The HDMI 2.0 connector in the MULTIVIEWER area on the rear panel of the event
controller has been connected to the Multiviewer connector of the seamless
switcher.

¢ The Multiviewer configuration is completed on the main touchscreen.

« The software control output connector of the media server has been connected to
the HDMI 1.3 connector on the rear panel of the event controller.

¢ On the event controller area of the front panel, press - to switch between
Multiviewer image and image from the media server. Each time you press it, the
image displayed on the smart touchscreen display screen changes from MVR1 to
MVR2 and then HDMI 1.3 (control interface of the media server).

8.3.12 Number Buttons

The U5 Pro is equipped with number buttons, which are used to enter numbers when
adjusting layer size, position, etc.
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Figure 8-15 Number buttons

H——\ ¥ N Q
) (5] =]

(o] to E: Press to enter the corresponding nhumber.

-: Press to subtract 1 from the current number for fine adjustment.
: Press to add 1 to the current number for fine adjustment.

-: Press to enter the decimal point.

: Press to delete a number or character to the left of the cursor.

I: Confirm and exit the current input.

8.3.13 Switching and Control Area

Figure 8-16 Switching and control area

7= = % e, %
|

LOCK
| FRZ ‘ FTB 8

s =y
|

|[SAWP| || TIME gl

\ TION

FRZ: Freeze all the images of the selected screen.

FTB: Make the output images displayed on the selected screens fade to black.
LOCK T-BAR: Lock the T-Bar. After it is lock, pushing T-Bar does not take effect.
SWAP: Press the button to enable or disable the SWAP function.
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¢ SWAP enabled: The button is solid green and the switching mode from PVW to
PGM is swapping. That is, the PVYW and PGM images are swapped during image
switching.

¢ SWAP disabled: The button is off and the switching mode from PVW to PGM is
copying. That is, PGM copies the PVW image during image switching.

¢ TIME: Set the transition effect duration.

¢ Trans: Set the transition effect during switching.
Currently only the Fade effect is supported.

e CUT: Press to send PVW to PGM directly without transition effect.
* TAKE: Press to send PVW to PGM with a selected transition effect.

8.3.14 MIDI Module Area

The MIDI module has 4 encoders and 8 faders, which can be used for property
adjustment or MIDI keyboard control.

¢ When used as a property adjustment, they can adjust the layer size, position,
image quality, etc.

* Touse them used as a MIDI keyboard, connect the USB (MIDI/KVM) connector of
the event controller to the controlled device, such as an audio console, a lighting
console, etc.

After the property adjustment information is bound to the encoders and faders, the
corresponding encoder or fader icons will be displayed on the property adjustment
page.

Figure 8-17 Bound to encoders

Layer

Basic™ Layout Color Screen Advanced

v Position & Size
[Feee] X

| ¥

When you enter a property area, the adjustment parameters are automatically bound
to the encoders and faders, and the binding relation icons are displayed under the
menu in the property area. The corresponding relation between the icons and MIDI
buttons is shown in the figure below.

When you rotate an encoder or a fader, the system automatically adjusts the
parameters corresponding to the encoder or fader. If a property parameter does not
have a corresponding encoder or fader, rotating the encoder or pushing the fader
does not take effect.

¢ Turn the encoder right to increase the corresponding parameter value, and turn
the encoder left to decrease the value.
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¢ Push the fader up to increase the corresponding parameter value, and pull the
fader up down to decrease the value.

Figure 8-18 Binding relationship between menu adjustment and MIDI buttons

‘
T (T T T [ [ e e

8.3.15 Power Button

| . . .
« Pressthe © button in the upper right corner of the panel, and the system will
automatically start up. After startup, the main touchscreen displays the home
screen.

¢ Power off the event controller through the following methods:

- Pressthe O button in the upper right corner of the panel, select OK in the
pop-up dialog box on the main touchscreen, and the system will shut down.

- During the startup process, hold down the b button to force shutdown.

8.3.16 T-Bar

Pushing the T-Bar up or pulling it down to manually control the switching from PVW
to PGM. The LED indicator shows the switching progress.

During the process of pushing or pulling the T-Bar, pressing the buttons on the front
panel of the event controller does not take effect.
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Figure 8-19 T-Bar area

8.3.17 Keyboard

The U5 Pro has a built-in 61-key mechanical keyboard. To open the keyboard, just pull
the middle section on the front panel.

8.3.18 Drawers

The U5 Pro is equipped with two drawers for you to put some wires or small objects.
To open the drawers, just pull the two sections next to the keyboard out on the front
panel.

www.pixelhue.com 193



All-New Event Presentation Switching Solutions
User Manual 9 Stream Deck Control

Stream Deck Control

About This Chapter

The Q8 and P series (P10 and P20) seamless switchers support control through a
third-party device (Stream Deck). When controlling through Stream Deck, it is
necessary to complete the configuration of Stream Deck device through the
Companion software.

This chapter guides you how to control the seamless switchers through Companion.

Overview
¢ Software Obtaining and Preparations

¢ Software Configuration
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9.1 Software Obtaining and Preparations

¢ User registration has been completed in companion official website
(https://bitfocus.io/companion).

* The supported Companion software version has been obtained from technical
support.

¢ The computer with Companion installed is on the same network segment as the
seamless switcher.

¢ The connection between Stream Deck and the seamless switcher has been
completed.

9.2 Software Configuration

Step 1 After downloading the Companion installation package, double click the package to
install the software.

Step 2 After the installation, double click the Companion software shortcut to open the
software.

Figure 9-1 Companion software interface

10,

o
BITFOCUS

Companion v3.1.1+6234-master-v3-1-1-c0c4345f

http://127.0.0.1:8000/

GUI Interface

+ Start minimized . Run at login
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Step 3 Click Launch GUI to enter the Companion configuration page.

Figure 9-2 Companion configuration page

) Bitfocus Companion = 30101146234 masterv3-1-1-c0c43457) A new stable version (3.1.2)is available

¥Connections  @Buttons  @dSurfaces  @Triggers  @Settings  Bimport /Epert  @log

Connections

When y

+ Add connection

or saftware with Companion, you need to add a connection to let Companion
ou want to control, N
Add connection

Status isabied [ B | o

fferent things, and the st grows every day. If you can't find the device

a

® © © © © © @ @ © © © © © © ©

Step 4 Enter the desired device name in the Add connection area search box on the
Connections interface, “Q8” for example, and the system will automatically display all
relevant product models.

Figure 9-3 Search software

# Connections @ Buttons @ Surfaces @ Triggers 2 Settings. 8 Import / Export @ Llog

Connections

When you want to control devices or software with Companion, you need to add a connection to let Companion
know how to communicate with whatever you want to control.

+ Add connection

Add connection
Label Module Status. Disabled [ETY warning | I Corr

ifferent things, and the list grows every day: If you can't find the device

phih .
$ pixelhue P Connecting ex > all]

mc-i-.e hue: P10; P20; F4; FALite; FE; OB °
Step 5 Click Add before the device model you want to control.
Step 6 After adding the device, the system enters the Edit Connection configuration
interface.
Figure 9-4 Connection configuration
Connections
wn i Comp . o . . ; . + Add connaction & Edit connaction
o pixelhue configuration -]
Label Module Status catied 203 Waroivs [ Lt
$  pixelhu Connecting o& >0 .3 . )

Step 7 Configure the control device.

¢ Label: The name of the controlled device is required. The name can only contain
letters, numbers, underscores and dashes.

www.pixelhue.com 196



All-New Event Presentation Switching Solutions
User Manual 9 Stream Deck Control

¢ |P Address: Enter the IP address of the device to be controlled.
¢ Model: Select the controlled device.

¢ Username: Enter the username for the selected device. The default username is
“admin”.

* Password: Enter the password for the selected device. The default password is
“MTIzNDU2".

Step 8 Click Save to complete the connection configuration.

If the configuration is correct, under the Connections tab, the status of the connected
device is displayed as °

Figure 9-5 Device connection complete

¥ Connections B Buttons @ Surfaces @ Triggers 8 Settings 8 Import / Export B Log

Connections

When you want to control devices or software with Companion. you need to add a connection to let Companion know how to
communicate with whatever you want to control.

Label Module Status Disabled m Warning

pixelhue 2 -
B 8 >
Q Pixelhue ° ® * . n

Step 9 Click Buttons to enter the Stream Deck button configuration interface.

Figure 9-6 Stream Deck button configuration

# Connectior WEuttons | @ Surd © Trigg: 28 Setting: 5 Expor 8

Buttons

Piselhue: P10: P20; F4; FLite: F&: Q8 (Q8)

ac #Moe  WDe @ s & Reset page bur
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Step 10 In the Presets area on the right, click the added control device to expand the preset
function menu.

Figure 9-7 Preset function menu

$Pesets  § Variable W Recorde

Pixelhue: P10; P20; F4; FdLite; F&; Q8 (Q8) [ st |

L ] & a

(L]

Step 11 Click one of the Basics, Display and Presets menu buttons on the right side to
expand the function list, drag the function buttons on the right side to the buttons of
Stream Deck on the left side, and complete the button binding between the control

function and Stream Deck.

Figure 9-8 Function binding - Basics

# Connectic @Buttons | @Sufaces  @Tiggers  WSettings  Bimport/Export  BLo

Buttons
f8Presets | $Variables  WMRecorder
The 1 Streamdeck. Click on them to set up how you want them to look. and

Basics (6o

drag and drop the preset buttons below into your buttons-configuration.

a Note

Since Stream Deck does not support page navigation horizontally, when adding functions to
the buttons on the Stream Deck, make sure the number of buttons horizontally matches the

physical device.

www.pixelhue.com 198



All-New Event Presentation Switching Solutions

User Manual 9 Stream Deck Control

Step 12 Click Back to select a different function menu and complete more function bindings.

Figure 9-9 More function binding - Display

BPresets | SVarisbie | W Recorder

Display =

2o fLoad 10

Figure 9-10 More function binding - Presets

= s 0cABSH A mew stable version (3.1.2)is availsble

Buttons

m

Step 13 After the configuration is completed, the function name will be displayed on the
button of Stream Deck. Press the corresponding button, and check whether the
function bound to the button is triggered in the controlled device.

¢ Yes = > Stream Deck is successfully configured.

¢ No = > Contact your technical support to find out the reason and reconfigure.

Other Operations
* Replace button function

Directly drag a new function from the right side list to the target button to replace
the existing function.

¢ Delete button function

Click Delete at the bottom to activate button function deletion. Click the function
on the button that needs to be deleted to delete the corresponding function.
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¢ Clear button functions

Select the button page that needs to be cleared, click Wipe page at the bottom to
clear all the added buttons functions on that page.

E Note

For more information, please refer to the Companion user manual.
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Specifications
A.1 P10/P20 Specifications
P20 P10
8x DP 1.2/HDMI 2.0 4x DP 1.2/HDMI 2.0
Inputs
4x 12G-SDI 2x 12G-SDI
2x HDMI 2.0
Outputs 8x HDMI 2.0
6x HDMI 1.3
OPT Ports 8 4
AUX Connectors 4x HDMI 1.3 2x HDMI 1.3

3.5 mm Audio Jacks

2x Line in & 2x Line out

(The audio function will be implemented in future updates)

Layers 12x DL layers or 6x 4K layers 6x DL layers or 3x 4K layers
Multiviewer Connectors | 1x HDMI 1.3

Presets 128

BKG & LOGO Up to 255 BKGs & LOGOs (Maximum storage space: 512 MB)
Front Screen 5"LCD

Gigabit Ethernet Ports 2

® Front panel buttons and LCD
® Event Controller U5/U5 Pro

Control .
* Event Management Software PixelFlow
® Third-party control system Stream Deck
. * FPGA-based high-performance image enhancement architecture
Processing L . .
® Real 4K60p 4:4:4 10-bit internal video processing
Chassis 3RU 2RU
W 482.6 x D 501.0 x H 139.0 mm W 482.6 x D 493.0 x H 94.6 mm
Dimensions

W 19.0 x D 19.7 x H 5.5 inches

W 19.0xD 19.4 x H 3.7 inches
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P20 P10
Net Weight 10.2 kg / 22.5 Ibs 7.9kg/17.41bs
Weight With Paper Box | 14.3kg/31.5Ibs 10.2kg/22.5 lbs
Uihin AT 25.2kg / 55.6 Ibs 20.6 kg / 45.4 Ibs
Case

Electric Parameters

Input Power: 100-240V~, 50/60Hz,
3.0-1.5A

Max power consumption: 140 W

Input Power: 100-240V~, 50/60Hz,
3.0-1.5A

Max power consumption: 82 W

Noise on Average (@1,
0.75m height)

45.6 dB

41.9dB

Operating Environment

Temperature: 0°C to 50°C (32°F to 122°F)
Humidity: 0% RH to 80% RH, non-condensing

Storage Environment

Temperature: —20°C to +60°C (—4°F to 140°F)
Humidity: 0% RH to 95% RH, non-condensing

A.2 Q8 Specifications
Description
Inputs Up to 48x 4K concurrent inputs through 6 input cards
Outputs Up to16x 4K concurrent outputs through 4 output cards
OPT Ports 8
Loy 32x 4K rr.1ixing Iayers.in switcher mode
64x 4K single layers in PGM only mode
Multiviewer Connectors | 2x HDMI 2.0
Presets 1024
BKG & LOGO Unlimited picture quantity in 1G storage space

Front Screen

7" touchscreen

Gigabit Ethernet Ports

2

Control * Front screen
* Event Management Software PixelFlow
® Event Controller U5/U5 Pro
® Third-party control system Stream Deck
Processing FPGA based high performance image processing architecture with SuperView
scaling engine inside
Chassis 7 RU
Dimensions W 482.6 mm x D 694.7 mm x H 335.3 mm
W19 x D 27.4 xH 13.2 inches
Weight | Net Weight 42.6 kg /93.9 Ibs
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With Flight
Case

87 kg/191.8 Ibs

Electric Parameters

Power connector: 100-240V~, 10A-5A, 50/60Hz

Max power consumption: 1400 W

Noise on Average (@1,
0.75m height)

45dB

Operating Environment

Temperature: 0°C to 50°C (32°F to 122°F)
Humidity: 0% RH to 80% RH, non-condensing

Storage Environment

Temperature: —20°C to +60°C (—4°F to 140°F)
Humidity: 0% RH to 95% RH, non-condensing

A.3 U5/U5 Pro Specifications

us

U5 Pro

Front Screen

Main touchscreen: 21.5"
Smart touchscreen: 8"

Main touchscreen: 43.8"
Smart touchscreen: 8"

Dimensions W 740 x D 651.4 x H 431.6 mm W 1129.6 x D 695.4 x H 422.7 mm
W 29.13x D 25.65x H 16.99 inches | W 44.47 x D 27.38 x H 16.64 inches
Weight | Net Weight 24 kg 46 kg
With Flight
Case 55 kg 107 kg

Electric Parameters

Power connector: AC100-240V~,
6A, 50/60Hz

Max power consumption: 240 W

Power connector: AC100-240V~, 6A,
50/60Hz

Max power consumption: 330 W

Noise on Average (@1,
0.75m height)

40 dB

40 dB

Operating Environment

Temperature: 0°C to 50°C (32°F to 122°F)
Humidity: 0% RH to 80% RH, non-condensing

Storage Environment

Temperature: —20°C to +60°C (-4°F to 140°F)
Humidity: 0% RH to 95% RH, non-condensing
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Supported Resolutions

B.1 P20/P10

Input Bit Depth Sampling Supported Resolutions | Supported Bandwidth
DP1.2 8bit RGB 4:4:4 18 Gbps
e 4096x2160@60Hz
YCbCr 4:4:4 8192x1080@60Hz
YCbCr 4:2:2
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096x2160@60Hz
12bit RGB 4:4:4 4096x2160@30Hz
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096x2160@60Hz
HDMI 2.0 8bit RGB 4:4:4 18 Gbps
4096x2160@60Hz
YCbCr 4:4:4
8192x1080@60Hz
YCbCr 4:2:2
10bit RGB 4:4:4 4096x2160@30Hz
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096x2160@60Hz
12bit RGB 4:4:4 4096x2160@30Hz
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096x2160@60Hz
12G-SDI 10bit YCbCr 4:2:2 4096%x2160@60Hz 11.88 Gbps
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Input Bit Depth Sampling Supported Resolutions | Supported Bandwidth
DP 1.2 8bit RGB 4:4:4 21.6 Gbps
YCbCr 4:4:4
YCbCr 4:2:2
) 8192x1080@60Hz
10bit RGB 4:4:4
YCbCr 4:4:4 4096x2160@30Hz
YCbCr 4:2:2 3840x2160@60Hz
12bit RGB 4:4:4
YCbCr 4:4:4
YCbCr 4:2:2
HDMI 2.0 8bit RGB 4:4:4 18 Gbps
4096x2160@60Hz
YCbCr 4:4:4
8192x1080@60Hz
YCbCr 4:2:2
10bit RGB 4:4:4 4096x2160@30Hz
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096%2160@60Hz
12bit RGB 4:4:4 4096x2160@30Hz
YCbCr 4:4:4 4096x1080@60Hz
YCbCr 4:2:2 4096x2160@60Hz
12G-SDI 8bit YCbCr 4:2:2 11.88 Gbps
10bit YCbCr 4:2:2 4096x2160@60Hz
12bit YCbCr 4:2:2
SFP25G 8bit RGB 4:4:4 4096x2160@60Hz 25 Gbps
10bit YCbCr 4:4:4
YCbCr 4:2:2
B.3 U5/U5 Pro
Input Bit Depth Sampling Supported Resolutions Supported Bandwidth
HDMI 2.0 8bit RGB 4:4:4 18 Gbps
. 4096x2160@60Hz
YCbCr 4:4:4 8192x1080@60Hz
YCbCr 4:2:2
YCbCr 4:4:4 4096x1080@60Hz
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Input

Bit Depth

Sampling

Supported Resolutions

Supported Bandwidth

YCbCr 4:2:2

4096x2160@60Hz

12bit

RGB 4:4:4

YCbCr 4:4:4

4096x2160@30Hz
4096x1080@60Hz

YCbCr 4:2:2

4096x2160@60Hz

HDMI 1.3

8bit

RGB 4:4:4

YCbCr 4:4:4

YCbCr 4:2:2

10bit

RGB 4:4:4

YCbCr 4:4:4

YCbCr 4:2:2

12bit

RGB 4:4:4

YCbCr 4:4:4

YCbCr 4:2:2

2048x1152@60Hz

4.95 Gbps

www.pixelhue.com

206




	Contents
	1  General
	1.1  About This Manual
	1.2  Version History
	1.3  Symbols and Pictures

	2  Safety
	2.1  General Considerations
	2.1.1  General Safety
	2.1.2  Environmental Requirements
	2.1.3  Device Safety
	2.1.4  Personal Safety

	2.2  Device Carrying
	2.3  Device Mounting
	2.3.1  Mounting on a Desktop
	2.3.2  Mounting into a Rack
	2.3.3  Grounding

	2.4  Cable Requirements
	2.4.1  Power Cords
	2.4.2  Signal Cables
	2.4.3  Miscellaneous

	2.5  Electrical Safety
	2.5.1  Battery
	2.5.2  Electromagnetic Interference
	2.5.3  Anti-Static

	2.6  Unpacking and Inspection
	2.6.1  Unpacking
	2.6.2  Inspection

	2.7  Device Labels
	2.8  Notes and Cautions
	2.8.1  Installation Notes
	2.8.2  FCC Caution
	2.8.3  Others


	3  Terms and Definitions
	4  Overview
	4.1  Solution Overview
	4.2  Control Overview
	4.3  Initial Inspection

	5  Hardware Introduction
	5.1  P20 Hardware Introduction
	5.1.1  Front Panel
	5.1.2  Rear Panel

	5.2  P10 Hardware Introduction
	5.2.1  Front Panel
	5.2.2  Rear Panel

	5.3  Q8 Hardware Introduction
	5.3.1  Front Panel
	5.3.2  Rear Panel
	5.3.2.1  Input card
	5.3.2.1.1  Q_4x HDMI2.0+4x DP1.2+4x 12G-SDI Input Card
	5.3.2.1.2  Q_ST2110_4xSFP25G Input Card_I

	5.3.2.2  Output Card
	5.3.2.2.1  Q_4x HDMI 2.0+4x 12G-SDI Optical Output Card

	5.3.2.3  Control Card



	6  Menu Operations
	6.1  P20/P10 Menu Operations
	6.1.1  Startup and Shutdown
	6.1.2  Home Screen
	6.1.3  Input
	6.1.3.1  Select Connector Type
	6.1.3.2  Select Connector Capacity
	6.1.3.3  Set EDID
	6.1.3.4  Import and Export EDID
	6.1.3.5  Set Input Color
	6.1.3.6  Set InfoFrame Override
	6.1.3.7  Set HDCP
	6.1.3.8  View HDCP Status

	6.1.4  Output
	6.1.4.1  Select Output Capacity
	6.1.4.2  Set Output Resolution
	6.1.4.3  Export EDID
	6.1.4.4  Set Output Color
	6.1.4.5  Set Output Information
	6.1.4.6  Set HDCP

	6.1.5  Screen
	6.1.5.1  Set Screen Status
	6.1.5.2  Set Connector Resolution
	6.1.5.3  Set Mosaic
	6.1.5.4  Set Edge Blending
	6.1.5.5  Set Screen Color
	6.1.5.6  Set Output Information
	6.1.5.7  Set PGM Edit
	6.1.5.8  Set Display Status

	6.1.6  Layer
	6.1.6.1  Set Regular Layers
	6.1.6.1.1  Create and Delete Layers
	6.1.6.1.2  Set Basic Information
	6.1.6.1.3  Set Input Crop
	6.1.6.1.4  Set Layer Color
	6.1.6.1.5  Set Cut & Fill
	6.1.6.1.6  Set DSK
	6.1.6.1.7  Set Layer Mask
	6.1.6.1.8  Set Layer Borders
	6.1.6.1.9  Set Border Shadow
	6.1.6.1.10  Set Layer Flipping

	6.1.6.2  Manage BKG
	6.1.6.3  Manage LOGO
	6.1.6.4  Set AUX Layers
	6.1.6.4.1  Create and Delete Layers
	6.1.6.4.2  Set Basic Information
	6.1.6.4.3  Set Input Crop


	6.1.7  Transition
	6.1.8  Preset
	6.1.9  Multiviewer (MVR)
	6.1.10  Network
	6.1.11  Advanced
	6.1.11.1  Set Synchronization Signal Source
	6.1.11.2  Set Input Backup
	6.1.11.3  Turn on/off Dynamic Range Conversion
	6.1.11.4  Return to Home
	6.1.11.5  Set Fn Button
	6.1.11.6  Reset to Factory Settings
	6.1.11.7  Run Diagnostics
	6.1.11.8  Import and Export Project Files
	6.1.11.9  Update Firmware
	6.1.11.10  Export Logs

	6.1.12  Mode
	6.1.13  About Us
	6.1.14  Language

	6.2  Q8 Menu Operations
	6.2.1  Startup and Shutdown
	6.2.2  Home Screen
	6.2.3  Network Settings
	6.2.4  Device Information
	6.2.5  Advanced Settings
	6.2.6  Language
	6.2.7  About Us


	7  Event Management Software PixelFlow
	7.1  Software Installation and Connection
	7.1.1  Software Installation
	7.1.2  Software Connection

	7.2  Project Management
	7.2.1  Create New Projects
	7.2.2  Import Projects
	7.2.3  Export Projects

	7.3  Device Management
	7.3.1  Enter Device Configuration Page
	7.3.1.2  Online Devices
	7.3.1.3  Virtual Devices

	7.3.2  Configure Device Properties
	7.3.2.1  Rename Device
	7.3.2.2  Configure IP Address
	7.3.2.3  Configure Sync Source
	7.3.2.4  Configure Output Mapping
	7.3.2.5  Configure HDR Format Conversion
	7.3.2.6  Switch Working Mode
	7.3.2.7  Configure Date and Time
	7.3.2.8  Configure Input Source Backup
	7.3.2.9  Configure Device Backup
	7.3.2.10  Reset to Factory Settings
	7.3.2.11  Shut Down or Restart Device

	7.3.3  Configure Input Properties
	7.3.3.1  Configure Card Properties
	7.3.3.2  View Input Source Info
	7.3.3.3  Configure Override Parameters
	7.3.3.4  Configure EDID
	7.3.3.5  Import and Export EDID
	7.3.3.6  Configure Input Color
	7.3.3.7  Configure DSK

	7.3.4  Configure Output Properties
	7.3.4.1  Configure Card Properties
	7.3.4.2  View Output Info
	7.3.4.3  Configure Output Info
	7.3.4.4  Configure Output Timing
	7.3.4.5  Export EDID
	7.3.4.6  Configure Output Color
	7.3.4.7  Configure Multiviewer


	7.4  Screen Configuration
	7.4.1  Configure Screens
	7.4.2  Configure Screen Properties
	7.4.2.1  Rename Screens
	7.4.2.2  Configure Connector Position
	7.4.2.3  Configure Test Patterns
	7.4.2.4  Configure AOI
	7.4.2.5  Configure Screen Color
	7.4.2.6  Configure Timing
	7.4.2.7  Configure Output Parameters
	7.4.2.8  Configure Edge Blending
	7.4.2.9  Configure LCD Bezel Compensation
	7.4.2.10  Configure Virtual Pixels


	7.5  Layer Operation
	7.5.1  Add Layers
	7.5.2  Manage Gallery
	7.5.3  Configure Layer Properties
	7.5.3.1  Configure Basic Properties
	7.5.3.2  Configure Layer Borders
	7.5.3.3  Configure Layer Mask
	7.5.3.4  Configure Layer Color
	7.5.3.5  Crop Input Sources
	7.5.3.6  Configure Cut & Fill
	7.5.3.7  Configure DSK

	7.5.4  Manage Presets

	7.6  Multiviewer (MVR)
	7.6.1  Configure MVR Layout
	7.6.2  Configure MVR Properties

	7.7  Screen Maintenance
	7.7.1  Device Maintenance
	7.7.2  Device Diagnostics

	7.8  Software Settings
	7.8.1  Switch UI Language
	7.8.2  Configure Input View
	7.8.3  Export Logs
	7.8.4  View Software Info


	8  U5/U5 Pro Event Controllers
	8.1  Introduction
	8.2  Hardware Introduction
	8.2.1  Front Panel
	8.2.2  Rear Panel

	8.3  Device Operations
	8.3.1  Basic Operations
	8.3.2  Startup and Shutdown
	8.3.3  Main Touchscreen
	8.3.4  Device Buttons
	8.3.5  Screen Buttons
	8.3.6  Input Source Buttons
	8.3.7  Layer Buttons
	8.3.8  Preset Buttons
	8.3.9  Function Control Area
	8.3.10  Camera and Timecode Control Area
	8.3.11  Smart Touchscreen
	8.3.12  Number Buttons
	8.3.13  Switching and Control Area
	8.3.14  MIDI Module Area
	8.3.15  Power Button
	8.3.16  T-Bar
	8.3.17  Keyboard
	8.3.18  Drawers


	9  Stream Deck Control
	9.1  Software Obtaining and Preparations
	9.2  Software Configuration

	A  Specifications
	A.1  P10/P20 Specifications
	A.2  Q8 Specifications
	A.3  U5/U5 Pro Specifications

	B  Supported Resolutions
	B.1  P20/P10
	B.2  Q8
	B.3  U5/U5 Pro


